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Foreword
Welcome to The Beginner’s Guide to DaVinci Resolve 18.
DaVinci Resolve 18 is the only post-production solution that combines editing, color 
correction, visual effects, motion graphics, and audio post-production all in one software 
tool! Its elegant, modern interface is fast to learn for new users yet powerful enough 
for the most experienced professionals. DaVinci Resolve lets you work more efficiently 
because you don’t have to learn multiple apps or switch software for different tasks. It’s 
like having your own post-production studio in a single app!

DaVinci Resolve 18 adds Blackmagic Cloud support for remote collaboration, DaVinci 
proxy workflow, new Resolve FX, intuitive object masking, improved subtitling for editors, 
Fairlight fixed bus to FlexBus conversion, and so much more!

Best of all, Blackmagic Design offers a version of DaVinci Resolve 18 that is completely 
free! We’ve made sure that this version of DaVinci Resolve includes more features than any 
paid editing system. That’s because at Blackmagic Design we believe everybody should 
have the tools to create professional, Hollywood-caliber content without having to spend 
thousands of dollars.

I invite you to download your copy of DaVinci Resolve 18 today and look forward to seeing 
the amazing work you produce!

Grant Petty 
Blackmagic Design
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Who This Book Is For
This hands-on training guide is designed for DaVinci Resolve editors, colorists, visual 
effects newcomers, and experienced compositors or motion designers who want to 
create visual effects and motion graphics in DaVinci Resolve 18. The book is divided into 
three parts:

 — Part I: Visual Effects Creation

 — Part II: Titling and Motion Graphics

 — Part III: 3D Compositing

You’ll start with an introductory composite that will give you a quick overview of the 
Fusion page interface and how nodes work. Each subsequent lesson builds your skills in 
the fundamentals of visual effects and motion graphics. You’ll cover a variety of genres, 
techniques, and technical best practices including title design, hidden effects, green-
screen compositing, visual effects color management, and much more. Finally, you’ll work 
in Fusion’s powerful 3D environment creating broadcast design graphics, 3D particles, and 
a 3D-tracked composite. Although the last lesson of this guide requires DaVinci Resolve 
18 Studio, you can progress through Lessons 1 through 11 using the free download of 
DaVinci Resolve 18 from blackmagicdesign.com.

http://blackmagicdesign.com
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Getting Started
Welcome to The Visual Effects Guide to DaVinci Resolve 18, an official 
Blackmagic Design certified training book that teaches professionals and students 
the art of titling, motion graphics, visual effects compositing, and broadcast design 
in DaVinci Resolve 18. Editors will find clear workflow-driven lessons, while seasoned 
compositors will quickly learn Fusion’s powerful node-based interface to accomplish 
incredible Hollywood-caliber visual effects.

As you step through the lessons, you’ll gain experience with Fusion’s title animation tools, 
particle effects, blue- and green-screen keyer, powerful planar tracking capabilities, 3D 
compositing environment, and more! Best of all, you’ll discover that there is no longer a 
need to send shots out to another application, because with DaVinci Resolve 18, fantastic 
visual effects and 3D motion design is simply a click away from editing.

This guide takes a practical, hands-on approach using real-world techniques for various 
compositing and broadcast design jobs, including credit rolls, split screens, sky and sign 
replacement, 3D graphics, and 3D set extension workflow. Beyond the artistic side of 
visual effects and motion graphics, you’ll also learn the fundamental science behind the 
techniques you’re using, including compositing in linear light, managing premultiplied 
alpha channels, and maintaining resolution independence. Along the way, you’ll find 
practical tricks and tips used by professional visual effects artists and motion designers 
to enhance the final outcome of your projects. As you complete each lesson, you’ll have 
opportunities to perform optional practice exercises and answer sample test questions to 
test your comprehension of the techniques.

After completing this book, you are encouraged to take the 50-question online proficiency 
exam to receive a Certificate of Completion from Blackmagic Design. You can take the 
exam online at www.blackmagicdesign.com/products/davinciresolve/training.

About DaVinci Resolve 18
DaVinci Resolve is the world’s fastest growing and most advanced editing software.

It also has a long history of being the world’s most trusted application for color correction. 
With DaVinci Resolve 18, Blackmagic Design has added a complete 2D and 3D visual effects 
compositing and motion graphics environment that enables you to complete even the 
most challenging projects using only one piece of software!

http://www.blackmagicdesign.com/products/davinciresolve/training
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What You’ll Learn
In these lessons, you’ll work with multiple projects and timelines to learn fundamental and 
practical techniques used in a wide range of visual effects and motion graphics genres. 
You’ll acquire real-world skills that you can apply to real-world productions.

Getting Started
You’ll begin with a quick start guide that lets you explore the user interface by creating 
a simple but highly realistic sci-fi composite. This lesson is meant to get you comfortable 
with the interface and workflow since it touches on all the essential tools that you will use 
throughout this guide.

Part I
Part I uses four lessons to cover the most common 2D visual effects techniques that you 
can use on a broad range of jobs. You’ll uncover various techniques using Fusion’s point 
and planar tracking tools so you can realistically integrate objects into a shot. Using the 
flexible vector-based Paint tool, you’ll remove objects to create hidden effects that viewers 
never even know are there. Finally, you’ll learn how to approach classic green/blue-screen 
compositing that epitomizes visual effects for most people.

Part II
Part II includes three lessons covering titling and 2D motion design. You’ll learn to 
create smooth and highly customizable credit rolls, explore more creative title animation 
using Fusion’s unique Follower modifier, and create motion paths that can be published 
and shared between any number of elements. Each lesson touches on some aspect of 
animation, including Fusion’s powerful keyframe Spline Editor, procedural modifier-based 
animations, and simple expressions that can create incredibly natural movement.

Part IIl
The final part of this guide uses four lessons to explore 3D compositing and motion 
graphics. You’ll start by exploring how to set up, navigate, and move around in a 3D 
compositing environment. Then, you’ll introduce various 3D objects as you design 
a broadcast graphic, complete with extruded 3D text, shiny custom brushed-metal 
materials, animated camera, and multiple light sources. Some of Fusion’s most useful 
and fun tools, the particle tools, are delved into in Lesson 11, as you create billowing 
realistic smoke for a 3D composite in a music video. The last lesson in this guide requires 
DaVinci Resolve 18 Studio, as it guides you through setting up, optimizing, and making use 
of the integrated 3D camera tracking tool for simple set extensions.



xiiiGetting Started

The Blackmagic Design Training 
and Certification Program 
Blackmagic Design publishes several training books that take your skills farther in 
DaVinci Resolve 18. They include:

 — The Beginner’s Guide to DaVinci Resolve 18

 — The Colorist Guide to DaVinci Resolve 18

 — The Editor’s Guide to DaVinci Resolve 18

 — The Fairlight Audio Guide to DaVinci Resolve 18

 — The Visual Effects Guide to DaVinci Resolve 18

Whether you want an introductory guide to DaVinci Resolve or you want to learn more 
advanced editing techniques, color grading, sound mixing, or visual effects, our certified 
training program includes a learning path for you.

Getting Certified
After completing this book, you are encouraged to take the 1-hour, 50-question online 
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link to 
this exam is located at the end of this book.

The webpage also provides additional information on our official Training and Certification 
Program. Please visit www.blackmagicdesign.com/products/davinciresolve/training.

http://www.blackmagicdesign.com/products/davinciresolve/training
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System Requirements
This book supports DaVinci Resolve 18 for Mac and Windows. If you have an older 
version of DaVinci Resolve, you must upgrade to the current version to follow along with 
the lessons.

NOTE The exercises in this book refer to file and resource locations that will 
differ if you are using the version of software from the Apple Mac App Store. 
For the purposes of this training book, if you are using macOS we recommend 
downloading the DaVinci Resolve software from the Blackmagic Design website 
rather than from the Mac App store.

Download DaVinci Resolve
To download the free version of DaVinci Resolve 18 or later from the 
Blackmagic Design website:

1 Open a web browser on your Windows or Mac computer.

2 In the address field of your web browser, type: www.blackmagicdesign.com/products/
davinciresolve.

3 On the DaVinci Resolve landing page, click the Download button.

4 On the download page, click the Mac or Windows button, depending on your 
computer’s operating system.

5 Follow the installation instructions to complete the installation.

When you have completed the software installation, follow the instructions in the following 
section to download the content for this book.

Copying the Lesson Files
The DaVinci Resolve lesson files must be downloaded to your Mac or Windows computer 
to perform the exercises in this book. After you save the files to your hard disk, extract the 
file and copy the folder to your Movies folder (Mac) or Videos folder (Windows).

http://www.blackmagicdesign.com/products/davinciresolve
http://www.blackmagicdesign.com/products/davinciresolve
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To Download and Install the DaVinci Resolve Lessons Files:
When you’re ready to download the lesson files, follow these steps:

1 Open a web browser on your Windows or Mac computer.

2 In the address field of your web browser, type: www.blackmagicdesign.com/products/
davinciresolve/training.

3 Scroll the page until you locate the The Visual Effects Guide to DaVinci Resolve 18.

4 Click the Part 1 link to download the media. The DR18_Fusion_Training_Media.zip file is 
roughly 4 GB in size.

5 After downloading the zip file to your Mac or Windows computer, open your 
Downloads folder and double-click DR18_Fusion_Training_Media.zip to unzip it if 
it doesn’t unzip automatically. You’ll end up with a folder named R18 Fusion Guide 
Lessons that contains all the content for this book.

6 From your Downloads folder, drag the R18 Fusion Guide Lessons folder to your Movies 
folder (Mac) or Videos folder (Windows). These folders can be found within your User 
folder on either platform.

You are now ready to begin Lesson 1.

http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve/training
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Introducing Blackmagic Cloud
DaVinci Resolve is the world’s only complete post-production solution that lets everyone 
work together on the same project at the same time. Traditionally, post-production 
follows a linear workflow with each artist handing off to the next, introducing errors and 
mountains of change logs to keep track of through each stage. With DaVinci Resolve’s 
collaboration features, each artist can work on the same project, in their own dedicated 
page with the tools they need. 

Now Blackmagic Cloud lets editors, colorists, VFX artists, animators, and sound engineers 
work together simultaneously from anywhere in the world. Plus, they can review each 
other’s changes without spending countless hours reconforming the timeline.

Simply create a Blackmagic Cloud ID, log in to the online DaVinci Resolve Project Server, 
and follow the simple instructions to set up a new project library—all for one low 
monthly price! 

Once created, you can access this library directly from the Cloud tab in the Project 
Manager to create as many projects as you need—all stored securely online. Then invite up 
to 10 other people to collaborate on a project with you. With a simple click, they can relink 
to local copies of the media files and start working on the project immediately, with all their 
changes automatically saved to the cloud.

Enabling Multiple User Collaboration for your project means that everyone can work on 
the same project at the same time—edit assistants, editors, colorists, dialogue editors, 
and visual effects artists can now all collaborate wherever they are in the world in a way 
never before possible.

Media Sync with Blackmagic Cloud Store
Now you don’t need to buy expensive proprietary storage that needs an entire IT team to 
manage! Blackmagic Cloud Store has been designed for multiple users and can handle the 
huge media files used by Hollywood feature films. You can also have multiple Blackmagic 
Cloud Stores syncing the media files with your Dropbox account so that everyone has 
access to the media files for the project.

To find out more about these exciting workflows, visit blackmagicdesign.com/products/
davinciresolve/collaboration

http://blackmagicdesign.com/products/davinciresolve/collaboration
http://blackmagicdesign.com/products/davinciresolve/collaboration
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90 minutes to complete.
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Lesson 1

Getting Started: 
Learning the 
Fusion Page
The Fusion page in Resolve contains 
all the tools you need to create world-
class visual effects. Instead of the 
timeline you might be used to from 
editing, Fusion uses nodes.

Working with nodes is no more difficult 
than working with video clips on a 
timeline. It is, however, a whole new 
way of doing things. As you work 
through this quick-start lesson, give 
yourself some grace to adjust to 
this new method of putting images 
together. Once the node-based 
paradigm becomes cemented in your 
understanding, the rest of this training 
guide will come easily.

Throughout this book, we’ll delve into 
some powerful techniques for creating 
compelling visual effects (VFX), but 
it all begins with a foundational 
understanding of the Fusion interface 
and its basic building blocks: nodes.
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Exploring the Fusion Interface 
In most editing systems, you put together your rough cut and then refine your edited 
versions in the edit page timeline. If you need compositing or motion graphics work, you 
export frames, open up different software, import the frames, and then render out the 
results for importing back into the edit timeline. Fusion does away with this: a single click 
takes you from the timeline and into the creation of your effects.

1 Open DaVinci Resolve, right-click in the Project Manager, and choose Restore 
Project Archive. 

2 Navigate to the R18 Fusion Guide Lessons folder.

This folder contains four DaVinci Resolve Archives and a separate “Fusion files” folder, 
all of which we will use throughout the exercises in this guide. We’ll start with the 
Getting Started archive.

3 Select the GettingStarted.dra (DaVinci Resolve Archive file) and click Open to add the 
Getting Started project to the Project Manager.

4 Open the Getting Started project from the Project Manager and then select the 
edit page, if necessary.

5 From the main menu bar, choose Workspace > Reset UI Layout.

TIP If you accidentally alter your interface and find it hard to follow along, 
selecting Reset UI Layout will return the interface to its default state, 
which—for the most part—should match the layout used throughout this book. 

The timeline in this project includes a shot that requires some visual effects work.

6 In the timeline, move the playhead to the start and play through the clip. 

This is a scene from the sci-fi short SYNC. In this scene, a robot courier receives a hard 
drive directly into a drive slot embedded in its back. Your job is to add the robot’s CG 
“cavity” to the live-action footage.

TIP The term CG stands for “computer generated” and typically refers to 
images created in a 3D animation package such as Maya or Blender. An older 
form of the term is CGI, or “computer-generated imagery.”

https://hazfilm.com/sync-a-proof-of-concept-robots-data-cyberpolice
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7 Position the playhead over the center of the clip.

8 Click the Fusion page button or press Shift-5. 

That’s all it takes to bring a single shot into the Fusion page where you can apply effects. 

Before you start creating those visual effects, let’s get familiar with the Fusion page. 

The page is organized into four main sections. The two viewers across the top display 
the images you’re working on. Below the viewers, a toolbar includes the most used 
effects (also called tools). The lower work area, called the Node Editor, is the heart of 
the Fusion page where you construct your effects. Finally, the Inspector is to the right. 

The toolbar has buttons for 
adding commonly used effects 
or tools to the Node Editor.

The left and right viewers 
can show different images or 
effects from your composite. 

The work area can show any 
combination of the Node Editor, 
Keyframes Editor, or Spline Editor.

In the Inspector, you can 
display and manipulate the 

parameter of any selected effect 
or tool in the Node Editor. 
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By default, the work area displays the Node Editor. Unlike the edit page, Fusion doesn’t 
apply effects directly to clips in a timeline. Instead, it uses a node graph (sometimes 
called a node “tree”) in which each image or effect is a node, as represented by a 
rectangular icon in the Node Editor.

As mentioned at the start of this lesson, nodes aren’t hard to understand; they just 
require a different way of thinking and take a little time to get used to. Before we dive 
into learning about nodes, let’s learn how to navigate around the interface.

Navigating in the Fusion Page
Mouse and keyboard commands in the Fusion page are “context sensitive”; the same key 
presses or mouse clicks can produce different results depending on where your mouse 
pointer is positioned in the interface. For the following exercise, pay attention to where 
you’re being asked to position the mouse pointer before commencing the action.

1 With the mouse pointer positioned over an empty gray space in the Node Editor, 
hold down the middle mouse button and drag to pan the node tree into the center 
of the panel.

TIP While there are workarounds when using other input devices, we strongly 
recommend using a three-button mouse when working with the Fusion page. 
Typically, pressing down on the scroll wheel of a standard mouse acts as a 
middle mouse button click. A pen and tablet input device is also an excellent 
choice for working with Fusion, although for brevity we will only cover the 
mouse commands in these lessons.
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It’s easy to accidentally pan nodes completely out of view of the Node Editor. When this 
happens, the Navigator pane appears in the upper-right corner of the editor panel. 
Simply click in the Navigator pane to re-center the Node Editor view.

2 To zoom the Node Editor view, hold down the left and middle mouse buttons and 
drag left and right.

Remember when we said that keyboard and mouse commands are context sensitive? 
This means you can use the same commands in the viewers.

3 Position your mouse pointer over the right viewer and drag with the middle mouse 
button down to pan, and hold the left and middle mouse buttons down and drag left 
and right to zoom.

4 With your mouse pointer still hovering over the right viewer, press Command-F 
(macOS) or Ctrl-F (PC) to fit the image into the full area of the viewer.

There are a couple more navigation keyboard commands worth learning.

5 Press the + and – keys to zoom in to or out of the viewers or Node Editor in discrete steps.
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6 With your mouse pointer over the right viewer, press Command-1 (macOS) or Ctrl-
1 (PC) and Command-2 (macOS) or Ctrl-2 (PC) to zoom to 100% and 200% zoom, 
respectively. Press Command-F (macOS) or Ctrl-F (PC) to reframe the image to fit 
the viewer in its entirety.

These same navigation commands also work in the left viewer, the Spline Editor, and the 
Keyframes Editor.

Navigating in Fusion

Mac PC

Pan around a view: Middle mouse drag Middle mouse drag

Zoom the view Left and middle mouse drag Left and middle mouse drag

Zoom to 100%, 200% Command-1, Command-2 Ctrl-1, Ctrl-2

Frame the view Command-F Ctrl-F

Working in the Node Editor
Every clip or image file that you bring into the Fusion page is represented by a Media In 
node in the Node Editor. The current Media In node represents the clip from the edit page 
timeline. The Media Out node represents the final image that is sent back to the timeline 
on the edit page. What flows into the Media Out node to the timeline will be the result of 
all our effects work.
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NOTE If you disconnect the Media Out node from the rest of the node tree, the clip 
will appear blank in the edit page timeline, since no image data is able to travel back 
to the timeline clip.

1 In the Node Editor, click the MediaIn1 node to select it. A red highlight border appears 
around the node to indicate the selection. Press the 1 key to display the image in 
viewer 1 to the left. 

Pressing the 1 and 2 keys loads a selected node into the left and right viewers, 
respectively. If you have an external broadcast monitor connected to a Blackmagic 
Decklink card, pressing 3 will load the selected node to the external display.

Notice the small dots at the base of each node. A white dot in position one indicates 
that the node is currently loaded in the left viewer. A white dot in position two indicates 
that the node is currently loaded in the right viewer. A third dot (as shown in the 
preceding figure) will only be present if an external broadcast monitor is connected 
and indicates whether the node is loaded to that monitor.

TIP The terms node and tool are used interchangeably to refer to an image-
processing operation. 



8 Lesson 1 Getting Started: Learning the Fusion Page

To better understand what each Media In node represents, we can add thumbnails to 
the nodes.

2 Right-click in an empty space in the Node Editor and choose Force Source Tile Pictures.

When you first enable source tile pictures, you’ll often see an icon in place of the clip 
thumbnail. To update the thumbnail, you simply need to drag the time ruler playhead.



9Exploring the Fusion Interface 

3 Click and drag along the time ruler to update the Media In node’s tile picture.

It’s a good idea to enable Force Source Tile Pictures by default for future projects.

4 Select Fusion > Fusion Settings.
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5 Select the Flow section, enable Source Tile Pictures, and click Save.

Future projects will now automatically create thumbnails for the Media In nodes.

In addition to adding tile pictures, you can rename nodes to describe their function 
or image. 

6 Select the MediaIn1 node. Press the F2 key and rename the MediaIn1 node 
BackgroundPlate.

Fusion does not allow spaces in node names (for a good reason: spaces can cause 
significant problems in production automation scripts written in Python and LUA). 
Instead, use the underscore character, “Background_plate,” or—as demonstrated in 
the previous step—use camel case, a standard form of notation where each new word 
starts with a capital (the “humps” of the camel).
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TIP A plate in visual effects work is simply the name given to a piece of 
footage. The main source footage is commonly referred to as the background 
plate. Footage that has had elements removed (such as foreground actors or 
unwanted production rigging) is commonly referred to as a clean plate.

Fusion’s node-based workflow focuses almost entirely on spatial relationships 
between images; it’s almost like time is an afterthought. However, as we saw when 
we updated the thumbnail, the time ruler enables movement forward and backward 
through the footage.

TIP By default, the time ruler and all time fields on the Fusion page display 
frame numbers. To display timecode, choose Fusion > Fusion Settings, and in 
the Defaults panel, configure the Fusion page to do so. 

The time ruler shows the entire source clip length, and the vertical yellow lines indicate 
the render range, which is that portion of that clip actually used in the edit page 
timeline. In this case, the entire source media appears in the edit page sequence, so 
the yellow lines appear at the far left and far right of the timeline.

7 Drag the playhead slowly through the render range.

As you drag the playhead through the render range, the current time display (to the 
right of the time ruler) displays the current frame number. To the left of the time ruler, 
you can see the render range start and end frames. 

As the playhead moves, a green line appears along the time ruler to indicate frames 
that are cached into RAM for smoother playback. The more RAM you have in your 
system, the longer the cached region for RAM playback can be. 

TIP You can assign more or less RAM for Fusion RAM playback in the 
Preferences panel. The amount of RAM assigned to Fusion RAM playback is 
taken from the total amount assigned to the DaVinci Resolve application. 
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Combining Images Using Nodes
It’s time to start creating an effect! We’ll begin by adding another clip to the Node Editor

1 Click the Media Pool button to open the media pool.

Adding new media to the Node Editor is as simple as dragging it from the media pool.

2 Drag the DriveDoc clip into the Node Editor and position it above and to the right of 
the BackgroundPlate node. Click the new MediaIn node to select it (the red selection 
highlight should appear around it) and press 1 to load it into the left viewer. Drag in 
the time ruler to preview the clip and update the tile picture.
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3 With the new MediaIn node still selected (it should have its red outline) press F2 and 
rename it DriveDock.

To combine two nodes together, we typically use a Merge node. We’ll soon learn how 
to search for and add the many nodes available in Fusion. However, since the Merge 
node is used so commonly, there’s a special method for creating a merge.

4 Click the small square on the right side of the DriveDock node and drag out a yellow 
connecting pipe. Place it directly over the square on the right edge of BackgroundPlate 
and release the mouse.

A Merge node automatically appears, connecting the DriveDock to the BackgroundPlate. 
You’ll also notice that the right viewer has updated to show the composite of the 
DriveDock over the top of the source footage. (That’s assuming you still have the 
MediaOut node loaded into it. If not, select the MediaOut node and press 2 to load it 
into the right viewer.)

TIP The term composite refers to the result of combining two or more images 
to create a final effects shot.
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Let’s talk about all those arrows and connecting lines (called pipes). Firstly, it’s 
important to understand that it isn’t the location of the connections that matter, but 
rather their color. Fusion will move the positions of the various arrows around the edge 
of the node to better lay out the connections. For example, dragging the DriveDock 
node below the Merge node will move the green arrow to the bottom of the Merge 
node and move the blue arrow to the top in its place.

In fact, you can lay out nodes however you like. As long as the connections go to and 
from the same places, nothing will change in your final image (although, as we’ll soon 
see, keeping nodes laid out in a logical order is important for your own comprehension 
as you work).

So, what do the colors of the connections mean? The green connector is the 
foreground input, and the yellow connector is the background input. In other words, 
the image feeding into the green, foreground input will be composited on top of the 
background image feeding into the yellow input. This is the reason we now see the 
DriveDock over the background plate in the right viewer.

Yellow, background input

Green, foreground input

Blue, mask input

Square output

The blue input is for masking effects (we’ll cover those a little later), and the small, 
white square represents the resulting image output from the node.

TIP If you accidentally connect nodes the wrong way around (the background 
clip to the foreground input and the foreground clip to the background input), 
simply press Command-T (macOS) or Ctrl-T (Windows) to switch them.
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While Fusion automatically “wires up” nodes as you go, you’ll frequently want to 
modify the pipe connections between them. Let’s look at how to connect and 
disconnect the pipes.

5 Hover your mouse pointer over the pipe connecting Merge1 to the MediaOut1 node 
until the pipe highlights yellow and blue.

6 Double-click to disconnect it.

There is no longer a link between Merge1 and the MediaOut1 node. If you still have 
MediaOut1 loaded into viewer 2, you’ll notice that the viewer has gone blank. There’s 
no longer any image data reaching the MediaOut node. Let’s go ahead and reconnect 
the nodes.

7 Click the square output icon of Merge1, drag it to the yellow input triangle of 
MediaOut1, and then release the mouse.

The two nodes are connected once again, and you should see the composited image 
in viewer 2 once again.
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Adding Effects
Let’s look at the current composite.

1 Press the Spacebar to begin playback. Press the Spacebar again to pause playback 
when you’re done, and then drag the playhead to a frame where you can clearly see 
the glowing vertical rails of blue light on either side of the CG drive bays (say, frame 65).

As the composite plays through, you’ll notice that the CG we added doesn’t seem to 
fit in with the live-action footage. (There’s also the small issue of the man’s hands 
disappearing—we’ll get to that a little later.) That’s because the contrast of the two 
elements doesn’t match. Let’s color correct the DriveDock element to match the 
background plate.

2 Drag the DriveDock node upward to create some space. You can hold down the left 
and middle mouse buttons and drag left to zoom out if you need more room in the 
node view.

Remember: moving nodes around doesn’t change the composite unless we actually 
rewire the connecting pipes between them.

3 Make sure DriveDock is selected (outlined in red) and click the Color Corrector icon in 
the toolbar above the node view.

As mentioned earlier, the toolbar gives you visual access to many of the most common 
tools in Fusion.

Notice how the color corrector is automatically added directly after the DriveDock 
node. Why there? Because we had selected the node prior to clicking the Color 
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Corrector button in the toolbar. New nodes are always added directly after the 
selected node.

TIP New nodes are always added directly after the selected node.

Looking at the Inspector to the right, you’ll see that the Color Corrector node offers 
multiple correction tools. Right now, we’re only concerned with adjusting the black point, 
white point, and contrast of the DriveDock element. Matching the black and white points 
of a CG element can go a long way toward integrating them convincingly into a shot.

4 Toward the bottom of the Inspector, drag the Lift slider left and right to see its effect.

Something isn’t right here. We only want to color correct the DriveDock clip, but it 
seems that the entire composite is changing as we adjust the controls. 
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This is happening because CG elements are almost always premultiplied. Premultiplied 
images need to be treated a little differently before being color corrected. We’ll talk 
in more detail about premultiplication in a later lesson. For now, just know that when 
dealing with premultiplied images (and again, computer-generated images are almost 
always premultiplied) you need to enable the Pre-Divide/Post-Multiply option in the 
color corrector.

5 In the Inspector, click the Options button to jump to the options section of the color 
corrector interface. Enable Pre Divide/Post-Multiply.

The color adjustment is now limited to the DriveDock element.

Now let’s dial in the black and white points of our CG, starting with the black point.
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6 Make sure the Color Corrector node is still selected; if not, click it to select it. Then click 
back to the Correction section in the Inspector.

The inspector always shows the properties for the currently selected node.

Eyeballing the black and white points in an image can be a little tricky, but we can take 
advantage of a handy viewer tool to help our precision.

7 Click the viewer 2 menu button (the three dots at the viewer’s top-right) and enable 
Gain/Gamma.

Two sliders appear superimposed over the lower right of the viewer.
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8 Drag the Gain slider to the right until the shadows in the actor’s suit have almost 
completely washed out to white.

These viewer sliders don’t actually color correct your shot. Rather, they temporarily 
change the brightness and contrast of your viewer to help you identify details that 
might be hiding in the shadows and highlights.

9 In the inspector, adjust the Lift slider until the shadows in the CG element match the 
intensity of the shadows in the live-action actor’s suit immediately adjacent to the CG. 
(Don’t try to match the darker shadows around the arms; you’ll end up with too big a 
mismatch due to lighting differences on set.) For greater precision, click in the numeric 
entry field to the right of the slider and drag left and right to adjust. In this case, it 
should be a very subtle adjustment: A value of around -0.006 should work.

TIP In color correction, the Lift control adjusts the level of the dark pixels in an 
image, while the Gain control adjusts the level of the bright pixels.

10 Click the small dot below the Gain slider to reset it to its default value.

Throughout Fusion, you can click these gray dots below the sliders to reset them to 
their default values.
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11 Drag the viewer Gain slider to the left until the bright areas at the top left of the frame 
are only just visible.

While it may be difficult to make out in the printed illustration, the vertical rails of light 
in the CG stand out compared with the horizontal beam of light at the top left of the 
frame. We need to tame the intensity of the bright parts in our DriveDock CG element.

12 Drag the Gain slider left until it matches the intensity of the light at the top left of the 
frame, around 0.48.

13 Click the small dot below the Gain slider to reset it to its default value.

We’ve set the black point and the white point (Lift and Gain), so why does the CG still 
look too dark? Well, we need to adjust the contrast of pixels between the dark and the 
bright areas. We use the Gamma control for this.

14 Raise the Gamma control until the contrast of the DriveDock pixels looks natural, at a 
value of around 1.16.
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15 In the viewer 2 options menu (the button with the three dots), disable the Gain/
Gamma option to return the viewer to normal operation.

Things are looking much better. To see just how much better, let’s temporarily disable 
the color correction to see how things looked before we started.

16 Make sure ColorCorrector1 is selected (outlined in red) and press Command-P (macOS) 
or Ctrl-P (Windows) to disable it. 

17 Repeat the keyboard command to re-enable the node when you’re done.

TIP The “P” in Command-P or Ctrl-P stands for “pass-through.” In this mode, the 
image stream flows directly through the disabled node, bypassing it as if it wasn’t 
there. You can also press the toggle button that appears in the Inspector directly to 
the left of the node’s name.
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Understanding node flow
Before we move on to fixing the disappearing hand, let’s pause for a moment to better 
understand how nodes work. Imagine that each source image is water under pressure. 
The water coming from the BackgroundPlate node is “background-colored.”

1 Select the BackgroundPlate node and press 1 to load it into viewer 1.

One of the great things about working with nodes is that you can quickly see the 
state of the composite at any point, simply by clicking through the various nodes 
that make up the node graph. Here we can see the state of the composite at the 
BackgroundPlate node—just the source footage with no other elements added—while 
still viewing the final output at MediaOut1 in viewer 2. This makes it much easier to 
troubleshoot a chain of effects in Fusion’s node graph compared to stacking and 
nesting effects in a traditional timeline.

2 Click the DriveDock node and press 1 to load it into viewer 1.

Now we see the CG element coming out of the DriveDock node in the left viewer. If you 
look carefully, you’ll see that this soloed version of the DriveDock isn’t as dark as the 
final version in viewer 2. That’s because we’re looking at the footage before it passes 
through the ColorCorrector node that we added in the previous section.

3 Select ColorCorrector1 and press 1 to load it into viewer 1.
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As soon as you pressed 1, you should have seen the image in viewer 1 darken. 
That’s because we’re now seeing the DriveDock image after the color correction has 
been applied.

TIP The viewer always shows the processed output of the loaded node.

So, the DriveDock “water” (to work with our water-under-pressure analogy) flows 
into the ColorCorrector1 node. As it passes through ColorCorrector1, the “water” is 
made darker by our color correction. What comes out the other side (and what we 
see in viewer 1) is the darkened result. The color corrector acts like a filtration plant—
in this case, “polluting” our water, making it darker.

When it arrives at Merge1, the “DriveDock water” combines with the “Background 
water” flowing in through the yellow, background input. The two streams merge 
(hence the name of the node) to create a new single stream that then flows on to 
MediaOut1, where it flows out and back to the edit page timeline.

And that’s really all there is to it. To strengthen your understanding, let’s try a little 
experiment.

4 Hold down the Shift key and drag the Color Corrector node to the right, away from the 
nodes it’s connected to. Release the mouse and then the Shift key.

Holding the Shift key enables you to remove a selected node (or group of selected 
nodes) from a connecting pipe, leaving the pipe intact. We can also use the Shift key to 
insert nodes into an existing pipe.
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5 Drag the BackgroundPlate node to the left to make some room. Hold down the Shift 
key and drag the ColorCorrector1 node onto the pipe connecting the BackgroundPlate 
to Merge1. Release the mouse and then release the Shift key.

TIP When inserting a node using the Shift key, make sure that the connecting 
pipe has changed to half blue, half yellow. Otherwise, you may simply be laying 
the node over the pipe without actually connecting it to the flow.

Looking at the viewer, you’ll now notice that the background looks darker, and our 
DriveDock CG looks lighter. That’s because the BackgroundPlate is now upstream from 
the ColorCorrector node, so it is the image being color corrected. DriveDock flows into 
the main stream at Merge1. It never passes through the color corrector, so its color 
remains unaffected.

6 Continue to press either Command-Z (macOS) or Ctrl-Z (Windows) to undo the 
previous commands until ColorCorrector1 is re-inserted after the DriveDock.
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Working with Masks
As mentioned earlier, dragging the playhead past frame 75 reveals a problem: since our CG 
DriveDock is simply pasted over the top of the source footage, it obscures the screen-right 
actor’s hand as it passes into the same region of the frame. We’ll use a new technique—
masking—to solve the problem.

1 The media pool should already be open at the top left. If it isn’t, click the Media Pool 
button to reveal it. In the Media bin, drag HandRoto into the Node Editor and position 
it just to the left of the DriveDock.

2 With the new MediaIn1 node selected, press the function key F2 and rename it 
HandRoto. Press 1 to load it into viewer 1, and then drag the playhead past frame 75 to 
preview the animation.

Rotoscoping, or “roto” for short, is the process of drawing outline shapes around 
picture elements you either want to isolate or remove. We’ll learn about Fusion’s 
built-in rotoscoping tools in later lessons. For now, we’ll work with the provided roto 
element of the actor’s hand.

If you remember when we introduced the different colors of a node’s input arrows 
earlier, we called the blue triangle the “mask” input. Let’s use it now.
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3 Drag from the output square of HandRoto to the blue, mask input of DriveDock to 
create a connecting pipe.

Well, that didn’t work so well. We produced the opposite result of what we were 
after: instead of hiding the DriveDock CG in the area of the hand, we removed it from 
everywhere else! By default, a mask input assumes you want to keep a node’s effect 
in the white regions and remove it in the black regions. And that’s exactly what’s 
happened. The DriveDock image has been masked off so that it only appears where 
the HandRoto clip appears white.

This is a common problem with a common solution: we can invert the roto matte so 
that the blacks become white, and the whites become black.

4 Select the DriveDock node. In the Inspector, click the Settings button to switch to the 
Settings section. Enable Apply Mask Inverted. The hand is now masked out of the 
DriveDock image.

You won’t see the inverted image reflected in the thumbnail tile of HandRoto. We 
selected invert in the DriveDock node; the image coming out of the HandRoto node 
is still white-on-black. It’s not until the image arrives at the DriveDock node that it’s 
inverted. Remember: in our water analogy, we said that the water is moving “under 
pressure.” It only flows in one direction, so what happens in the DriveDock when we 
enable invert doesn’t change the state of the DriveDock image “upstream” from it.
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5 Press Spacebar to view the final clip.

Secondary Color Correction
Just when you think your shot is complete, notes will inevitably come back from the client. 
After viewing the final composite, the client has decided that the blue light of the drive 
dock should change to a red light as the drive bay doors open. The shot is due in 3 hours, 
and the CG artist who created the animation has flown back home for the holidays. 
What to do?

Thankfully, Fusion provides all the tools we need to customize the shot and create the 
desired effect.

A Luma Key node isolates pixels in an image based on their brightness. We’ll use one to 
work with only the blue lights in the CG shot.

1 Move to frame 75 in the timeline and then double-click in the empty gray space of the 
Node Editor to deselect any selected nodes.

So far, we’ve used two methods to add nodes: connecting the outputs of two nodes to 
create a Merge node, and clicking the Color Corrector button in the toolbar above the 
Node Editor.

Now let’s look at the most common way you’ll add nodes in Fusion: the Select Tool dialog.
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2 Position the mouse pointer just to the right of the DriveDock and press Shift-Spacebar 
to open the Select Tool dialog.

3 Type the letters LUM into the dialog.
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As you type the letters, Fusion begins to isolate all tool names that contain those 
letters. You can use the Up and Down Arrow keys to highlight different selections, 
although in this case the node we want—Luma Key—is already the default selection.

4 Click Add to add a Luma Key node to the Node Editor.

Nodes get added at the location of the mouse pointer, hence the reason you 
positioned the mouse pointer just to the right of the DriveDock before opening 
the Select Tool dialog. Also, the node doesn’t automatically connect itself to any 
other nodes since we had double-clicked an empty space in the Node Editor 
before adding it.

5 Drag a connecting pipe from the output square of the DriveDock and hover it over the 
center of LumaKeyer1. Hold down the Option key (macOS) or Alt key (Windows) before 
releasing the mouse.

If you ever get confused about which colored input is which, you can use this handy 
trick to view a list of all available inputs. The Luma Key node in particular has some 
unusual inputs—a Solid Matte input and a Garbage Matte input. We’re only concerned 
about the main Input for our purposes.

6 Select Input from the pop-up list.

7 Select LumaKeyer1 and press 1 to load it into viewer 1.
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8 In the Inspector, drag the Low and High knobs in the range slider to around 0.32 and 
0.78, respectively.

The range slider is the primary method for selecting the low and high end of the range 
of pixels that will be isolated by the luma key. At this point, viewer 1 should display only 
the blue lighting of the DriveDock element, along with faint highlights on the chassis.

We can use this to mask off the area where we want to apply color correction.

9 Select Merge1 and press Shift-Spacebar to access the Select Tool dialog. Type COL, and 
then press the Down Arrow key to select a Color Corrector node. Press Return/Enter, 
or click Add to add it to the node graph.

A new Color Corrector node is added directly after Merge1, since Merge1 was the 
selected node prior to accessing the Select Tool dialog.
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10 In the Inspector, drag the puck (the circle labeled “M”) at the center of the color wheel 
all the way to the right, tinting the image red.

We’ve succeeded in turning the entire composite red. Now let’s mask off the color 
correction so that it only affects the pixels we isolated with our Luma Keyer.

11 From the output square of LumaKeyer1, drag a connecting pipe over the blue, mask 
input of ColorCorrector2 and release the mouse.

The red color correction is now isolated to only the bright portions of the robot’s back.

Let’s blur the luma key a little to create more of a glow effect.

12 Select LumaKeyer1, press Shift-Spacebar, and type BLU to select and add a Blur node 
directly after LumaKeyer1. Press 1 to load the Blur node into viewer 1 (Make sure 
MediaOut1 is still loaded into viewer 2. If not, select it and press 2.)

TIP Pressing 1 or 2 when a selected node is already loaded in that viewer will 
“unload” the viewer, leaving a blank gray. Just press the viewer number again 
to reload it. 

13 In the Inspector, set the Blur Size to around 8.

By blurring the mask, we’ve inadvertently “washed out” the strength of 
ColorCorrector2. Let’s fix this by increasing the intensity of the color correction.
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14 Select ColorCorrector2 to load its properties into the inspector. In the Inspector, drag 
Saturation to 2.0 and Gain to around 1.7

We’re back to the same color strength, but we now have a little glow around the edges 
of the light, thanks to the blur.
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Animating with Keyframes
We’ve taken care of half of the notes from the client. Now we need to animate the light 
changing from the original blue to our new red as the drive doors open. They begin to 
open at frame 55 and are completely open at frame 70.

1 Move to frame 70 and select ColorCorrector2. Click the Settings button to switch to the 
Settings section.

At the very top of the Settings tab is a Blend slider. You’ll find these in the Settings tab 
of every node. They allow you to choose how much of the node’s effect to blend in to 
the incoming image. If you’re an editor, think of blend as a cross dissolve: a blend value 
of 0.0 will output the unaffected source clip; a value of 1.0 will output all the “affected” 
version at full strength. A value of 0.5 will output a mix: 50% unaffected source clip and 
50% affected version.

2 Drag the Blend slider to see the effect.

3 Click the diamond to the right of the Blend slider and drag the slider all the way to 1.0. 
The diamond changes color.

When you clicked the diamond button, you enabled auto keyframing, indicated by the 
change of color. When keyframing is enabled, Fusion automatically sets a keyframe at 
the current frame. From now on, whenever you move the Blend slider, Fusion will set a 
keyframe at whatever frame your playhead happens to be set to.

4 Move the playhead to frame 55. Drag the Blend slider to 0.0.

Notice that as soon as you dragged the slider, the diamond changed color again, 
indicating that you’ve set a keyframe at the current frame: frame 55.
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TIP We’ll cover editing keyframes in detail in later lessons. For now, if you 
make a mistake, just undo (Command-Z on macOS, Ctrl-Z on Windows) back to 
before the error.

5 Drag the playhead from frame 55 to frame 70. The light changes from blue to red as 
the Blend value animates from 0 to 1.0.

Adding a Vignette
For a final “flourish,” we’ll add a vignette effect to the shot.

1 Select ColorCorrector2. 

2 Press Shift-Spacebar to access the Select Tool dialog and type VIG, and then press 
Return or Enter to add the Vignette tool.

3 Drag the Size slider up to around 0.8 and bring Softness down to about 0.4.
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Returning to the Timeline
The beauty of Fusion existing as a page in Resolve is that returning from performing 
effects work is as simple as clicking back to the edit page. For the smoothest playback from 
the timeline, let’s enable smart caching.

1 Click the Edit button at the base of the interface or press Shift-4 to return to the 
edit page.

2 Select Playback > Render Cache > Smart to enable smart caching.

When smart caching is enabled, Resolve will take advantage of idle CPU cycles to 
render a cache file of the Fusion effects work. As you watch, the bar at the top of the 
timeline will turn blue, indicating that the clip is fully cached and ready to be played 
back smoothly (assuming your cache directory is set to a sufficiently speedy drive—
you can set its location in the Media Storage section of System Preferences).
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Lesson Review
1 In the Fusion page, how can you display the output of a node in viewer 1?

2 When adding a new node, where is the node added?

3 What node would you use to combine two images?

4 What is the yellow input on a Merge node?

5 True or false? When you’re on the Fusion page, you can disconnect the Media Out 
node because you have no use for it.
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Answers
1 In the Fusion page, to display the output of a node in viewer 1, select the node and 

press the 1 key. 

2 The new node is added directly after the selected node in the Node Editor. 

3 A Merge node is used to composite two images.

4 The yellow input on a Merge node is for the background input. 

5 False. The Media Out node is always the last node connected, and it renders the 
Node Editor results back to the edit page timeline.



Part I

Visual Effects 
Creation
In this section, you’ll learn the foundational techniques of visual effects compositing. 
Tracking, keying, working with mattes, and basic color manipulation are the building 
blocks for the majority of effects shots. You’ll become familiar with these tools in 
Fusion as you work through some of the most common VFX tasks: split-screen 
fixes, sky replacements, sign replacement, and green-screen compositing.
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This lesson takes approximately 
45 minutes to complete.
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Lesson 2

Compositing 
Split Screens

The Fusion page excels at creating 
photorealistic visual effects 
composites. The next four lessons 
in this book focus on visual effects 
compositing, which is primarily about 
combining multiple, distinct images 
to make a believable new whole. 
The goal of visual effects compositing 
is to convince the audience that a 
single, live-action camera recorded the 
resulting shot live, regardless of how 
fantastical the subjects.
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One of the most critical aspects when compositing is to have all the different elements 
follow the same camera motion. These are often called match moves because you analyze 
the background clip’s movement and apply it to a foreground clip or vice versa. The 
Fusion page provides three primary techniques for extracting the camera’s motion: point 
tracking, planar tracking, and 3D camera tracking. In the course of this book, you’ll learn 
all three. In this lesson, we’ll begin with the standard point tracker. Although not the most 
sophisticated tracking tool, the point tracker is a real workhorse because it works on the 
broadest range of shots.

This first visual effects lesson will analyze the motion in two shots to create a split-screen 
effect. Now, when we say split screen, we are not talking about a simple picture-in-picture 
effect. A split screen in visual effects terms is a technique where different takes are 
combined to make one better overall take. For instance, let’s say we have two actors in 
a shot. One actor might deliver an excellent performance in take 1, while the other actor 
delivers their best performance in take 2. The director might want to combine the two 
performances and make them appear as a single take.

Original clip and completed split screen for Lesson 2.

Using Layers from the Edit Page
Part I of this book uses a new project for its four lessons. You’ll start by restoring a new 
archive that includes all the media, bins, and timelines you’ll need.

1 Open DaVinci Resolve 18, and in the Project Manager, right-click and choose Restore 
Project Archive.

2 In the navigation window, go to the R18 Fusion Guide Lessons folder and open 
Fusion 18 Lessons Part 1 dra.

3 Click the Edit button or press Shift-4 to return to the edit page if you’re still on the 
Fusion page.

4 From the Timelines bin, double-click Part 1 -START.
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5 Move the playhead over the first red marker in the timeline. Use Cmd + and 
Cmd - (macOS) or Ctrl + and Ctrl - (Windows) to zoom the timeline in and out.

This first edit consists of a driver and a passenger in a car. The passenger is listening 
to the driver, nodding with encouragement. Video track 1 has a much better view of 
the driver speaking but not of the passenger’s reaction.

6 In the timeline, select the clip on video 2, press D to disable it, and view the driver 
speaking and the less affirming passenger.

7 Press D a second time to enable the foreground clip again.

Your job as the visual effects artist is to perform a split-screen effect. The goal 
is to combine the driver speaking from V1 with the nodding passenger’s better 
reaction from V2.

To start the split-screen effect, you must bring both takes into the Fusion page. To bring 
more than one clip from the edit page into the Fusion page, you must create a Fusion clip.
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8 Select both clips in the timeline. Right-click the selected clips and choose New Fusion 
Clip at the top of the menu.

A Fusion clip is created in the timeline and added to the selected bin. The two layers 
are collapsed into the container.

TIP You can display all the layers of a Fusion clip in the edit page timeline by 
right-clicking the Fusion clip and choosing Open in Timeline.

9 With the playhead still positioned over the clip, click the Fusion page button or 
press Shift-5.

The two layers are brought into the Node Editor and combined in a Merge node.

10 Move MediaIn2 above Merge1 and MediaIn1 to the left of Merge1.

This creates a more “readable” layout, where the background clip is on the left and the 
new, foreground clip is added to the horizontal stream from above.

NOTE Feel free to rearrange the nodes within the Node Editor as you continue 
to add nodes in this lesson. In the screenshot above, we’ve already moved 
MediaIn1 a little so that it doesn’t overlap with MediaIn2.
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The MediaIn1 node represents the clip from video track 1, and the MediaIn2 node 
represents the clip from video track 2. The clip from video track 1 connects to the 
Merge node’s background, and video track 2 connects to the foreground input.

To quickly identify each Media In node and what they represent, you can change their 
default names to be more descriptive of the contents.

11 Rename MediaIn1 to DRIVER and MediaIn2 to PASSENGER.

TIP Node names cannot contain spaces, but you can use the underscore 
character to separate words.

Now, you’ll continue with this split-screen composite by tracking the PASSENGER clip and 
using that tracking data to stabilize it.

Image Processing across DaVinci Resolve Pages
The layout of the pages at the bottom of the DaVinci Resolve interface represents 
the project workflow. Media is ingested in the media page, assembled into a 
timeline edit or cut page, undergoes compositing in the Fusion page, and is then 
graded in the color page before rendering out through the deliver page.

FUSION PAGE
viewer

Source media 
compound clips

EDIT PAGE
Source viewer

Source media

COLOR PAGE
viewer

Edit page 
plug-ins Fusion 

comps

EDIT PAGE
Timeline viewer

Fusion comps 
color page 

grades

Viewer results

This order of operations also corresponds to the image-processing pipeline, with 
some exceptions. The video signal of the source media in the edit page (or cut 
page) flows to the Fusion page, where it is processed and output to the color 
page. However, if an effect (Resolve FX or OFX plug-in) is applied in the edit page, 
it will not appear in the Fusion page but will instead appear on the color page. Edit 
page effects are applied to the image data signal after it has left the Fusion page. 
The only exception to this is resizing and repositioning in the edit page. To force 
visibility of an edit page effect in the Fusion page, you can convert the clip into a 
compound clip on the edit page timeline.
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Tracking in the Fusion Page
The easiest way to create a split-screen effect is to remove all camera motion from both 
the PASSENGER and the DRIVER clips. You want to eliminate the camera motion so that 
later you can re-apply camera motion to the new composite from whichever take you 
prefer. To remove camera motion or stabilize a clip, you need to track the clip using a 
Tracker node in Fusion.

1 Select the PASSENGER node and then open the Effects Library.

2 Press Shift-Spacebar to bring up the Select Tool dialog, type TRA, and then press 
Return/Enter to add the selected Tracker tool. It is added after the selected 
PASSENGER node.

3 Select the Tracker node and press 1 to see it in the viewer.

The first step in setting up the tracker is to position the tracker over a high-contrast 
pattern in the frame that includes the motion you want to track. Because you want to 
remove the camera motion, you identify objects in the frame that move only because 
of the camera moves.

4 Move the playhead to the start of the render range.

TIP You can press Command-Left Arrow (macOS) or Ctrl-Left Arrow (Windows) 
to move the playhead to the start of the render range.

When the mouse pointer is over the tracker outline in the viewer, the tracker displays 
two boxes. The inner box identifies the high-contrast pattern that the tracker should 
follow, and the outer box is the search area. You can position the inner pattern box by 
dragging it from the upper-left corner handle.
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TIP The tracker automatically chooses the clip connected to its background 
input as the clip to track.

5 In viewer 1, drag the handle in the upper-left corner of the pattern box to position the 
tracker over the lock on the back door.

The pattern box expands and displays a magnified view of the area you are over, so 
you can be precise with your selection. The door lock is a high-contrast, well defined 
area that stays in the shot the entire time. This makes it a good tracking point.

6 When the door lock is centered in the magnified view, release the mouse button.

The outer box of the tracker is the search box. As the tracker moves frame by frame 
through the clip, it looks for the pattern you have identified in the pattern box. The 
larger the search area is, the longer the tracking analysis takes. On slow-moving 
objects, the pattern probably won’t move far from one frame to the next, so you can 
usually create a relatively small region for the search box. When you have a fast-
moving object, you might need to increase the search box size.

Because the camera does not move very quickly in this shot, the tracked objects will 
not move very far from one frame to the next. So, we can leave the search box at its 
current size.

When stabilizing a shot, a single point stabilizes only the translation movement (up/
down and side-to-side) of that pattern in the frame. The pattern can still scale and 
rotate. You need at least three points to prevent an image from moving, scaling, 
and rotating.
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7 In the Inspector, click the Add button twice to add two additional tracker points to the 
tracker list.

TIP You can double-click a tracker in the Tracker List and rename it for 
organizational clarity.

8 In viewer 1, drag Tracker 2 over the highest-contrast area of the seatbelt attachment to 
the right of our passenger’s head.

The high-contrast parts of the car are good tracking points. They are “nailed to 
the set,” meaning they do not move except for the fact that the camera moves. 
The passenger and the driver are not nailed to the set, so they would make a poor 
choice for tracking in this shot. 
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Selecting a third tracking point gets trickier. There are not too many other high-
contrast points in the car. Because details outside the car (looking through the 
window) are at a distance, tracking anything in the window could be impacted by 
camera parallax. So, we are limited to picking a point inside the car. Although in most 
cases shadows are a last resort when tracking since they can move independently of 
the camera, the shadows on the door to the left of our passenger will work in this clip.

TIP Parallax occurs when camera movement reveals one object behind 
another that was previously obscured by the foreground object.

9 Drag Tracker 3 over the sharp triangular shadow on the door.

To begin the tracking process, you use the tracking analysis buttons along the top of 
the Inspector.

10 Click the Track from First Frame button to begin the tracking process.

Viewer 1 displays the progress of the trackers until the analysis is complete. A dialog is 
displayed, showing some information about the tracking process.

11 Click OK in the dialog to confirm the completion.

You now have three reliable trackers that follow the camera movement. However, 
tracking is not the effect; it is only the means to an end. The next step is to put that 
tracking data to use in stabilizing this clip.
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Using a Tracker for Stabilization
After the tracking analysis completes, you can then change the tracker’s operation mode 
to utilize the tracking data.

1 In the tracker’s Inspector, click the Operation tab.

The Operation tab is where you determine how the tracking data gets used. The 
Operation menu at the top of the Inspector contains all available options.

2 From the Operation menu in the Inspector, choose Match Move.

The Operation menu options depend on the inputs connected to the Tracker node. To 
stabilize a clip, you must have the clip connected to the background input, as we have 
here. Then you set the match move operation to apply to the background.

3 From the Merge menu, choose “BG only.”

4 Play the clip to view the stabilized clip in viewer 1.

As the clip plays in viewer 1, notice that it reveals some of the checkerboard 
background on the left side of the frame. Stabilization works by taking the camera 
motion from the tracker, inverting that motion, and applying it to the same clip. 
For instance, if the camera moves down, the tracker pushes the entire frame up to 
offset the move.

However, this exposes the background because the clip is the same resolution as 
the output. You’ll have to fix this at some point, but for now you just want a very 
steady clip.
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Stabilizing the Driver
There are many methods you could use to perform this split screen, but the most 
straightforward is to make sure both clips are stabilized. This makes it much easier to 
combine the two clips. Now that you have some experience stabilizing with the tracker, 
you can repeat the same steps to stabilize the DRIVER clip.

1 In the Node Editor, select the DRIVER node, press Shift-Spacebar to access the Select 
Tools dialog, type TRA, and add the tracker to it.

2 Select the Tracker 2 node and press 1 to see it in the viewer.

3 In the Inspector, add two more trackers to the tracker list and then position all three 
trackers in roughly the same locations as you did for the PASSENGER clip.

4 Once the trackers are correctly positioned, click the Track Forward button.

5 In the Inspector, click the Operation tab, and from the Operation menu, choose Match 
Move, and then from the Merge menu, choose “BG only.”

You now have two perfectly stabile clips. With the camera motion removed, you can draw 
a simple mask shape to isolate the halves of each clip you want to use.

Drawing a Matte
A considerable part of compositing has to do with drawing mattes, sometimes called 
rotoscoping. Mattes help you isolate specific areas of your image so that effects are 
applied only where they are needed.

In the “Getting Started” project, we were working with a CG element that had an alpha 
channel—a special, hidden channel of image data that defines which parts of an image are 
solid and which parts should be transparent. (We’ll cover alpha channels in more detail in a 
later lesson.)
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Since there is no alpha channel in either of these pieces of footage, we need to create a 
matte that will define which parts of the PASSENGR clip should be solid and which parts 
should be cut away to reveal the DRIVER clip.

1 Select the Merge node and press 2 to view the merge in viewer 2.

The merge has the PASSENGER clip connected as the foreground, so viewing the 
merge will only display that clip until we apply the mask.

2 Drag the playhead to the start of the render range.

It’s best to add the polygon mask shape while you’re positioned at the start or end of 
a render range because mask shapes auto-animate—meaning, if you later change the 
shape on any other frame, the shape interpolates (changes shape over time, morphing 
from the start shape to the new, changed shape). This makes it very quick to rotoscope 
a moving object but can be confusing if you’re unaware of the behavior.

TIP To disable auto-keyframing on spline shapes in the Inspector, 
right-click over the “Right-click here for shape animation” label and choose 
Remove Polygon#Polyline.

3 With Merge1 selected, select the Polygon shape tool from the toolbar directly above the 
Node Editor. Drag the resulting Polygon node below Merge1 for better organization.

When a Polygon mask tool is selected, drawing tools appear above the viewer, and you 
can begin to draw a shape even before connecting the node into your composite.

4 To increase the size of the viewer and see more detail around the area you’re 
rotoscoping, position the mouse pointer on the line between the transport controls 
and the toolbar, and then drag down to increase the viewer’s size.

We won’t need two viewers for this task, so we can gain more working space by just 
viewing a single viewer for the Merge node.



53Drawing a Matte

5 With the Merge node still viewed in viewer 2, click the Single Viewer button located in 
the upper-right corner of the viewer.

Now, viewer 2 takes up the entire top half of the screen to give you a good canvas on 
which to draw your matte.

NOTE The terms matte and mask are often used interchangeably. In this 
book, matte refers to a grayscale image that identifies transparent and opaque 
pixels. A mask is the application of a matte. That is, you use a matte to mask off 
part of an image.

6 To ensure that you draw the matte around the frame, move the mouse pointer over 
the viewer. Hold down the Command (macOS) or Ctrl key (Windows) and scroll the 
middle mouse wheel to zoom in until you are able to see around the entire frame.

To draw a polygon shape around the left side of this image, you’ll need no more than 
10 to 15 control points. You want to use as few points as possible but as many as 
needed to cover the area correctly.

TIP You can always add and subtract points later, but the more points you add, 
the more you’ll have to manage.

7 Select the Polygon node, and then in the viewer, click in the upper-left corner of the 
frame to add a control point. Then, move your pointer down to the lower-left corner 
and click to create a spline running down the left side of the frame.
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You don’t need to add many points along the straight edges of the frame, because 
they are straight. However, you’ll want to be more detailed as you continue the shape 
between the characters.

8 Move the mouse pointer across the bottom of the frame until you reach the driver’s 
blue shirt, and then click to add a point under his blue shirt.

TIP Holding the middle mouse button and dragging in the viewer will pan the 
viewer, making it easier to see various parts of the frame while you are zoomed 
in and drawing your matte.

9 Move your pointer between the passenger’s yellow top and the driver’s blue shirt, and 
then click to add a new control point just before they separate.

10 Add another point at the top of the sun patch on the back seat.
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11 Move your mouse pointer up and over to the left to the lower-left corner of the back 
door window.

12 Move your mouse pointer halfway up the window frame between the front and back 
door and click to add a control point just before the driver’s hair overlaps with the 
window frame.
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13 Move your mouse pointer up and into the center of the window frame to avoid the 
driver’s hair.

14 Add a point at the top of the frame and then move your mouse pointer over the first 
point you started with.

15 When the mouse pointer displays a circular icon, click the first point you added or 
press Shift-O to close the shape.

TIP Many problems occur when you assume that you have closed a shape, but 
it is still open. Making sure you close the shape either by using the keyboard 
shortcut (Shift-O) or clicking directly on the first control point will save you a 
considerable amount of troubleshooting time later.
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Your new polygon matte is now “choosing” to Merge only the passenger (the screen-
left actor) from the PASSENGER clip over the top of the passenger in the DRIVER clip.

16 Select DRIVER and press 1 to load it into viewer 1. Select PASSENGER and press 1 to 
load it into viewer 1. Finally, select Merge1 and then press 1 to load it into viewer 1.

You’ve just confirmed that the split screen is working: the screen-right driver actor 
from DRIVER appears in the final composite at Merge1, and the screen-left passenger 
actor from PASSENGER is the version of that actor appearing in the final composite.

17 Select Polygon1 and press 1 to load it into viewer 1.

It’s worth pausing for a moment here to get a better understanding of what’s going 
on. We’ve drawn a matte using the polygon node that essentially decides where 
Merge1 will “do its job,” and where it won’t. In the white area of Polygon1, Merge1 will 
“work.” In other words, it’ll do its job of compositing the pixels of Merge1’s foreground 
input—PASSENGER—over the top of the pixels of Merge1’s background input—
DRIVER. But where the matte is black, Merge1 will not apply any effect. In other words, 
it will leave the pixels coming into its background input unchanged. The result is that 
we get the screen-left actor of PASSENGER composited over the top of the existing 
version of her in the DRIVER take, but the screen right actor remains unchanged.



58 Lesson 2 Compositing Split Screens

Aligning the Clips Using Nudging
At this point, we could call the shot “final” and send it on for review.

1 Make sure Merge1 is loaded into viewer 2. Press Spacebar to play through the sequence.

There are two remaining problems: Firstly, we’ve removed all motion from the frame 
by stabilizing both shots. Directors like motion in the frame, so the director won’t 
be happy with us removing it. Secondly, there’s no guarantee that each take started 
with the camera in exactly the same position, so there’s a slight misalignment in the 
positioning of the two stabilized shots. Look carefully at the border between the two 
actors and you’ll notice a “tear” resulting from the misalignment.

Let’s start by fixing the latter issue: aligning the starting position of the two shots.

2 Double-click the connecting pipe between Polygon1 and Merge1 to disconnect it.

We’re just temporarily disconnecting Polygon1; when we’re done aligning the clips, 
we’ll reconnect it.
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3 Move the playhead back to the start of the timeline. Select Merge1, and then in the 
Inspector change the Apply Mode to Difference.

Sometimes you’ll find that you need to “break” a shot to perform useful adjustments. 
Here, we’ve changed the method by which Fusion composites the foreground and the 
background. That’s what apply modes do: they blend foreground and background in 
different (and often artistically interesting) ways. In Difference apply mode, whenever 
overlapping foreground and background pixels are the same, they’ll appear black. 
Wherever they’re different, they’ll appear as light. Now we should expect the actors to 
stand out, since they’ll be in different positions in the two different takes. But all things 
considered, the background of the car should be identical in both shots.

4 In the Inspector, click and drag in the Center X and Center Y numeric entry fields 
to nudge the alignment of the images until the majority of the car background 
turns black. For fine adjustments, hold down the Command key (macOS) or Ctrl key 
(Windows) while dragging. For extremely coarse adjustments, hold down the Shift key 
(though in the case of this shot, such large adjustments should be unnecessary).
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TIP Due to lens distortion and subtle light changes between takes, you’ll never 
get perfect alignment of the shot throughout the frame. Focus instead on 
getting alignment where it counts. In the case of this shot, that’s toward the 
center of the shot where the split screen divides between the two actors.

You’ll find that you’ll need to go back and forth between the X and Y, since adjustment 
in X will negatively impact the alignment in Y, and vice versa. Alternately adjusting X 
then Y will home you in on a final optimal alignment. Final values of 0.501 and 0.5199 
should produce the desired alignment.

5 With alignment complete, return Merge1’s Apply Mode to its Normal blend state and 
reconnect Polygon1 to the blue, mask input of Merge1.

For the most part, the tear between the actors is fixed. We’ll add a little blur to the 
matte to soften the transition and hide any remaining mismatch due to shadows and 
lighting differences between the takes.
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6 Select Polygon1. In the Inspector, drag Soft Edge to around 0.02 to smooth the border 
between the two takes.

If you notice that the screen-left actor is bleeding into the split-screen border, move 
back to the start of the sequence (where you initially created the shape) and drag the 
border points of the shape to eliminate the problem.

Restoring Camera Motion
Let’s address the other issue now: reintroducing movement to the frame. Restoring 
camera motion is done by reapplying the tracking data, but instead of steadying the clips 
as we did to stabilize them, you will now unsteady the composite. 

1 Choose Workspace > Reset UI to return to a dual viewer setup.

You should now have two viewers with the Tracker 2 in viewer 1 and the Merge node 
displayed in viewer 2.

2 Select the Merge node, press Shift-Spacebar to open the Select Tool dialog, type TRA, 
and then select Transform (Xf).

The Transform node will be used for two final steps. First, the Transform node will 
be used to reapply the tracking data, and secondly it will allow us to scale up the final 
composite a tiny bit to hide some imperfections around the edges.
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3 Select the Transform node and press 2 to see the results in viewer 2.

When you have tracked an image with a Tracker node, the data from the tracker is 
published. This allows other nodes to reuse the same data without you having to copy 
and paste the Tracker node multiple times throughout a composition. You access 
this published tracking data by right-clicking over a parameter in the Inspector or the 
onscreen control in the viewer and using the Connect To menu.

4 In the viewer, right-click over the transform’s center point control.

5 At the bottom of the contextual menu, choose Tranform1: Center > Connect To > 
Tracker2 > Unsteady Position.

The Connect To submenu is used to link various published parameters or data to other 
parameters. Since we added a tracker to the PASSENGER clip and a second tracker to 
the DRIVER clip, both tracker’s published data is shown in the menu. This allows you 
to reapply the camera motion from either clip.
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Choosing Tracker 2 takes the camera motion from the DRIVER clip, and choosing 
Unsteady Position applies the tracked motion data to the transform.

6 Play the composite to view the split screen.

TIP For optimal quality, it’s best to try to construct your node trees so that 
nodes that transform images are placed next to each other in the node tree. 
Specific nodes that transform (scale, position, rotate) an image will maximize 
quality by performing the transforms from adjacent nodes in one pass. This 
is called concatenation. The Transform, Tracker, DVE, and Merge nodes all 
concatenate as long as a mask is not connected to any of the nodes. 

The last piece of the puzzle in finishing this composite is to scale the final result so the 
image fills the frame. Because of the stabilization, you can see that the left edge and 
the top of the frame reveal the background. The way to correct this is to scale the final 
composite to fill the image.
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7 In the Inspector, increase the Size control to around 1.02 in order to fill the frame with 
the finished composite.

8 Play the composite to view the final shot.

Your split-screen composite now has a better overall look with the added camera motion. 
You’ve taken these two shots from the edit page timeline into a completed composite, 
using a couple of Tracker nodes, a simple Polygon mask, and a Transform.

Completed node tree for Lesson 2.
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Lesson Review
1 True or false? A Fusion clip is used to take multiple timeline layers from the edit page 

into the Fusion page.

2 True or false? Green is the color of the Effect mask input on a Matte control node.

3 True or false? You must click the Keyframe button in the Inspector to animate a 
Polygon matte.

4 True or false? The Tracker is used to stabilize clips in the Fusion page.

5 True or false? In the Merge menu of the Tracker’s Operation tab, choosing “BG 
only” will stabilize the clip that is connected to the yellow background input of the 
Tracker node.
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Answers
1 True. A Fusion clip is used to take multiple timeline layers from the edit page into the 

Fusion page.

2 False. The green input on any node is the foreground input.

3 False. No button needs to be enabled. Polygon mattes auto-animate by default.

4 True. The Tracker is used to stabilize clips in the Fusion page.

5 True. In the Merge menu of the Tracker’s Operation tab, choosing “BG only” will 
stabilize the clip that is connected to the yellow background input of the Tracker node.
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One of the most common problems 
with shooting outdoors is the sky. 
Either the location or time of day you 
are shooting lacks the drama your 
scene calls for, or your camera lacks 
the dynamic range to expose the 
foreground without overexposing the 
sky. The good news is, as far as visual 
effects go, sky replacement isn’t all that 
difficult once you know the basic node 
structure.

Lesson 3

Replacing a Sky
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In this lesson, you’ll learn an indispensable node structure for a sky replacement. 
During the process of learning how to perform a sky replacement, you’ll also look closer 
at compositing images of different resolutions.

Completed sky replacement for Lesson 3.

Retaining a Clip’s Resolution
This lesson will continue with the same project you restored in the previous lesson. We’ll 
open the same timeline and begin with the clips located at the second red marker.

1 Open DaVinci Resolve 18 and, from the Project Manager, open the R18 Fusion Guide  
Lessons Part 1.dra project.

2 In the Timelines bin, double-click the Part 1 - START timeline.

3 Move the playhead over the second edit and the second red marker.
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DaVinci Resolve in general, and the Fusion page specifically, are resolution 
independent. You can efficiently work with any number of elements at different 
resolutions. But knowing what resolution independence means and dealing with it 
in your node tree are two very different things. When constructing composites with 
mixed resolutions, you must be aware of how images are handled, not only between 
the edit and Fusion pages but also within the Fusion page itself.

Like the clips you worked with in Lesson 2, this second edit in the timeline also includes 
two layers.

4 Select the foreground clip on video track 2 and press D to disable this clip in the viewer 
and reveal the sky with rainbow clip on video track 1.

In this two-layer composite, the sky with rainbow is a still photo with a resolution of 
3888 x 2187, and the foreground clip on video track 2 is 1920 x 1080. The timeline is 
also set to 1920 x 1080 HD.

As you can see, the sky with rainbow has some buildings along the bottom, which we 
do not want to see in the sky replacement composite. Since this is a high-resolution 
photo, we can scale it up without losing any quality.
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5 Select the sky with rainbow clip on video track 1 in the timeline, and then in the 
Inspector, use the zoom controls to scale up the clip to about 1.5.

Because Fusion is fully integrated into DaVinci Resolve, the layering and transforms 
you perform on the edit page timeline carry over to the Fusion page.

6 Select the foreground clip on video track 2 and press D to enable this clip in the viewer.

7 Select both clips in the timeline, and then right-click and choose New Fusion Clip 
from the menu.

As you saw in Lesson 2, a new Fusion clip is created in the timeline and added to the 
selected bin. The two layers are collapsed into a container and can be brought into 
the Fusion page.

8 Position the playhead over the new Fusion clip, and then click the Fusion page button, 
or press Shift-5. Re-arrange the nodes so that MediaIn2 appears above Merge1.
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NOTE This lesson uses dual viewers. If your workspace is using a single viewer, 
click the Dual Viewer button in the upper-right corner of the viewer.

The two layers are brought into the Node Editor and combined via a Merge node. The 
MediaIn1 node represents the sky clip from video track 1, and the foreground clip from 
video track 2 is represented as the MediaIn2 node.

9 Hover your mouse pointer over viewer 2 and drag the middle mouse down and to the 
left until you can see the resolution in the top-right corner of the frame.

When using a Fusion clip, the resolutions of the nested clips are set to timeline 
resolution. This is the working resolution of the composite.

10 With your mouse still over viewer 2, press Command-F (macOS) or Ctrl-F (Windows) 
to fit the image to the viewer once more. Select the MediaIn1 node, and then click the 
Transform tool in the toolbar.

Press 1 to see the Transform node in viewer 1.



72 Lesson 3 Replacing a Sky

The Transform node is added to the sky clip. Since this is a large-resolution image in a 
1920 x 1080 frame, we should be able to scale it back a considerable amount and see 
the remaining image that falls outside the frame boundary.

11 Select the Transform node and, in the Inspector, drag the Size slider down just a 
small amount.

As you scale back the image, it reveals transparency around the edges as if the 
background clip has a resolution of 1920 x 1080. The beauty of a Fusion clip is that it allows 
you to use the intuitive tools of the edit page to layer, trim, and align your clips before 
bringing them into the Fusion page. However, the new Fusion clip is created at the timeline 
resolution. If your source clips and timelines have the same resolution, as you had in 
Lesson 2, then the Fusion clip is the most efficient way to set up your composite. However, 
if you are dealing with clips larger than the timeline resolution, then a Fusion clip will resize 
all the sources to fit. This is not the best setup for dealing with a large photo of the sky 
where we only want to use a small area. Let’s look at a different technique that will allow 
us to work with clips at mixed resolutions.
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Controlling a Composition’s 
Resolution
Unlike a Fusion clip, bringing a single clip from the edit page to the Fusion page maintains 
the clip’s original resolution, despite how the timeline resolution is set. This means you’re 
always using the highest-quality compositing in the Fusion page when dealing with a single 
layer from the edit page.

1 Return to the edit page and choose Edit > Undo to undo the Fusion clip in the timeline.

With the clips returned to individual layers in the edit page, we can disable video track 
2 and bring the sky image into the Fusion page.

2 Select the foreground clip on video track 2 and press D to disable the clip.

3 Select the Sky image on video track 2 and reset the scale you applied in the Inspector.

4 Switch to the Fusion page.

If a clip or track is disabled, clicking the Fusion page button takes the first enabled clip 
under the playhead. In this case, it switches to the Fusion page with only the sky image 
from video track 1.
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The resolution seen above the frame is now defined by the original source image 
resolution (3888 x 2187). Now you’re compositing with the highest-quality sky image, 
but you still need to bring in the foreground clip.

5 Open the media pool, and from the “Sky replace” bin, click on the metadata badge in 
the lower-right corner of the foreground clip.

The metadata badge reveals a pop-up with some basic metadata about the clip. One 
of the pieces of the metadata is the resolution, which is 1920 x 1080. Dragging this clip 
from the media pool into the Node Editor retains the clip’s native resolution.

6 Drag the foreground clip to an empty place in the Node Editor, and then press 1 to see 
it in viewer 1.

Above the frame, the clip displays its resolution as 1920 x 1080.

Just like single elements brought in from the edit page, elements from the media pool 
always retain their original resolution.

To keep the media organized, let’s rename the nodes so that the names are more 
descriptive.

7 Rename the MediaIn1 node to SKY and the MediaIn2 node to ACTORS.

With all the media at its highest resolution and our nodes named appropriately, we can 
begin creating the sky replacement.
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8 Drag the output of the ACTORS node onto the output of the SKY node to automatically 
create a Merge node.

Viewer 2 now shows a composition that uses the resolution of the larger sky image 
with a small 1920 x 1080 HD foreground in the middle.

A fundamental concept in Fusion is that the background input of a Merge node 
determines the resolution of the Merge node’s output. This is how you can control the 
resolution when mixing footage of different sizes. In our case, the background input 
is the large sky image, not the full HD resolution of the foreground clip and timeline. 
To correct the resolution of our composite, we need to change the resolution of the 
sky image to be 1920 x 1080. There are a couple of ways to control the resolution of a 
composite, but we will use a Background tool.

TIP The Resize and Crop nodes also modify the resolution of a clip.

9 Drag the Background tool (the first tool at the far left of the toolbar) from the toolbar 
to an empty place in the Node Editor.
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10 In the Inspector, click the Image tab. 

The Background tool’s Image tab in the Inspector includes controls for the background 
image resolution.

11 Click the Auto Resolution button to disable the automatic resolution setting and enter 
1920 as the width value and 1080 as the height.

The background input of the Merge tool determines the resolution of the Merge tool’s 
output. So, by connecting a 1920 x 1080 HD image to the Merge’s background input, 
we can set the composite’s resolution. The easiest technique to accomplish this is to 
use a Background node.

12 Select the Background node, and from the toolbar, click to add a Merge node.

13 Select the Merge node and press 1 to see the black solid color of the Background node 
in the viewer, then hover your mouse pointer over viewer 2, hold the Command key 
(macOS) or the Ctrl key (Windows), and scroll the middle mouse until you can see the 
resolution in the top-right corner of the frame.

The Merge node now uses a resolution of 1920 x 1080. If we connect the larger Sky 
node to the foreground, it will be cropped (not resized) by the Merge’s resolution.
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14 Click the connection line near the input of Merge1 to disconnect the Sky node.

15 Drag the output of the Sky node to the green foreground input of the Merge2 node.

As soon as the connection is made, viewer 1 shows the MediaIn1 node at its full 
resolution but cropped by the 1920 x 1080 Merge node.

16 Drag the output of the Merge2 to the background input of the Merge1 node.

The Merge loaded in viewer 2 shows exactly what we had on the edit page. One layer 
lies over another without any transparency. That’s because the Merge places the 
SKY foreground over the background, and since there is no mask or alpha channel 
in the foreground, there is no transparency.

Compositing Using the 
Darken Apply Mode 
Compositing typically requires an alpha channel or matte, as we used in Lesson 1 with 
the HUD. Mattes or alpha channels are used to tell the software which areas of the 
foreground it needs to cut away to reveal the background. In our case, we have two 
elements, the live-action scene of the actors and our sky picture, neither of which have an 
alpha channel. When starting a sky replacement, some people might be inclined to reach 
for a Luma Keyer immediately. A Luma Keyer is a tool that creates a matte based on the 
luminance in an image, like an overexposed sky. However, it is usually not the right tool for 
sky replacement. At least it’s not the right tool to handle the edges of a sky replacement. 
A much better choice is to start with an Apply mode located in the merge you already have.



78 Lesson 3 Replacing a Sky

1 Select Merge1 and, in the Inspector, set the Apply mode to darken (sometimes 
called minimum).

The Darken Apply mode shows the darkest pixel wherever the foreground and 
background overlap. Since the sky image is darker than the overexposed sky in the 
actors’ clip, most of the sunset sky displays. However, there are lots of issues we 
need to deal with before getting a good-looking sky replacement.

TIP The Channel Booleans node also contains a minimum mode and can be 
used in place of a merge.

2 Select the Sky in the Node Editor and, in the toolbar, click the Transform node.

The larger sky image is cropped (not resized). You still have access to the entire sky 
image. You are just looking at it through a 1920 x 1080 window. The Transform node 
will allow you to reposition the larger sky frame within the crop window.
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3 In viewer 1, drag the center onscreen control to the left edge of the frame to include 
more interesting cloud formations.

Adding Effects from 
the Effects Library 
Up until now, we’ve added nodes using either the Select Tool dialog (summoned using 
the Shift-Spacebar command) or the toolbar. These are great when you know what you’re 
looking for, but what if you simply want to browse a list of all available effects? That’s what 
the Effects Library is for.

Although switching to Darken mode in the previous section took care of the edges, we’ll 
still make use of a Luma Keyer to handle the transparency we see over the actors and 
hillside. Since the actors’ clip has no alpha channel built into it, a Luma Keyer can create 
one for us.

1 In the upper left of the Fusion page, click the Effects Library button. 

The library is organized by category. The Tools category contains all the effects 
available only in Fusion. 

2 In the Effects Library, click the Tools disclosure arrow. 

3 Click on the Matte subcategory.
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4 From the list of Matte nodes, drag the Luma Keyer to an empty area of the Node Editor, 
near the ACTORS node.

5 Drag a second output from the ACTORS node and connect it to the yellow input of the 
Luma Keyer.

Nodes can have multiple outputs without causing any reduction in quality.

6 Press 1 to see the luma key in viewer 1.

Right away, we can see a semitransparent checkerboard pattern that represents 
transparency from the Luma Keyer settings. Because you will create a matte, it can 
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be helpful to view the alpha channel in the viewer instead of the RGB image that is 
currently visible.

TIP An alpha channel is a fourth channel that accompanies the red, green, and 
blue channels of an image. Alpha channels determine which parts of an image 
are opaque and which parts are transparent. 

7 In viewer 1’s toolbar, click the Color controls button and select the alpha channel (or 
click in the viewer and press the A key).

The viewer displays a grayscale image that represents the transparency based on the 
luma key. Areas that are pure white will be transparent, and areas of pure black will be 
opaque. Areas of semitransparency will be some shade of gray.

8 In the Inspector, drag the High threshold slider to the left until the majority of the sky 
appears solid white. The High threshold should end up around 0.8.

An important thing to understand about mattes is that they need to contain pure 
black and pure white. Gray areas, as mentioned above, will be a semitransparent mix 
of foreground and background. That’s OK for glass objects, but most of the time, areas 
will be either all foreground or all background. Right now, the sky is completely white, 
but the foreground of the actors isn’t pure black.
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9 Drag the Low threshold slider slightly to the right to darken as much of the actors and rock 
as you can without darkening the sky. The Low threshold should end up around 0.75.

10 To smooth the harsh edges, drag the Blur slider to about 0.5.

We now have areas of mostly pure black and pure white. Unfortunately for us, there are 
many highlights on the actors and some darker areas in the upper left of the sky that will 
cause problems in our matte.

Fixing Holes in a Key
The remaining problems we have are the areas where white still shows through due to the 
very bright highlights over the actors, the rocks, and the water. There is also a problem in 
the upper-left area of the sky. Let’s tackle the rocks and actors first. Instead of laboriously 
drawing a matte or painting out the holes, we will use an easier method. Enter the Erode 
Dilate node. An Erode Dilate node expands or shrinks the edges of a matte.

1 In the Node Editor, select the Luma Keyer, and from the filter category in the Effects 
Library, click the Erode Dilate node to add it to the Node Editor.
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2 Press 1 to see it in the viewer.

3 In the Inspector, in the Amount slider, type -0.005.

Moving the amount slider left (negative) expands the edge of the matte covering up 
the holes. Unfortunately, it also expands the border of the rocks. How do we fix that? 
We’ll add another Erode Dilate node and set the amount in the opposite direction.

4 In the Effects Library, click the Erode Dilate node to add a second node directly after 
the first Erode Dilate.

5 Press 1 to view the second Erode Dilate in the viewer.

6 In the Inspector, in the Amount slider, type 0.008. 

TIP If a slider in the Inspector does not reach the value you want, you can often 
type in the number to extend the slider’s range.

The Erode Dilate has brought us closer to having a clean black-and-white matte, but visual 
effects are often a game of whack-a-mole, where you fix two problems and reveal another. 
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The Erode Dilate has not removed a few white spots on the actors that we will have to fix. 
We also need to combine this newly generated matte with the actual RGB image of the 
actors to get an idea of our finished shot.

Embedding Alpha into an Image
The matte you created with the Luma Keyer must now be combined with the RGB image 
of our actors. When combining mattes with RGB images, one of the most useful nodes 
is a Matte Control node. One of its primary functions is to take the alpha channel from 
the image connected to foreground input and copy it into the image connected to the 
background input.

1 From the toolbar, drag the Matte Control tool to the Node Editor near the Erode 
Dilate 2 node.

2 Drag a third output from the ACTORS node to the yellow background of the 
Matte Control.

The background input on a Matte Control is used to connect the image that will have 
the alpha embedded.

3 Press 1 to view the Matte Control in the viewer and set viewer 1 to view the RGB 
channels instead of the alpha channel, either by clicking the Color controls button and 
selecting Color or by clicking in the viewer and typing C.
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4 Drag the Erode Dilate 2 node output to the green foreground input of the 
matte control.

5 To embed the alpha channel into the ACTORS image, in the Inspector, set the Combine 
menu to Combine Alpha and enable Post Multiply Image at the bottom of the 
Inspector properties.

By choosing Combine Alpha, we’re telling Fusion to copy the alpha channel from our 
Luma Key (entering the node on the foreground input) into the alpha channel of our 
ACTORS image (coming in on the background input).
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OK, but why did we check the Post Multiply Image option? We’ll get into the full 
explanation in Lesson 4, but for now you should understand that there are two types of 
alpha channels. Premultiplied alpha channels are typically created by computer graphics 
in combination with the RGB image. Straight alpha channels are commonly created by 
image processing apart from any RGB image, as we have done here with the Luma Key. 
The Merge node in Fusion always assumes the incoming foreground image with alpha is 
premultiplied. Since ours isn’t yet, we need to perform the premultiplication.

TIP If you’re wondering why the checkbox is called Post Multiply, it’s simply 
because it’s happening after (post) the alpha channel has been added to the 
main RGB image. The result is a premultiplied image. Confusing, but we’ll cover 
the whole concept in much more detail in Lesson 4.

You now have the actors with an embedded alpha channel, but if you look in the 
viewer, all you’ll see is the washed-out sky we’re trying to replace. Typically, in a matte, 
the white areas are opaque, and black areas are transparent. That is the opposite of 
what we have. So, we’ll invert the matte.

6 In the Matte Control’s Inspector, click the Invert Matte checkbox (just above the Post 
Multiply Image checkbox). 

Before going any further, it helps to view the composite of the foreground with the 
sky. The Matte Control output forms our new foreground with alpha, while the output 
of Merge1 contains the nice clean edges for our composite. Now you’ll merge the 
two together.

7 Select the Merge1 node and click the Merge tool in the toolbar to add a third Merge.
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8 Drag the output of Matte Control to the green foreground input on the Merge3 node.

9 Select the Matte Control node.

10 At the bottom of the Inspector, click the Post Multiply Image button.

11 Click the Play button to review the composite.

The results are displayed in viewer 2. The image appears a lot closer to what we want, but 
the sky appears very flat and fake, so fixing that will be your next task.

Tracking the Sky into Position
As you play the composite, it looks fine when the image is still, but as soon as it plays and 
the camera moves, the illusion falls apart. For this sky replacement to work, the sky needs 
to move as the camera moves. Instead of using the Tracker node as you did in the previous 
lesson, you’ll apply the Tracker as a modifier.

1 Select the Merge2 node that is connected to the Sky node in the Node Editor.
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You’ll need to apply the Tracker modifier to a node that contains position controls. 
The Merge tool includes center X and Y controls that can be used to reposition the 
clip connected to the foreground input.

2 In the viewer, right-click over the Merge’s center onscreen control, and from the menu 
choose Merge 2: Center > Modify With > Tracker position.

TIP Alternatively, you can right-click over the center control in the Inspector to 
attach the Tracker.

The Tracker modifier is attached to the Merge’s center X and Y controls. Although the 
process of tracking is the same as the Tracker node, the Tracker modifier is a single-
point tracker that tracks up and down and side to side movement, so it is more limited 
than the multipoint tracker you used in the split screen. Still, it is perfect for quick, 
simple tracks, as we have here.
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Adding a Tracker modifier displays the tracker pattern and search rectangles over the 
center position in the viewer. Since it is a modifier, the tracker controls are displayed in 
the Merge2’s Modifiers tab.

3 At the top of the Inspector, click the Modifiers tab to display the tracker controls.

The Tracker modifier assumes that you want to track the background of the Merge 
node. In our case, we want to track the ACTORS node.

4 From the Node Editor, drag the ACTORS node to the Tracker source field at the top of 
the Inspector.

NOTE As you drag a node from the Node Editor into an Inspector source field, 
the node will appear to move at first, but it’ll snap back into its original location 
once the mouse pointer leaves the Node Editor.

5 Move the playhead to the start of the render range.

Just as you did in the previous lesson, you need to position the Tracker over a high-
contrast pattern that moves precisely how you want the sky to move. For this shot, the 
ridge in the background has a few rocks that stick out. These would make good high-
contrast tracking points that we can use for the Tracker.
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6 In viewer 1, drag the handle in the upper-left corner of the pattern box to position 
the Tracker over the very small, sharp rock sticking up from the ridge, between the 
two actors.

Unlike when viewing the Tracker node, the pattern box does not expand to show a 
magnified view of the area you are over. However, the Inspector does contain a small 
preview of the selected area.

Since this camera does not move very fast, we can leave the search rectangle at its 
default size.

7 In the Inspector, click the Track Forward button to begin the tracking process.

Viewer 1 displays the progress of the track until the analysis is interrupted around frame 
90 when the actor’s head obscures the rock. You’ll need to find a way to continue the 
tracking for the remainder of this clip. Although the rock you initially selected is fine for the 
first half of the clip, it won’t be the solution for the second half.

TIP If the tracker is interrupted prior to frame 90, try repositioning the pattern box 
or making the pattern box slightly smaller and track the clip again.
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Fixing Interrupted Trackers
When the tracking process is completed, a dialog appears to display information about the 
number of frames tracked and the time it took.

1 In the dialog, click OK to continue with the composite.

You now have a solid track for the first 90 frames or so, but you’ll need another 
solution for the remaining 70 frames. Instead of giving up hope, you can keep the 
tracking data of the initial rock you selected for the first half of the shot and now 
identify a new tracking point for the remainder of the shot.

2 In the render range, drag the playhead to frame 90. 

This is the last good frame of tracking data from the first rock you tracked. At this 
point, you need to locate a new high-contrast object to track.

3 If the Track1 section of the Modifiers tab has closed, double-click the label Track1 to 
re-open it.

4 In the Inspector, set the Path Center menu to Track Center (Append).
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The Track Center (Append) setting allows you to move the pattern box over a new 
object and continue the tracking based on this new point. 

5 In viewer 1, drag Tracker2’s handle in the upper-left corner of the pattern box to place 
the tracker over the sharp rocks on the right side of the actress.

6 Click the Track Forward from Current Time button to pick up the tracking process 
from frame 90.

7 When tracking is completed, click Done in the dialog to continue.

Fusion automatically blends the two analyses for Tracker1 to create one seamless motion 
path. You now have a steady track that follows the position of the camera movement. Since 
you applied the tracker as a modifier to the Merge center X and Y, the motion of the sky 
automatically follows the tracker.

TIP If you notice black at the edge of the frame, it may be that the tracking data is 
pulling in black from outside the sky image’s frame. To fix this, simply readjust the 
sky positioning using Transform1.
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Blending In the Original Sky
If you leave the sky replacement as it appears now, it just looks like a pasted-on sky. By 
color-correcting the SKY clip, we can adjust how it blends with the original sky, creating a 
more natural composite.

1 Select the SKY clip and add a Color Corrector node using the Select Tool dialog 
(Shift-Spacebar).

2 Adjust the Gain up to blend back some of the original sky. A value of around 1.6 should 
work. You can also play with the Gamma to adjust the contrast of the clouds if you like.

Some sky replacements require a few mattes, and some require none. Some might require 
a bit of color correction to get the foreground and background to match better. The goal of 
this lesson was to give you a basic structure you can build on for any sky replacement you 
may come across.

Completed node tree for Lesson 3.
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Practice Exercise
To reinforce the concepts you learn, there will occasionally be optional exercises at the 
end of the lessons. These exercises will be very similar to the procedures you will have 
just completed.

However, they will have brief directions for guidance instead of detailed 
step-by-step instructions.

In this practice exercise, you’ll need to use the masking and tracking skills you’ve learned 
from these past two lessons. Using the third edit in the timeline, you’ll simulate depth of 
field by creating a matte around the robot in the front, tracking the matte, blurring the 
remaining robots, and adding a separate stronger blur to the background.

1 From the edit page timeline, go to the third edit in the timeline (first blue marker) and 
switch to the Fusion page.

2 Bring both layers into the Fusion page.

3 Create a polygon matte for the frontmost robot on the left.

4 Track the robot and apply the tracking data to the polygon matte.

5 Add a Blur to the Robots node and use the matte so the blur applies only to the robots 
in the back.

6 Add a Blur to the background room, so it is blurred more than the robots to simulate 
greater depth of field.

7 Color correct the robots to be slightly darker and have less saturation.

Here’s a final image of how your composite should look.
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Lesson Review
1 True or false? Clips from the media pool use the timeline resolution when added to the 

Fusion Node Editor.

2 True or false? The Merge node contains Apply modes such as screen, multiply, 
and darken.

3 True or false? To offset a tracking point when a pattern becomes obscured, you must 
create a new tracking point.

4 True or false? Tracker modifiers have all the same controls and functionality as the 
Tracker node.

5 True or False? A Luma Keyer is used to create a mask from the brightness in an image.



96 Lesson 3 Replacing a Sky

Answers
1 False. Adding a clip from the media pool to the Node Editor uses the clip’s native 

resolution.

2 True. The Merge node contains Apply modes such as screen, multiply, and darken.

3 False. To offset a tracking point, you must set the Path Center menu to Track 
Center (Append).

4 False. Tracker modifiers track only a single tracking pattern, while a Tracker node 
can track multiple patterns.

5 True. A Luma Keyer is used to create a mask from the brightness in an image.
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Lesson 4

Replacing 
Signs and Screens

You’ve learned how to match move 
using the standard Tracker; now it’s 
time to learn a more sophisticated 
method that is ideal for replacing tablet 
screens, billboards, or signage on the 
side of vehicles. This type of match 
move is most efficiently done using a 
Planar Tracker. Planar tracking, as the 
name suggests, relies on there being a 
flat, planar surface for it to work.
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In this lesson, you’ll add a new sign to the side of a moving van. The process of adding a 
new sign to a moving vehicle (or screen to a tablet) is made up of three parts. First, you’ll 
need to track the flat surface as it moves. Then, using Fusion’s Paint tool, you’ll remove any 
tracking markers to create a clean surface. Once that is complete, you can composite a new 
logo using the tracking data. 

Completed composite for Lesson 4.

Tracking Planar Surfaces
Having Fusion built in to DaVinci Resolve comes with a number of benefits. One of those 
benefits is that it changes visual effects and motion graphics from a shot-based, isolated 
part of the workflow to an integrated, multi-shot workflow, enabling you to change shots 
in an instant without importing, exporting, or timing the clips to the few frames you need.

1 Open DaVinci Resolve 18 and, from the Project Manager, open the 
R18 Fusion Guide Lessons Part 1.dra project into the edit page.

2 In the Timelines bin, double-click the Part 1 START timeline.

3 Move the playhead over the fourth edit and the third red marker, and press Shift-5 to 
switch to the Fusion page.
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4 Press the Spacebar to view the clip.

This shot of the van will ultimately need a sign added as it drives off. However, the first 
part of the composite is to put those black markers to use and track the side of the van.

The single-point tracker is the simplest tracker in the Fusion page. Although it works 
well on many shots, it’s not the most optimal tracker in some specific cases. For 
instance, what happens if the camera changes perspective? No matter how many point 
trackers you use, they are still independent 2D points that can only process limited 
camera motion. A Planar Tracker tracks multiple points across a defined flat surface, 
such as a billboard, TV screen, or in this case, the side of a van. In doing so, it calculates 
a more accurate 2.5D track that can contain more complex motion.

On this shot, you’ll track the van’s movement, so when you ultimately add the new 
logo, it will move across the shot as the van moves.

5 In the upper left of the user interface toolbar, click the Effects Library button to reopen 
the panel.

6 Select the Tools > Tracking category and insert the Planar Tracker tool between the 
MediaIn1 and the MediaOut1 nodes.

7 Press 1 to see the Planar Tracker in the viewer.

It’s important to start planar tracking on a frame where the area you are tracking is 
clear and large in the frame. In this case, frame 65 is ideal because the side of the van 
is large in the frame but moving slowly, effectively eliminating motion blur.
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8 Move to frame 65 in the comp.

Unlike the tracker that you used in the previous exercise, the Planar Tracker does 
not use one or two tracking patterns. Instead, it tracks the motion, scaling, and 
perspective distortions of an entire planar surface in a background clip. So, the next 
step is to identify the planar surface you want to track.

When the Planar Tracker is added, the polygon shape toolbar appears above the viewer. 
The same functionality you used previously to create polygon shapes applies here.

TIP If a clip has any significant lens distortion, it should be removed using a Lens 
Distort node before performing a planar track.

Selecting a Good Area for Planar Tracking
When drawing a shape around the area for planar tracking, keep the following 
guidelines in mind:

 — Select as large an area as possible.

 — Select an area that stays in frame as much as possible.

 — Select an area that is clear of obstruction from moving foreground objects.

 — Start your track when the area you are tracking is at its maximum size. You 
want as much detail in the area as possible when you begin the track.

 — Make sure everything included in the selection is part of the same rigid body. 
That is, make sure you don’t include any area with independent motion, such 
as, in this example, the background behind the van or even the rotating tires.

 — Start your track on a frame in which the area is the least distorted.
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9 In viewer 1, draw a very simple shape that fits around the side of the van. Do not go 
outside the van, and do not include the wheels. 

The area inside your shape is the pattern that will be tracked over time.

TIP When defining the area to track, include only pixels inside the shape that 
belong to the plane being tracked (in this case, the side of the van). Do not 
include any of the background area.

10 At the top of the Inspector, click the Set button.

The current frame is set as the reference frame for the rest of the track.

TIP If you stop before the tracking is completed, you must re-click the Set 
button before resuming the tracking process.
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11 At the bottom of the Inspector, click the Track to Start button.

The viewer shows the tracking as it progresses backward to the start of the shot. 
When it is done, a series of dots appears in the render range to indicate that the 
track is completed.

12 When the first half of the track is done, return to the Inspector and click the Go button 
to move the playhead back to frame 65. Then click the Track to End button.

Despite the majority of the van disappearing offscreen, the Planar Tracker continues to 
track right to the end of the clip.

13 To test the track, in the Inspector, change the Operation Mode pop-up menu to Steady 
and play the clip. (Make sure you have the Planar Tracker node and not the Media In 
node displayed in a viewer).

The side of the van should stay locked in place throughout the timeline playback.

14 Reset the Operation Mode pop-up menu to Track.

The Steady setting is obviously not what you’re trying to accomplish for the shot, but it’s a 
good way to evaluate a track and ensure that there’s no drift or bumps in the tracking data. 
If you do see errors, readjust your tracking shape at frame 65 and try again.

Painting with the Clone Tool
With the tracking done, we can now focus on removing the tracking markers. You will 
create a clean side of the van using the Paint tool to clone white areas of the van over 
each marker. You just need to freeze a single frame to paint over, then cut out the clean 
side of the van and composite it over the live full-motion shot. Let’s start by freezing the 
frame we want to paint over.



103Painting with the Clone Tool

1 In the Effects Library, navigate to the Tools > Miscellaneous category, and drag the 
Time Stretcher tool into an empty part of the Node Editor.

The first part of this job is to freeze the van on a clear frame. Freeze frames from the 
edit page do not transfer into the Fusion page, but it is easy enough to create a freeze 
frame using Fusion’s Time Stretcher node.

2 Drag from the MediaIn1 output to the yellow input on the TimeStretcher1 node.

Dragging a second output from the Media In node is similar to duplicating a clip in 
a timeline.

3 Press 1 to load the Time Stretcher node into the viewer.

The Time Stretcher automatically adds a keyframe when you connect a source to it. 
Doing so makes it easy to speed ramp a clip. However, you want to create a freeze 
frame, so you’ll remove this keyframe and enter the frame number you want to hold 
for the entire shot.

4 In the Inspector, click the red Keyframe button to the right of the Source Time slider to 
disable it.
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The keyframe button turns white, indicating that animation has been removed from 
the Source Time channel.

The frame you want to hold for the duration of the clip is frame 65, because it displays 
a clear, undistorted image of the side of the van.

TIP The Time Stretcher frame numbers are based on the entire clip length, not 
the duration of the clip in the timeline.

5 In the Source Time field, enter 65 to hold frame 65 for the entire length of the shot.

If you do not keyframe this value, the Time Stretcher will hold the frame throughout 
the clip’s duration. That’s all it takes to create a freeze frame.

Now, you’ll paint out the markers on this freeze frame.

6 In the Node Editor, select the Time Stretcher. In the toolbar, click the Paint tool to 
connect it after the Time Stretcher.

7 Press 1 to see the Paint tool in the viewer.

With the Paint tool selected, the Inspector changes to show various paint controls, and 
a viewer toolbar is displayed above the viewer with the various paint stroke types.

The Paint tool offers several stroke and paint styles suitable for motion graphics or 
retouching shots. In this exercise, you’ll use a simple stroke brush in Clone mode to 
copy white areas of the van and paint over the markers.

8 In the viewer toolbar, click the Stroke tool.

The Stroke tool is the most versatile of paint tools and the one you will use for most 
paint tasks.
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9 In the Inspector, click the Clone Apply Mode button to switch from painting with color 
to painting with a clone brush.

The clone brush works by selecting a source area from a frame and a destination 
area. The source area is the area in the frame you want to duplicate as you paint. The 
destination area is the area you will paint over using the content of the source area.

10 Option-click (macOS) or Alt-click (Windows) to the left of the first black marker in the 
upper left of the van to select the source area offset for the clone brush.

11 Once you’ve selected the source area offset for the clone brush, paint over the 
first marker.

As you paint, the source area offsets by the same amount. For instance, when you 
paint upward, the source area selection also moves up. It is often good to keep the 
source selection near the area you will paint over, because doing so keeps the texture 
and color of the two areas as similar as possible.

TIP You can hold down the middle mouse button and drag in the 
viewer to pan.

12 If necessary, Option-click (macOS) or Alt-click (Windows) on a new offset for the next 
marker and paint over it. Command-drag (macOS) or Ctrl-drag (Windows) to resize 
the brush. Continue choosing a new offset and painting over each marker until all the 
markers are removed.
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You now have a clean van, perfect for compositing a new logo. In the next exercise, 
you’ll import a logo and learn how to blend it onto the side of the van. 

Using Photoshop PSD Layers
DaVinci Resolve can use various still-image formats for graphics, including TIFF, JPEG, and 
PNG. It can also use layered Photoshop files, allowing you some flexibility when it comes to 
selecting the layer you want to use from the PSD graphic.

1 Ensure that nothing is selected in the Node Editor by clicking in an empty graph area. 
You’ll add a graphic file to this graphics bin.

2 From the Fusion menu, choose Import > PSD. Then, navigate to the R18 Fusion 
Lessons folder > Fusion Files and import the EatatJoes.psd file.
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3 Once imported into the Node Editor, you will get a node representing each layer in the 
file and a merge node, labeled Normal, that combines the layers together.

4 With the Normal node selected, press 1 to see it in the viewer.

This photoshop image is 1920 x 1080 resolution and includes two layers. One layer is 
the main logo, while the other layer is the address of the company. You can delete the 
Normal and ADDRESS nodes to use only the LOGO layer.

5 Select both the ADDRESS and Normal nodes and press Delete or Backspace on 
your keyboard.

With only the LOGO node remaining, you can composite it over the van.
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6 Connect the output of the LOGO node to the output of the Paint1 node to create a 
Merge node.

7 Connect the output of the LOGO node to the green input of the Merge node.

That looks just like what it is: a photoshop document placed on top of the van clip. 
However, with some blending, color correction, and positioning, you can make it 
appear much more realistic.

8 Select the Merge node and, in the Inspector, set the Apply Mode to Soft Light.

The soft light apply mode is a good choice because it softly lightens the logo based 
on the white van color, giving the logo a nice, diffused look, However, since the crease 
lines in the van are darker than much of the logo, the logo is darkened in those areas. 
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The result is good but maybe a bit too light and diffused. We can improve it a bit using 
some simple color correction.

9 From the toolbar, insert a Brightness Contrast node between the LOGO node and the 
Merge1 node.

10 Adjust the Lift down to darken the black part of the logo and increase the Contrast 
slider until the logo appears less diffused.
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Although looking much better, the edges of the graphic have become a bit ragged.

This is a common problem that occurs when you perform color correction on an image 
with a premultiplied alpha channel. To correct this problem, you can enable the Pre-
Divide/Post-Multiply checkbox in the color corrector.

To correct this, we must pre-divide before the color correction and post-multiply after 
it. We can do both with just one checkbox in the Brightness Contrast node.

11 With the Brightness Contrast node selected, click the Pre-Divide/Post-
Multiply checkbox.

You now have a great-looking logo that just needs a bit of positioning to appear like it is 
actually painted on the side of the van.
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About Straight and Premultiplied Alpha Channels
To display anti-aliased edges in an alpha channel, Fusion performs a multiplication 
operation on the edge pixels. At that time, some of the original color values shift 
slightly darker to achieve the anti-aliased look.

Straight alpha channel Premultiplied alpha channel

In Fusion, this color shifting is not noticeable because the Merge tool expects to 
receive a premultiplied alpha channel. It becomes noticeable only when the black 
level or gamma of the graphic changes through some tonal value adjustment such 
as color correction. The result is either a brighter or darker outline around the 
edges of the graphic.

Composited premultiplied  
alpha channel

Adjustment on premultiplied 
alpha channel

Luckily, you have a relatively easy solution available. You perform an operation that 
divides the multiplied alpha channel, then make your color correction, and finally 
remultiply the edges again. Most of the color correction tools in Fusion include a 
Pre-Divide/Post-Multiply checkbox that does the work for you. All you have to do is 
be aware of the issue and when it might need to be corrected.
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Corner Pinning an Image
Positioning this logo could be done using a Transform node, but that wouldn’t allow 
you to replicate the perspective distortion from the camera’s viewpoint. To recreate any 
perspective distortion, it is best to position this graphic using a Corner Positioner node.

1 In the Node Editor, select the Brightness Contrast node.

You’ll place the Corner Positioner node directly after the Brightness Contrast node but 
before the logo is merged with the freeze frame.

2 In the Effects Library, select Tools > Warp, and then click on the Corner Positioner tool 
to add it to the Node Editor.

The entire logo has been squeezed onto a tiny area of the van based on the corners 
of the frame. To fix that, you need to position each corner of the logo near the 
corresponding corner of the frame. You can do this easily by dragging each corner into 
position or entering values in each of the four corner position controls in the Inspector.

3 In the viewer, drag the upper-right corner of the graphic corner pin outline to the 
upper-right corner of the frame, or enter 1 for X and 1 for Y in the corresponding 
Inspector fields. 

4 Drag the lower-right corner of the graphic corner pin outline to the lower-right corner 
of the frame or enter 1 for X and 0 for Y in the corresponding Inspector fields.

The two corners on the left will frame the graphic best if they are located about 25% in 
from the left edge.

5 In the Inspector, set the top left X value to .25 and the Y value to 1, placing the corner 
at the top of the frame and 25% in from the left edge. 
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6 In the Inspector, set the bottom left X value to .25 and the Y value to 0, placing the 
bottom at the bottom of the frame and 25% in from the left edge.

With these values entered, the graphic is placed over the van but positioned a bit too 
close to the roof. Fine-tuning the left corners to be lower in the frame will pull the 
graphic away from the top of the van.

7 In the viewer, drag the top-left and bottom-left corner pin control points slightly down 
in the frame until the graphic is more realistically located on the van.
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The placement and appearance of the graphic is perfect, but it is still just placed on a still 
frame without any movement. Hang in there; you’ll fix that in the next exercise.

Fusion Coordinate System
Fusion’s 2D coordinate system is normalized, which means that it always uses a 
value between 0.0 and 1.0, regardless of the image’s resolution. It begins in the 
lower-left corner with an X value of 0 and a Y value of 0. The upper-right corner has 
an X value of 1.0 and a Y value of 1.0. For any image resolution, the absolute center 
is always X = 0.5 and Y = 0.5.

Fusion viewer coordinate systemX = 0.0  
Y = 1.0

X = 0.0  
Y = 0.0

X = 1.0  
Y = 1.0

X = 1.0  
Y = 0.0

X = 0.5  
Y = 0.5
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Combining Mattes and Images
So far, you have a freeze frame of the entire shot, but you need to isolate the side of the 
van with the logo to composite it. This is where the rotoscoping technique you learned 
earlier comes in handy. You’ll create a matte that isolates just the side of the van.

1 Go to frame 65, and then, from the toolbar, drag the Polygon tool into an empty area 
of the Node Editor near the Merge tool.

2 With the Polygon tool selected, draw a shape around the side of the van using 
the creases by the door and roof to guide your matte. Be sure to close your matte 
by connecting the last and first control points or by pressing Shift-O to connect 
them automatically.

You now have a matte, but you have nowhere to connect it into the node tree. All the 
available blue Effect Masks inputs are not the type of mask input you need. An effect 
mask limits the area of an effect. What you are doing here is combining an image with 
a matte, effectively cropping the image. This type of mask is often called a garbage 
matte. You need to add a node that can accept a garbage matte input. The most 
commonly used node for this purpose is called a Matte Control node.
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3 In the Node Editor, select the Merge1 node, and then in the Effects Library select the 
matte category.

4 Click the Matte Control tool from the Effects Library to add it after the Merge1 node.

5 Press 1 to see the Matte Control in the viewer.

The Matte Control is typically used to copy or combine mattes from a foreground to 
a background. In this situation, you’ll use it to copy a matte to the background freeze 
frame. However, because the Matte Control has several possible inputs, you need a 
way to ensure that you select the correct one.

6 Option-drag (macOS) or Alt-drag (Windows) from the Polygon output to the Matte 
Control node and release the mouse button.

When you release the mouse button, a pop-up menu appears listing all the possible 
inputs of the matte control. This menu makes it easier to select the correct input.

For this task, you want to use a garbage matte.

7 In the pop-up menu, click the Garbage Matte to connect the Polygon.

The viewer now shows a hole where the side of the van used to be. Your matte is used 
to cut out the side of the van rather than isolating it. You can use the Inspector to 
reverse this operation.
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8 With the Polygon node selected, in the Inspector, click the Invert button.

The side of the van with the logo is the only part seen from the freeze frame. You can now 
composite this still image over the top of the moving image using the Planar Tracker data 
to move it in sync with the full-motion shot.

Match Moving with the 
Planar Transform
For simple corner-pinning images, you can connect directly into the Planar Tracker. 
However, when you’re working with irregular polygon matte shapes or anything other 
than images of the same aspect and resolution of the composition, the more appropriate 
method is to use the Planar Transform.

1 In the Node Editor, select the Planar Tracker node.

2 At the bottom of the Inspector, click Create Planar Transform.
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A Planar Transform node is created that contains all the transform and perspective 
distortion data captured by the Planar Tracker. You can apply this data to any input 
image or matte, thereby saving lots of time compared to rotoscoping objects.

3 Connect the output of the Matte Control to the yellow input of the Planar Transform.

4 Press 1 to view the Planar Transform in the viewer.

5 Drag through the render range to preview the match-moved side of the van.

The freeze frame of the van’s side now follows the driving motion. The next step is a 
simple merge to composite the van side over the moving van shot.

6 Select the Planar Tracker and press Delete.

Once you have the Planar Transform, there is no need to keep the Planar Tracker. All 
the data captured from the tracking is now stored in the Planar Transform.

7 From the toolbar, drag the Merge node over the connection line between the MediaIn1 
and the MediaOut1 nodes to insert it.

8 Drag the output from the Planar Transform node to the green foreground input of the 
Merge2 node.

9 Select the Merge2 node and press 1 to see it in the viewer.

10 Press the Spacebar to play the entire shot.

You now have fairly convincing results. In the next exercise, you’ll address a few little 
cleanup areas to finish this shot.
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Finalizing the Composite
If you look carefully at later frames (such as frame 90), you’ll see a clear shift in the 
shadows between the masked region and the moving van.

1 Move the playhead to frame 90.

This is a common problem resulting from the shadows changing in the live shot. Your 
freeze frame lighting is baked in and doesn’t update with the moving shot. A simple 
blur could disguise the seam. However, because the clean van goes right to the top 
of the roof, you’ll use the variable soft-edge on the polygon tool only where needed, 
toward the base and back of the van.

2 Move to frame 65.

TIP It’s important to always perform changes to a matte on the original frame 
where the adjustments were made. Doing so will avoid accidentally adding 
keyframes and interpolating between adjustments.
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3 Select the Polygon node and, at the top of the viewer, click the Make Double Poly button.

4 Right-click over one of the control points in the viewer and choose Controls > Select > 
Polygon 1: Outer Polygon

5 Drag the middle control point along the right edge of the shape to create a soft 
transition edge.

TIP If you need to move a second control point, first click off into the gray area 
of the viewer to deselect the initial control point. Then hold Command (macOS) 
or Ctrl (Windows) as you drag the second control point.

6 Select the MediaOut1 node to hide the onscreen controls for the Polygon node and 
play the clip to preview the results.

The matte now looks clean. The final touch to make our logo appear more natural is 
to fix the “strobed” motion that the logo appears to have. This is due to the original 
camera footage having motion blur as the van gathers speed and our graphic 
having none.
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7 With the Planar Transform node selected, in the Inspector, click the Settings tab. 

8 Enable motion blur.

The default blur seems a little strong for the shot, so you’ll dial back the shutter angle. 
You’ll also increase the quality of the blur to remove any visible stepping.

9 Adjust the Shutter Angle down to 130.0 and the Quality up to 5.

With that, the shot is complete. The technique you learned here can be used to replace 
many different objects in a shot, from simple street signs to touchscreens and even 
tattoos. Creating the clean surface with the Time Stretcher, Paint tool, and Polygon Spline 
gives you a very simple but powerful recipe for common problems that may arise in a shot.

Completed node tree for Lesson 4.
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Practice Exercise
This practice exercise is almost identical to the van exercise, although there is no paint 
required. The goal is to replace the twitching closed eyes on an actor with a freeze frame of 
his eyes, so they remain static throughout the shot.

1 Go to the next-to-last clip in the timeline.

The man on the gurney moves his eyes too much in this shot. This would be an easy fix 
if the camera didn’t rotate as it looked down on him. However, whether it be the eyes, a 
piece of the set, or a few people, the job of removing patches from a frame or covering 
up unwanted areas is a common task that can help save a shot. Fixing this particular 
shot is a very quick and easy procedure almost identical to what you have completed 
with the van shot.

2 Planar track the face of the man.

3 Use the Time Stretcher node to freeze a frame.

4 Add the Matte Control and a Polygon tool to isolate the eyes.

5 Create a Planar Transform.

6 Use the Planar Transform to move the isolated eyes.

7 Composite the eyes over the moving face.

8 Soften the edges of the Polygon node.
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Lesson Review
1 True or false? You must click the Set button before you begin planar tracking.

2 True or false? When drawing a shape around a surface for planar tracking, you should 
include as much of the background as possible.

3 Which of the following make for good planar tracking surfaces:

a) Side of a building

b) Billboard

c) A bouncing ball

d) All of the above

e) None of the above

4 True or false? The Planar Transform can be used to track planar surfaces and 
composite the results.

5 True or false? When cloning with the Paint tool, you hold the Option (macOS) or Alt 
(Windows) key and click to select the clone offset source, and then keep the Option or 
Alt key pressed while you paint over the destination.



124 Lesson 4 Replacing Signs and Screens

Answers
1 True. Clicking Set identifies the reference frame for the planar tracker.

2 False. When drawing a shape around a surface for planar tracking, you should not 
include any of the background.

3 a) and b) are ideal for planar tracking. c), the bouncing ball, is not a planar surface and 
therefore not a good option.

4 False. The Planar Transform uses the tracking data from a Planar Tracker and applies to 
it its input image. The Planar Transform has no compositing capabilities.

5 False. When cloning with the Paint tool, you hold the Option (macOS) or Alt (Windows) 
key and click to select the clone offset source, and then release the Option or Alt key 
when you begin painting over the destination.
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Compositing 
Green‑Screen 
Content
Green- or blue-screen keying is the 
classic visual effects work that comes 
to mind for most people. A foreground 
subject is shot against a bright blue or 
green screen, which is then keyed to 
make it transparent, thereby allowing 
the subject to be placed on a new 
background.
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The keying process is a procedural method of generating a matte, rather than the 
manually drawn mattes you used in previous lessons. The process of compositing with 
green screen is really an art unto itself, but a simple workflow can be followed for most 
keys. The trick is not to try to do everything with a single keying node. Focus the keyer on 
the fine detailed edges of your foreground subject, and then you can manage other areas 
with other tools. In the end, combining multiple mattes together will always get you better 
results quicker.

Completed composite for Lesson 5.

Managing Color for Visual Effects
Before you begin this keying lesson, we must cover some of the more technical aspects 
of compositing. Color management is a critical part of the visual effects workflow, and the 
requirements for compositing are slightly different than editing or color grading. You’ll 
start this keying job by setting up a scene-referred color managed workflow.

NOTE The Timelines bin includes a Backups bin with timelines saved at various 
stages of the lesson and a Completed Projects bin with finished compositions. 
These bins are both available for reference and reverse- engineering the 
node trees.
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1 Open DaVinci Resolve, and in the Project Manager, open the R18 Fusion Guide  
Lessons Part 1.dra project that you have been using for the past three lessons.

2 From the Timelines bin, double-click the Part 1-START timeline. Then go to the last red 
marker, which is over the green screen of our musician.

3 Click the Fusion page button.

This shot from a Steve Vai music video is typical of a professional green-screen 
shoot. The first thing you might notice is that it appears to have low contrast and 
low saturation. This is often the case with content acquired on modern digital 
film cameras. Digital film cameras apply a very pronounced gamma curve to clips 
to achieve a higher dynamic range. To a much lesser extent, every HD video clip, 
Photoshop document, or web graphic has a nonlinear gamma value based on either 
an sRGB or Rec 709 2.4 color profile.

The problem with using nonlinear gamma curves is that compositing operations 
expect images to have linear gamma, not modified gamma values. Why? Because the 
math used in almost every compositing operation works more predictably assuming 
images have linear gamma.

So, if you simply click the Fusion page and start working on your HD or RAW content, 
you’re starting out on the wrong foot.

To composite, you first need to remove the nonlinear gamma curve from this green-
screen shot and convert it to linear. Then, you’ll reverse the process and ensure that the 
output from the Fusion page will apply the correct nonlinear gamma according to your 
output format. Sound confusing? Don’t worry; DaVinci Resolve handles all of this with 
very little effort from you. You just need to enable DaVinci YRGB color management.
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4 Choose File > Project Settings, and in the sidebar, click the Color 
Management category.

5 In the Color Science menu, choose DaVinci YRGB Color Managed.

The metadata embedded in camera-original clips carry information about the clip’s 
gamma curve and gamut. The “Output color space” dropdown menu in the settings 
defaults to Rec 709 gamma 2.4. That will work for our purpose, but you may change 
that in the future based on your final output. The Color Management preset primarily 
handles the feel of controls on the color page and how high dynamic range (HDR) clips 
are tone mapped for specific outputs. Again, the default for SDR Rec 709 will work for 
our green screen.

TIP If you do not have a calibrated HD display connected to your computer 
when creating visual effects, it is more common to set the output color space to 
sRGB to match your computer display.

6 Click Save to close the window.

The image in the viewer now appears with more saturation and more contrast.

Turning on Color Management performed a number of processing steps automatically. 
It first converted the Media In nodes to linear gamma. The second step it performed 
was to enable a LUT (Lookup Table) in the viewer, so you are not looking at the linear 
image. Images in linear color space are rather dark and highly saturated and therefore 
unpleasant to work with. The viewer LUT makes for a more natural viewing experience, 
while still allowing you to composite correctly using linear gamma images.
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7 In the upper-right corner of the viewer, click the LUT button to disable it, revealing the 
linear image.

A viewer LUT is a simple color adjustment applied to the viewers in the Fusion page. 
The image itself is not changed, but only its display in the Fusion viewers. Rather 
than showing the image with linear gamma, Resolve enables the viewer LUT to 
convert the linear gamma image to the output color space identified in the color 
management setting.

8 In the upper-right corner of the viewer, click the LUT button to re-enable it and thus 
view the corrected image.

TIP If you don’t use color management, you can add a gamut or Cineon LOG 
tool after every Media In node to convert it to linear gamma. Then, add a gamut 
or Cineon LOG tool just before the Media Out node to convert back to the final 
output gamma setting.

You are now able to composite using images that look correct, but more importantly, will 
act correctly during compositing. And when you switch to the edit or color pages, all the 
gamma curve corrections are managed automatically, based on the output color space 
setting that you configured in the Color Management Project Settings.
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Why Use Linear Color Space?
The different gamma curves in a post-production workflow, from your camera, the 
displays, and even the way the human eye perceives light, are not helping when it comes to 
compositing. Why is that? You can blame it all on math.

The majority of compositing tools calculate their effects expecting linear gamma. When 
given images with nonlinear gamma, you can get unexpected results. When images are 
composited using linear gamma, each step in brightness represents a uniform change 
of intensity rather than of a change in your perceived brightness. Let’s look at a simple 
black to white gradient to help explain this. In the real world (not the one you perceive 
with your eyes), light is linear. Think of brightness as being a scale that starts with black at 
0 and white topping out at 1.0. Based on this linear tonal range, 0.5 is half the intensity, or 
middle gray.

Linear Gamma

LOG Gamma

Middle Gray

Middle Gray

When you apply a LOG gamma curve, similar to images from a digital film camera, middle 
gray is moved and ends up being somewhere around 0.2!

Your middle gray value isn’t actually middle gray any longer and no one has told all the 
color correction tools about this change! These tools still assume middle gray is based on 
linear gamma, and they will operate based on that assumption. Of course, you cannot have 
different color correction tools for each and every gamma curve and image format, so the 
easiest thing to do is remove all nonlinear gamma curves and work with linear gamma.
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In a more practical example, below we have applied the same color correction on this 
split-screen RAW image. We raised the gamma by 25% and boosted green and yellow in 
the midtones as well. The lower-left side of the split screen shows the adjustment done 
using the original LOG gamma, and on the upper right the adjustment is done with linear 
gamma. Both images were then converted back to sRGB with a split wipe for display on the 
monitor and print.

Linear Gamma

LOG Gamma

Notice the lack of contrast on the lower-left face. There is also a noticeable midtone color 
shift on the log image with a lot more red appearing on the skin and light.

Similar differences happen even with HD content; however, the difference is much less 
considering the gamma curve for HD is closer to linear. All of this is due to the fact that 
most compositing operations do not handle nonlinear gamma curves. They expect that 
light is linear, so when you add +2 to brightness, the shadows, midtones, and highlights 
are increased equally. Color correction is not applied differently to the midtones than to 
other regions.

The correct way to composite images is to use a scene-referred color management 
system like DaVinci YRGB Color Management or ACES and convert any nonlinear gamma 
curve to linear. You can then composite without worrying and allow the scene-referred 
color managed system to handle the conversion back to your final output display. 
This is how DaVinci Resolve and the Fusion page can work to give you more accurate 
compositing results.
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Pulling a Green-Screen Key
With the color management correctly set up, you can begin the keying process. As you 
know, combining shots requires a matte: a grayscale image that identifies parts of the 
foreground as transparent and other parts as opaque. Unlike computer-generated images, 
this live-action green-screen shot does not include an alpha channel. So, it is up to you to 
create the matte through keying. This is often termed “pulling a key.”

NOTE In this lesson, the shot you will work on uses a green screen, but the keying 
process works the same for blue-screen content.

1 In the Node Editor, select the MediaIn1 node, and rename it to GREENSCREEN.

2 In the upper-left corner of the interface, click the Effects Library button. All the tools 
for keying are located in the Tools > Matte category.

3 Click the tools disclosure arrow and select the Matte category. Click the Delta Keyer.

Because the GREENSCREEN node was selected in the Node Editor, the Delta Keyer is 
connected to the GREENSCREEN output. Whenever you are keying, it is helpful to use 
two viewers: one where you can see the final output, and the other where you can 
view the quality of your matte.

It’s worth noting that since the tile picture isn’t “aware” of the LUT applied to the 
viewer, it simply displays the linear image direct to screen, making the contrast appear 
darker than the viewer image we’re working with.

4 If you are not already in a dual viewer setup, from the upper-right corner of the viewer, 
click the Single/Dual Viewer button to display two viewers.

5 Click the Effects Library button to close the panel and open up more room for 
the viewers.
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The Delta Keyer is the primary tool used for green-screen and blue-screen keying in 
the Fusion page. As powerful as it is, it is also very simple to use.

TIP The term chroma key represents a specific, simplified process of extracting 
a matte based on a range of hue and saturation in an image. Modern keyers 
like the Delta Keyer use a more sophisticated color difference method to 
extract the matte.

6 Select the Delta Keyer node and press 1 to display its output in viewer 1.

TIP Make sure both viewers have the viewer LUT enabled.

Your first step will be to sample the key color in the foreground image and make it 
transparent. Doing so tells the keyer whether it is keying a blue, red, or green screen 
and also dials in a few other optimizations.

7 In the Inspector, drag the background color Eyedropper and move it over the green 
screen in viewer 2.

For convenience, Fusion draws an underlay pattern to indicate transparency. When 
keying, however, this can make it difficult to see unwanted noise in the background. 
We can turn the underlay effect off in the viewer menus.
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8 In the viewer menu, deselect Checker Underlay.

9 Repeat for the other viewer.

TIP When sampling an area of the frame for a key color, select an area where 
the audience will be focusing its attention in the final shot. Doing so sets you 
up for creating an optimal key.

10 Release the mouse button when the Eyedropper is near the guitarist’s shoulder, 
screen right.

TIP As you select an area over the screen color, holding Command (macOS) 
or Ctrl (Windows) allows you to drag out a rectangle to select an average 
of an area.
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The green background mostly displays the checkboard. You’ve now created a matte for 
the foreground shot by selecting a green color. Even if this matte looks satisfactory in 
the viewers, you always need to check it for overall quality.

11 Above viewer 1, click the Color Controls button, or click the mouse button in viewer 1 
to make it the active window and press the A key.

The matte for your live-action shot is displayed in viewer 1. A single click of the 
Eyedropper typically produces a matte with lots of gray (semitransparency).

12 Drag the Gain slider slightly up to subtract more value from the green background. 
Adjusting gain too far will cause some of the white foreground to become transparent, 
so you only need to increase it a small amount. Staying under 1.3 should be safe.



136 Lesson 5 Compositing Green-Screen Content

13 Drag the Balance slider to the right until it is between .3 and .4. The Balance slider 
takes more or less information from the colors other than the screen color—in this 
case, red or blue. Dragging it to the left causes blue to be more transparent, while 
dragging it to the right causes red to be more transparent. Since there is a lot of red in 
this foreground subject, dragging it to the left removes some of the transparency from 
the foreground.

Although this is not nearly good enough for the final result, this is a good start, since it 
retains all the fine hair detail.

Even with the cleanest of green-screen keys, such as you have here, you must refine the 
matte a bit to ensure that areas intended to be opaque appear as solid white, and the 
areas intended to be transparent appear as solid black.

Refining a Matte
Refining your matte is done within the Delta Keyer. Taken in stages, the first stage is to 
ensure that you have selected all the various shades of green you can, without causing any 
damage to the fine details in the matte. This pre-matte selection refinement is done in the 
Pre-Matte tab of the Inspector.

1 In the Inspector, click the Pre-Matte tab. 

The goal in the Pre-Matte tab is to select areas of your green screen that were not 
made transparent with the single-click Eyedropper. Selecting other areas will even out 
the color selection of the green screen.

TIP You can use the Clean Plate node in place of the Pre-Matte tab for more 
control over the pre-matte process.
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2 In viewer 1, drag a selection rectangle around the dark gray area to the left of his hat.

When making these pre-matte selections, be careful not to get too close to the fine 
hair details you’re trying to preserve.

It may seem as if you have a pretty clean matte, but your computer screen can play 
tricks with the gamma in your image. To offset the computer screen gamma setting, 
you can make a temporary gamma adjustment to the viewer that will allow you to 
check the matte for unwanted semitransparent areas.

3 From the Options menu in the upper-right corner of viewer 1, choose Gain/Gamma 
from the list.
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4 Drag the Gamma slider up about halfway to view any gray areas in the transparent 
background of the matte.

The gamma adjustment usually exposes some small areas that can be removed.

5 Drag a selection rectangle across any white specks that appear close to the guitarist.

During the pre-matte selection process, and during other matte refinements you’ll 
make later, do not concern yourself with parts of the screen that are not near our 
foreground subject. Those areas are best handled by other mattes. But, conversely, 
do not get too close to the fine hair details to prevent them from eroding.

The Pre-Matte keyer is designed to remove noise from the background but can 
unintentionally damage the soft edge of the main matte (in this case, the silhouette 
of the guitarist). To fix this, we can erode the pre-matte away from the main matte 
to prevent it affecting the soft edge. We can then add a little softness to smooth the 
transition between the pre-matte and the main matte.

6 Drag the Erode control up to around 0.002 to eat away at any holes created by the 
soft range.

7 In the Inspector, drag the Soft Range slider up to around 0.02 to expand the pre-
matte selection.

Both the soft range and the erode are small adjustments that you may decide to come 
back to later in the process if the edges around the subject become too pronounced.

To refine the matte density further, you can switch to the Matte tab of the Delta Keyer.

8 In the Inspector, click the Matte tab. 
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The Matte tab contains parameters for modifying the density and edges of the matte. 
It is arguably the most important tab in the Delta Keyer because the quality of your 
matte determines the quality of your key. By adjusting the Threshold sliders at the top 
of the matte tab, you clamp the black and white cut-off points. Values that fall below 
the Low Threshold setting are considered as pure black (transparent), and values that 
fall above the High Threshold setting are considered as pure white (opaque).

TIP As you make adjustments to the matte, zoom in to, and/or expand the 
viewer size to get a clearer look at the matte, especially around the fine 
hair details.

9 To clamp the black, transparent areas of your matte, drag the Low Threshold slider 
to the right until there are very few gray spots in the background. Again, pay extra 
attention to the hair details. The more you increase the Low Threshold, the more you 
eat away at the thin hair strands. In this shot, if you drag above 0.2 you have probably 
lost some hair detail.

10 To clamp the white areas of the subject, drag the High Threshold slider to the left until 
the white areas filling in the foreground are mostly pure white. Decreasing the High 
Threshold too much below 0.75 can cause the fine details to merge together.

TIP When refining the key, you are primarily concerned with getting good 
quality edges for your subject. The black transparent areas and the core of your 
foreground subject can be handled using various types of mattes.

The next steps are very subtle adjustments using the Clean Foreground and Clean 
Background controls. You generally apply these with an extremely light touch because 
they tend to cause harsh matte edges, but they can also “fill in” the small holes that 
appear in the black and white parts of the matte. As you adjust them here, you’ll use a 
combination of the keyboard and the slider to make very small-scale adjustments.
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11 To fill in any black holes in the white areas of the matte, hold the Command key 
(macOS) or the Ctrl key (Windows) and drag the Clean Foreground slider to around 
0.0005, and then do the same for Clean Background.

12 From the Options menu, choose Gain/Gamma from the list to close the overlay and 
reset the gamma in the viewer.

It will be impossible to refine the matte to the point where it fixes every pixel of the frame 
without also sacrificing some of the hair detail. You’ll find that for every shot, compositing 
with green screen requires multiple tools that work together. However, the basic 
adjustments in the Delta Keyer that you have completed here are a useful starting point 
for any key.

Rotoscoping Auxiliary Mattes
Your matte still has unwanted areas such as the gray or semitransparent areas around 
the lower portion of the guitar and a few white specks in the black transparent areas. 
Sometimes, you won’t be able to key out everything, so you need to pull out the digital 
duct tape, more formally known as auxiliary mattes.

Auxiliary mattes are mattes other than the main core matte created by the key. These 
auxiliary mattes help to patch matte holes that are impossible to patch otherwise. Two 
auxiliary mattes are used regularly on every keying job. One is the garbage matte that 
removes areas of the set not covered by the green screen. The second is a holdout matte. 
The holdout matte covers up unwanted semitransparent areas in the foreground that the 
keyer didn’t catch. Let’s start with creating a garbage matte.
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1 From the toolbar, drag a B-Spline tool into the Node Editor under the Delta Keyer. 

2 Select the B-Spline node and rename it to GMATTE.

When drawing a matte, it is sometimes easier to use a B-Spline tool rather than Bézier 
splines as you have been doing. B-Splines produce smoothed, curved edges without 
the need to manage handles. For consistently smooth curved shapes (when you’re not 
concerned with making extremely detailed shapes with lots of corners), B-Splines can 
be easier to work with.

Let’s use the B-Spline tool to draw around the area you want to keep, and then invert 
the matte.

TIP When you draw a shape with a B-Spline curve tool, the control points you 
set influence only the shape of the curve. The control points do not define the 
location of the actual spline curve. That being the case, it is best to start by 
drawing a very loose shape, and then adjust the control points to create the 
curve you need.

3 In viewer 1, draw a wide, rough shape around the guitarist.
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TIP Similar to drawing a polygon spline, remember to close the matte by 
clicking on the first control point you added or by pressing Shift-O.

4 Once you finish drawing the matte, Option-drag (macOS) or Alt-drag (Windows) from 
the GMATTE output to the Delta Keyer node.

5 Release the mouse button, and in the Input pop-up list, choose Garbage Matte.

TIP You can adjust the smoothness of a B-Spline’s curve by holding down the 
W key, selecting the control point for the curve, and dragging left or right to 
increase or decrease the smoothness.

Because you drew this garbage matte around the subject, the guitarist’s silhouette is 
removed from the shot. You need to invert it.

6 Select the GMATTE node and, in the Inspector, click the Invert checkbox.

This matte is done only for a single frame, and this guitarist likes to move as he plays. 
The drawing of polygon or B-Spline mattes and animating them over a series of frames 
is called rotoscoping. A basic rotoscoping technique is called divide and conquer. Divide 
and conquer bifurcates the clip with keyframes and continually divides each section 
with keyframes until the motion of the object is covered. This ensures that you only 
add keyframes when absolutely necessary.

7 Move to the end of the render range.

By default, after you close a polygon shape, any change you make to a control point 
adds a keyframe. Changes to the shape on different frames are interpolated. This 
behavior makes it incredibly efficient to animate small changes to your matte as the 
subject in your clip moves.

8 Refine the shape to better fit around the guitarist by adjusting any of the control 
points along the B-Spline. 
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TIP When animating a spline, you can move the entire shape by clicking the 
Select All Points button in the viewer toolbar and then dragging the points to a 
new area in the viewer. Moving the Center X and Y parameters or the onscreen 
Center control will not add a keyframe.

When using the divide and conquer technique, the idea is to set keyframes at the 
start, end, and middle of your animation. You then continue to divide those segments 
by adjusting the shape to fit at halfway points between keyframes until the shape’s 
movement in each segment accurately matches the object that you’re trying to rotoscope.

9 Move to the middle of the render range, around frame 570.

10 Adjust the control points to fit around the guitarist.

11 Repeat the process by dividing the keyframed sections from frame 530 through frame 
570 so that the animated shape fits the guitarist throughout the moving shot.

Above the viewer is a viewer toolbar, which is used to modify the spline shape.

12 When you come to a point where you must move the entire shape, click the Select All 
Points button in the viewer toolbar and drag a control point to move all the control 
points and set a keyframe.

TIP Pressing Option-Left and Right Arrow (macOS) or Alt-Left and Right 
Arrow (Windows) will move the playhead to the next and previous keyframe, 
respectively, to help you more quickly refine the polygon matte.

13 Once you finish with the first half of the shot, divide the second half starting at frame 
570 through frame 603. Adjust the shape wherever you feel a keyframe is needed, 
continually dividing sections as you go.
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Rotoscoping a Holdout Matte
Another auxiliary matte you will typically create does the opposite of the garbage matte. A 
holdout matte fills in any holes that appear in the white matte of the foreground subject. 
Some bright areas of the white guitar have caught green bounce light from the screen. To 
correct this area, you’ll draw another polygon shape to cover the dark gray area where the 
body of the guitar is located.

1 Move to frame 560 where you can clearly see the gray area in the matte.

2 From the toolbar, add a Polygon node into the Node Editor, next to the GMATTE node, 
and rename it to HOLDOUT.
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3 In viewer 1, zoom in to the matte and draw a shape around the midsection of the 
matte to cover up any gray areas.

TIP You should be able to create this matte with around 15 keyframes.

The holdout matte must be connected to a different input of the Matte control 
than your garbage matte. A holdout matte is connected to the solid input on the 
Delta Keyer.

4 Option-drag (macOS) or Alt-drag (Windows) from the HOLDOUT output to the Delta 
Keyer node, and in the Input pop-up menu, choose Solid.

5 Using the divide and conquer technique again, adjust the polygon Bézier matte for 
the remaining frames in this shot. Use the Select All Points button above the viewer or 
draw a selection rectangle around a group of control points to move them, and then 
refine any single points as needed.

TIP An alternative to drawing a holdout matte is to create a very hard matte 
using the Delta Keyer and then connect that into the Solid input.

A note about garbage mattes and holdout mattes: Often people unaccustomed to creating 
green-screen composites attempt to do everything in the keyer. Let me dispel that myth 
right now. Using auxiliary mattes is not an admission of a failed key. The use of auxiliary 
mattes means that you are being smart about your time and are aware of the entire 
process. Use a keyer for what it’s good at: creating soft edges and extracting the fine hair 
detail. Use the auxiliary mattes to avoid wasting time fiddling with keyer controls for items 
easily done with a spline shape.
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Lining Up the Background
You can only go so far adjusting the matte against a black background. Eventually, you 
must view the foreground over the actual background clip to get a complete picture of 
the matte quality.

1 In the upper-left corner of the interface, click the Media Pool button, and from the 
keying bin, drag the BKGD HD clip into an empty area of the Node Editor.

2 Close the media pool to make more room for your viewers.

3 Press 2 to see the clip in the viewer.

The viewer is empty, as if there is nothing to see. Remember that the comp has start 
and end times based on the source clip from the edit page timeline. If you view the 
render range, it starts at frame 530. Unless the background clip you brought in is 
over 530 frames long, it will not be visible in this composition. It’s helpful to view the 
Keyframes Editor when bringing in new clips to see where they are located in time. 

4 In the upper-right corner of the window, click the Keyframes button.

By default, the Keyframes Editor shows only tracks for animated controls. You’ll need 
to switch the filter menu to show all the tracks.

5 From the filter menu in the upper-right corner of the Keyframes Editor, choose 
Animated to disable the filter.

The Keyframes Editor now shows all the tracks, including the background node. It is 
clear now why the viewer is empty. The background node clip begins at frame 0 and 
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ends at frame 73. This is a full 437 frames before the comp starts. You can use the 
Global In/Out controls in the Inspector to slide the background clip into place.

6 Select the MediaIn1 node in the Node Editor.

7 At the top of the Inspector, position the mouse pointer between the two Global In/
Out handles.

8 Drag the Global In/Out bar to the right until you get near the 530 start frame.

9 When the Global In is near 530, zoom in to the Keyframes Editor and slide the clip into 
place by dragging over it as you would in the edit page.

Now you are able to view the clip in viewer 2.

10 With the MediaIn1 node selected, press F2 and rename the clip BACKGROUND. 
To view the key over the background, you’ll use a Merge node.

11 In the upper-right corner of the window, click the Keyframes button to close the panel.

12 Click the connection line near the yellow input of the Media Out node to disconnect it. 

13 Drag the output of the Delta Keyer to the output of the BACKGROUND node to create a 
Merge node.



148 Lesson 5 Compositing Green-Screen Content

14 Drag the output of the Merge node to the Media Out node.

15 Select the Merge node and press 2 to display it in viewer 2 to see the initial composite.

Although this looks good for the amount of work we’ve done so far, the foreground and 
background still look like very different images. The next step is to color correct both 
elements so they appear as if they are in the same location.

Color Correcting Elements
Color correcting the background and foreground is done for two reasons. The first is to 
remove any green color that remains on the foreground subject, and the second is to 
match the foreground and background so they realistically appear to exist in the same 
setting. Let’s tackle the green tint issue first. The Replace Color at the bottom of the Matte 
tab in the Inspector already includes a fair amount of spill suppression.

1 Select the Delta Keyer and, in the Inspector, select the Matte tab.

Spill is created from bounced light reflecting off the green screen that spills onto 
the foreground subject. Since removing that green spill is inextricably linked to the 
process of extracting a matte, you will sometimes create holes in your foreground 
matte. This is due to the Replace Color attempting to remove the green-screen color 
that has spilled onto your foreground. You inevitably must balance the quality of the 
spill suppression with the generation of the matte. A way around this dilemma is to 
set the Replace Color to Source.
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2 At the bottom of the Inspector, set the Replace Mode dropdown menu to Source.

Setting the Replace Color to Source reintroduces an amount of the original green-
screen pixels instead of trying to remove them. However, you are now left with green 
spill on the musician.

You can remove spill fairly easily using a Color Corrector node directly after the 
Delta Keyer. 

3 From the toolbar, insert a Color Corrector node between the Delta Keyer and the 
Merge1 node.

The Color Corrector node includes several modes for correcting highlights, midtones, 
and shadows, as well as spill suppression.

4 At the top of the Color Corrector Inspector, choose Suppress from the menu.

TIP Zoom in to the viewer as far as needed to view the changes as you reduce 
the spill colors.

The Suppress wheel allows you to drag the control point for the desired spill color 
toward the center, thereby reducing its saturation.



150 Lesson 5 Compositing Green-Screen Content

5 To reduce the green and some of the bright yellow tint around the edges of the 
foreground, drag the green and yellow control points in toward the center of the 
color wheel.

TIP In many cases, spill suppression can produce a noticeable reduction in 
image brightness. You can counteract this effect by slightly raising luminance.

6 With the Color Corrector node selected, press Command-P (macOS) or Ctrl-P 
(Windows) to disable the spill correction. Then, press that keyboard shortcut again to 
re-enable the spill suppression.

Now you can focus on matching the foreground and background. You can choose to 
perform the foreground color correction in the Fusion page by adding additional Color 
Corrector nodes, or, since you have the world’s best color grading tools on the color page, 
you can perform the color correction there.

Sending a Matte to the Color Page
As you have experienced, the Delta keyer is an amazing tool for green-screen shots. 
And although the Fusion page also includes extremely adept Color Correction nodes, 
DaVinci Resolve offers world-renowned color grading tools on the color page. So, in some 
cases you may want to use the two pages together for compositing a shot. In this exercise, 
you’ll use the matte from the Delta Keyer to color match the foreground and background in 
the color page. It’s a simple process to show you how easy it is to bring mattes from Fusion 
into the color page.
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Adding a Second Media Out Node
The main requirement in sending the matte from the Fusion page to the color page is 
adding a Media Out node. 

1 Click in an empty area in the Node Editor above the Delta Keyer node.

Clicking in an area of the Node Editor is a way of pinpointing where a node should be 
placed when you add the next node.

2 Press Shift-Spacebar, type MediaOut, and then press Return/Enter to add the node to 
the Node Editor.

3 Drag the output of the Delta Keyer to the input of the MediaOut2 node.

The first Media Out node in the Node Editor always goes to the edit page. Additional 
Media Out nodes go to the color page. You can add as many Media Outs as needed for 
sending multiple mattes. 

Setting Up the Color Page
Most of the time that you use nodes in the color page, you are processing color data. 
Occasionally, you may add an external matte from the media pool. In our case, we need to 
add a source from the Fusion page.

1 Click the color page.

The green-screen clip you were working on in Fusion is now the currently selected clip 
in the color page. You need to add a source that represents the MediaOut2 node (the 
matte) from the Fusion page.
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2 In the Node Editor, right-click in an empty gray area and choose Add Source.

The source is added as a green icon on the left side of the Node Editor, directly under 
the RGB source from the edit page. This second source is from the MediaOut2 in the 
Fusion page. You can use it as either RGB data or an alpha channel since it includes 
both. For this exercise, we’ll use the second source as an alpha matte source.

3 Drag the output of the second source to the key input of node 1.

You now have a mask connected to node 1 so that any color correction you do will be 
limited by the mask from the Fusion page.

4 Using the color page Gamma color wheel, lower the master wheel, push the color 
toward yellow/green, and lower the overall saturation to better match the guitarist 
with his background.
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The main point of this green-screen lesson is not only to teach you the steps in setting up 
a green-screen key, but perhaps more importantly to show you that keying a foreground 
subject is almost never completed using only one tool. It’s far more common to employ 
multiple techniques to address separate areas. In the end, if you learn to break down the 
foreground into its own small problematic areas, you can address each area with different 
tools to get the best possible results.

If you stopped here, you could be rather pleased with the results we’ve achieved in such a 
small amount of time. However, you can also go the extra step and make it really special by 
continuing on with Appendix A, which will introduce you to an additional color correction 
step called a light wrap.

Completed node tree for Lesson 5.

Lesson Review
1 In the Fusion page, what is the primary tool for pulling a green-screen key?

2 True or false? A solid matte connects to the Delta Keyer in order to fill any holes 
that appear in the white matte of the foreground subject.

3 True or false? Removing spill or bounce light coming from the screen onto the 
foreground subject requires that you add a Color Corrector node.

4 True or false? Adjusting Threshold in the Delta Keyer suppresses spill on the foreground.

5 What project setting must be enabled for the Fusion page to automatically switch 
all Media In nodes to linear gamma?
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Answers
1 The Delta Keyer is the primary tool for green-screen keying.

2 True. A solid matte connects to the Delta Keyer to fill holes in the foreground subject.

3 False. Removing spill or bounce light coming from the screen onto the foreground 
subject can be done in the Delta Keyer or additionally in a Color Corrector node.

4 False. Adjusting Threshold can clip only the black or white levels in a matte. It cannot 
modify the RGB levels for spill suppression.

5 The Color Science setting must be set to DaVinci YRGB Color Managed to convert all 
the Media In nodes to linear gamma in the Fusion page.



Part II

Titling and 
Motion Graphics
One of the most interesting aspects of Fusion is that it can be used both for visual 
effects work and for motion graphics. In this section, you’ll learn how to animate 
text and images using Fusion’s powerful keyframing, linking, and modifier system.
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Time
This lesson takes approximately 
40 minutes to complete.

Goals
Starting with a Fusion Generator 158

Adding a Text+ Node 160

Aligning Text with Tabs 162

Formatting a Single Line 166

Inserting Logos and Graphics 168

Making Credits Roll 171

Converting to Pixel Values 172

Setting and Looping Keyframes 174

Lesson Review 177

Every scripted project, documentary, 
or reality program ends with credits.

A lot of effort and thought goes into 
deciding how those credits look and 
the order in which the crew is listed. 
Since there are no rules that guide 
how credits are displayed, whoever is 
finishing the project must be flexible 
with the setup. One day all the text 
may be justified to the left; the next 
day it is centered.

Lesson 6

The Art of the 
Credit Roll
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Although not principally designed for animating credit rolls, the flexibility inherent in 
Fusion’s node-based interface turns out to be surprisingly good at producing credits. 
Building a credit roll will reinforce some of the text functions you learned in Lesson 1, 
while introducing you to some more advanced formatting and animation options.

Completed composite for Lesson 6.

Starting with a Fusion Generator
To start, you’ll restore a new archive that will be used for the next three lessons that make 
up Part II of this book.

1 Open DaVinci Resolve. In the Project Manager, right-click and choose Restore 
Project Archive.

2 Navigate to the R18 Fusion Guide Lessons folder you downloaded and restore the 
Fusion 18 Lessons Part 2.dra project.

When designing text, especially a credit roll, you don’t necessarily need a video clip. 
You just need a blank canvas on which to create. For those situations, you can add a 
Fusion composition effect to your timeline and begin designing whatever you want.

NOTE The Timelines bin includes a Backups bin with timelines saved at various 
stages of each lesson and a Completed bin with finished compositions. These 
bins are available for both reference and reverse engineering the node trees.
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3 In the edit page, load the Part 2 Timeline- START timeline if it isn’t already loaded. 

4 Open the Effects Library, and then select the Effects category.

The Effects category includes two effects that act like containers for other effects.

5 Drag the Fusion Composition effect to the end of the timeline, making it the last clip.

6 Right-click over the Fusion Composition and choose Change Clip Duration. In the 
dialog, enter 10000 to create a 1-minute clip, and then click Change.

TIP When entering timecode in Resolve, there’s no need to enter the colons 
between the various time denominations. Resolve will automatically do 
this for you.

Admittedly, this is on the shorter side of credit rolls, but rather than having you sit 
through 5 minutes of credits, without the hope of seeing outtakes from the movie, this 
will work for learning purposes.

7 Position the playhead over the Fusion Composition effect in the timeline and click the 
Fusion button to go to the Fusion page.

A single Media Out node is the only node in the Node Editor. When using the Fusion 
Composition effect, you have no Media In nodes. It is up to you to add whatever content 
is required.
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Adding a Text+ Node
When you need to create text in the Fusion page, the primary tool is the Text+ tool. You 
use it for any 2D title designs, from dynamic opening titles to simple credit rolls. You’ll add 
a Text+ tool to the Node Editor and then begin adding and formatting the text for your 
credit roll.

1 Just before the first divider in the toolbar, drag the Text+ tool into the Node Editor and 
connect it to the Media Out node.

No matter what you are creating or how you started the Fusion composition, 
you always need to connect to the Media Out node to render back into the edit 
page timeline.

TIP You can also find the Text+ tool in the edit page Effects Library or the cut 
page Title Library. Adding it to the edit page or cut page timeline provides the 
same text formatting controls you’ll find here, in the Inspector.

You’ll need only one viewer for this lesson. To give yourself more room, you can use 
either viewer 1 or viewer 2 in a single-viewer layout by clicking on the Single Viewer 
button in the upper-right corner of either viewer.

2 In the upper-right corner of viewer 1, click the Single Viewer button.

3 Select the text node in the Node Editor and press 1 to see it in the viewer.
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4 In the Inspector’s Styled Text field, enter DREAMLAND PRODUCTIONS, and then press 
Return/Enter to create a line break.

5 Set the Font to Open Sans and set the font typeface to Regular.

6 Change the text size to around 0.05.

TIP The text size is not based on font point size but is measured relative to the 
width of the frame. Therefore, changing the resolution maintains the relative 
size of the text in the frame.

You can enter multiple lines of text and format them how you want. However, the easiest 
method for a credit roll is to write them in a word processor and then copy and paste them 
into the Text+ tool.
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Aligning Text with Tabs
Credits can be hundreds of names long. Grouping your credits into categories is the only 
way to keep things organized. You can have all the information, but unless you carefully 
organize it, you won’t be able to correct names or reorder the credits easily. To start, write 
your credits in a simple text app or word processor. You can then check spelling and easily 
share it with other people in the crew who might not be involved in post-production. Once 
you have the text document, simply copy and paste it into the Text+ tool.

1 On your computer’s hard drive, navigate to the R18 Fusion Guide Lessons folder > 
Fusion files and open the CREDITS document in a text app or Notepad.

2 Select and copy the first two lines for the executive producer and the director.

Once you’ve copied the first two names, you can return to the Fusion page and paste 
them into the Text+ tool.

3 In the Inspector, click below DREAMLAND PRODUCTIONS to insert the cursor in the 
field, and then press Command-V (macOS) or Ctrl-V(Windows).

The text is pasted into the Styled Text field and is seen in the viewer. All words in the 
Text+ tool start center justified; however, that can be changed using tabs. You’ll leave 
DREAMLAND PRODUCTIONS center justified but add tabs to align the executive 
producer and director’s credits.
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4 In the text field, before the E in Executive Producer, insert the text cursor and press Tab.

5 Insert the text cursor before the R in Robert and press Tab again.

6 Do the same before the D in Director and the J in John, inserting a tab for each.

The text in the viewer appears a bit worse in terms of layout, but that is only because 
you have not positioned the tabs.

7 At the bottom of the Inspector, click the disclosure arrow to reveal the tab 
spacing controls.

When you add tabs to the text, the tab spacing controls allow you to position the tabs 
in the frame and determine how the text aligns with those tabs. The number menu at 
the top of the Tab Spacing controls indicates which tab you are currently adjusting.

8 Drag the position slider to -0.1, or to be more precise, enter -0.1 in the numeric field.

The tabs use a value of 0.0 as the center of the frame; -0.5 is the left edge, and 0.5 is 
the right edge. So, tab 1 is now set slightly off to the left of the center. However, the 
text is still center aligned on that tab. Using the Alignment slider, you can choose to 
align the text left, center, right, or any offset in between.

TIP Clicking the tab handle above the viewer cycles through left, right, and 
center alignment.

9 Drag the Alignment slider all the way to the right, right justifying the text on the tab.
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This causes the ending of the words Executive Producer and Directed By to be right-
aligned to the tab.

Now for tab 2, you’ll do the same setup in the opposite direction.

10 In the Tab Spacing controls, change the Tab pop-up to 2 to control the position and 
alignment properties for tab 2.

11 Drag the Position slider or type in 0.1 to move tab 2 off to the right.

12 Drag the Alignment slider all the way to the left, left justifying the text on the tab. This 
causes the start of both men’s names to be aligned to the tab.
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You now have the basic setup for your credit roll. Any text that you type or copy and 
paste into the Styled Text field is now center aligned in the frame unless they have 
tabs. If the text you type or paste includes tabs, the formatting is based on the tabs 
in the Text+ tool.

13 Return to the CREDITS document, select the text starting from the word CAST and 
including up to the last actor. Press Command-C (macOS) or Ctrl-C (Windows) to 
copy the text.

14 Back in the Fusion page Inspector, click below DIRECTED BY to insert the cursor in 
the Styled Text field, and then press Command-V (macOS) or Ctrl-V (Windows) to 
paste the text.
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TIP Before pasting the text, you may need to press Enter/Return to create a 
line break after the director’s name if you haven’t done so already.

Since the text document already includes tabs, the pasted text aligns to the tabs in the 
Text+ tool. The text layout in the viewer expands to include the new text, causing some of 
the text to fall outside the active frame area. Text that falls outside the active frame area 
can be seen as outlines, making it easy to read and format all the text in the credit roll.

Formatting a Single Line
If you change the font, size, or color of the text in the Text+ node, it changes the entire text 
block that you have entered. To change the style of a single letter, word, or line, you must 
use a special modifier called Character Level Styling.

1 Right-click in the Styled Text field and choose Character Level Styling from the menu.

Modifiers provide add-on functionality to the core capabilities of a tool. They are 
applied by right-clicking on the parameter you want to modify and choosing the 
appropriate modifier. The Character Level Styling modifier allows you to override the 
Text+ tool’s global styling. Now, you can select the letters in the viewer that you want 
to style differently.
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2 With the mouse pointer over the viewer, hold the Command key (macOS) or the Ctrl 
key (Windows) and scroll the middle mouse wheel until you are able to see the outlines 
of the DREAMLAND PRODUCTIONS text above the frame.

You’ll style the DREAMLAND PRODUCTIONS heading using bold typeface.

3 Drag a selection rectangle around DREAMLAND PRODUCTIONS to select it, being 
careful not to select other letters.

4 In the Inspector, click the Modifiers tab.

When using a modifier, all adjustments for the modifier must be done in the Modifier 
tab of the Inspector.
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5 Set the font typeface menu to Bold and set the Size to 0.06.

You can still return to the main tools tab in the Inspector to change the main body of the 
text. Text that has character level styling only updates if you select the text in the viewer 
and use the Modifiers tab.

Inserting Logos and Graphics
Very often, credits are not limited to text, and you come across logos that you must add 
into the credit roll. Using a Transform node and a Merge, you can insert your logo or 
additional pages of text anywhere in the credit roll.

1 In the upper-left corner of the window, click the Media Pool button.

2 Select the Credit Roll bin and drag the DREAMLAND LOGO tiff into an empty area of 
the Node Editor.

3 Select the Text1 node in the Node Editor and click the Merge tool in the toolbar 
to add it.

4 Connect the output of the MediaIn1 node to the output of Text1 to create a 
Merge node.
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5 Select the Merge node and press 1 to see it in the viewer.

Like all images you add to the Node Editor, its location is in the center of the frame. 
Media In nodes have no inherent positioning controls built into them. If you want to 
move or scale a Media In node’s image, you must use a Transform node. 

6 Select the MediaIn1 node and, from the toolbar, click the Transform tool to insert it 
between the MediaIn1 node and the Merge node.

7 In the Inspector, drag the Size slider down to about 0.5.

Assuming you want this logo to appear at the end of the credits, to position it 
accurately you’ll need to see the logo in context with the cast text.

8 In the Node Editor, drag a selection rectangle around the Text1 node, the Merge node, 
and the MediaIn1 node and its Transform node.

Now you can see the cast text and the logo in the viewer. Instead of scrolling the 
viewer back to see the last name of the cast text, you can get away with just panning 
the viewer up.
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9 In the viewer, press the middle mouse wheel and drag up until you are able to see the 
bottom of the cast text, and a bit below where you will want the logo to be positioned.

10 In the Inspector, use the Transform1 Center Y controls to position the logo below the 
cast text.

You can continue adding new pages and logos to create longer credits, using additional 
Text+ nodes for each department in the crew. Once you have everything in place, you can 
create the actual movement for the roll.
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Making Credits Roll
Animating in Fusion is not very different from animating in the edit page. Although the 
Fusion page provides in-depth tools for refining animation, to get something moving you 
can just use the Inspector.

1 Position the playhead at the start of the render range by dragging the red playhead or 
by clicking the First Frame button in the transport controls.

The easiest way to move the text and the logo is to add a Transform tool directly after 
the Merge node. This causes both the text and the logo to be controlled by the new 
Transform node simultaneously. Changing the Transform parameters causes any items 
connected to its input to follow.

2 Select the Merge node and then, from the toolbar, click the Transform tool to insert it 
between the Merge node and the Media Out node.

3 Press 1 to see the Transform1 tool in the viewer.

4 To fill the viewer with the entire frame, choose Fit from the magnification dropdown 
menu in the upper-left corner of the viewer or click anywhere in the viewer and press 
Command-F (macOS) or Ctrl-F (Windows).
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5 Make sure the playhead is at frame 0 (the start of the timeline). In the Inspector, click 
the Keyframe button to the right of the Center X and Y controls.

Just like the edit page, you have now enabled keyframing for the Center X and Y 
position controls. You have also set a keyframe at the current playhead position.

6 In the Inspector, position the mouse pointer over the Center Y numeric field and drag 
to the left to lower the text in the frame. Keep dragging until the first line of the credit 
roll is out of the frame (around -1.2 or -1.3).

The easy method of finishing a credit roll is to move the playhead to the end, set a new 
keyframe, and scroll the text off the top of the frame. However, pesky motion artifacts 
typically result from using that technique. Whether you call it jitter, flicker, stutter, or 
strobing, fixing motion artifacts with credit rolls can seem hit or miss. Luckily, however, it is 
reasonably straightforward to correct this in Fusion.

Converting to Pixel Values
The only real way to achieve flicker-free rolling credits is to create a roll that moves two or 
three pixels per frame. It is essential that the roll does not move at a sub-pixel rate; it must 
use integer (whole number) values. This restriction is not dependent on which software 
you use. Wherever you create your rolling credits, to avoid flickering, you cannot arbitrarily 
set keyframes because that can result in fractional position values and hence flicker.

The first step in making the roll smooth is making sure you position elements based on 
pixels. By default, Fusion uses normalized screen dimensions that go from 0 (bottom of the 
frame) to 1 (top of the frame). You must convert those coordinates to use pixel values.
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Normalized Values Actual Pixels
1.0

0.5

0.0

1080

540

1

1 Select the Transform2 node.

2 At the bottom of the Inspector, open the Reference Sizing controls.

3 Click the checkbox for Auto Resolution.

The Auto Resolution checkbox converts the values in the Center X and Y fields to use pixels 
instead of the normalized values of 0 to 1. With the resolution set to represent pixels, a 
value of 1 represents the bottom of the frame, and 1080 represents the top. To create the 
actual roll, you’ll set the first keyframe to a whole number and set a second keyframe on 
the next frame, just three pixels higher. From there, you’ll use Fusion’s keyframe prowess 
to extrapolate the remaining duration of the roll.
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Setting and Looping Keyframes
To create a smooth roll, you need to move consistently in whole-number increments 
per frame. For instance, you must be able to move two or three pixels per frame on a 
consistent basis; otherwise, you risk introducing jitter in your credit roll.

1 Go to the start of the render range and look at the Center Y value. It probably has a 
value between -1200 and -1400 but with a few decimal points.

This is the starting pixel value for the Center Y position. You need to make sure this 
starts on an integer (a whole number). Let’s round off the starting Center Y value.

2 In the Inspector, enter -1300 for Center Y. This should be a large enough value to start 
the text off the screen and provides us with a nice whole number.

Now, you’ll set a second keyframe on the very next frame but only move the Center Y 
value by three pixels.

3 On the far-right side of the time ruler, enter 1.0 for the current frame. This will move 
the playhead one frame forward, to frame number 1.

TIP A Fusion Composition effect always starts with frame 0.

4 In the Center Y field, double-click to select the entire field, and then enter (minus) 
-1297. Then press Enter or Return.

Setting these two keyframes moves the text three pixels higher in the frame. Now you 
need a way to repeat that pixel movement on each subsequent frame for the entire 
duration of the roll. For this, you’ll use the Spline Editor.
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5 In the upper-right of the DaVinci Resolve window, click the Spline button. Then, in the 
upper left, click the Nodes button to hide the Node Editor, allowing more room to view 
your keyframes.

The Spline Editor is an incredibly deep panel used to refine the motion between 
keyframes. You’ll learn more about it in the next two lessons. For this lesson, all you 
need to be aware of is the list of animated parameters displayed on the left side and 
the toolbar displayed along the bottom.

The Spline Editor is divided into two sections. On the left is the header, and on the 
right is the graph area. The header shows all the animated parameters in the Node 
Editor. Using the checkboxes next to each parameter, you can show and hide the 
keyframes in the graph area.

6 Click the checkbox next to Transform to display the Transform animation line in the 
graph area.

The animation line (or curve) displayed in the graph shows how values are interpolated 
between keyframes. 

7 In the upper right of the Spline Editor, click the Zoom to Fit button to view the two 
keyframes in the graph area.

The straight line between the keyframes indicates a linear animation, which means 
it has a constant, steady rate of motion. For this lesson, you don’t need to move the 
existing keyframes in the graph area. You only need to make them repeat for the 
duration of the roll.
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Along the bottom-left corner of the Spline Editor are several different tools for 
manipulating selected keyframes in the graph.

8 Drag a selection rectangle around both keyframes in the Spline Editor.

9 In the lower-left corner of the Spline Editor, click Set Relative (the sixth button from the 
right end of the toolbar) to create a relative loop of the keyframes.

The relative loop repeats the selected keyframes for the entire duration of the effect. 
Each repetition starts where the last one left off and adds to it so that the values 
increase steadily over time. In our case, each loop is one frame long and changes the Y 
value by three pixels.

This is just a quick sample of the powerful tools you’ll discover in the Spline Editor that 
can make animation much more flexible and creative.

TIP Right-clicking over keyframes in the spline graph and choosing Gradient 
Extrapolation will provide similar results to a relative loop.

10 In the upper right of the Resolve window, click the Spline button to close the Spline 
Editor. Then, in the upper left, click the Nodes button to return to viewing the 
Node Editor.
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11 Click the edit page button.

12 Wait until the credit roll clip has cached, and then press Command-F (macOS) or Ctrl-F 
(Windows) and play the roll full-screen.

The credit roll is smooth and long enough to fit all our text. Naturally, for the amount of 
text you have, you would need to modify the duration, but the relative loop will take care of 
extending the animation.

Completed node tree for Lesson 6.

Lesson Review
1 True or false? The Fusion Composition Effect is a way to start a Fusion composition 

without requiring a video clip.

2 True or false? The Character Level Styling modifier is located in the Effects Library.

3 True or false? To change the position of a logo or graphic that has been imported from 
the media pool, select the Media In node and use the position controls.

4 True or false? Tabs can only be left, right, or center justified in Fusion.

5 True or false? To set a keyframe, you can click the diamond icon to the right of the 
control’s name in the Inspector.
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Answers
1 True. The Fusion Composition Effect is a way to start a Fusion composition without 

requiring a video clip.

2 False. The Character Level Styling modifier is applied by right-clicking in the Styled Text 
fields and using the Modifiers tab in the Inspector.

3 False. Media In nodes have no inherent position controls. You must use a 
Transform node.

4 False. The position slider in the Tab Spacing controls aligns the text to left, center, right, 
or any offset in between.

5 True. To set a keyframe, you click the diamond icon to the right of the control’s name 
in the Inspector.
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Lesson 7 

Creating 
Title Templates

Realistically, a credit roll has only a 
handful of design options since the aim 
is simply to convey information. When 
designing a main title, a tagline in a 
commercial, or lower thirds, you are not 
only conveying important information, 
but you must also add to the overall 
tone of the program and hold the 
audience’s attention. 

We briefly saw some of the functionality 
of the Text+ tool in the previous lesson, 
but the Text+ tool provides a fantastic 
amount of control over the look, layout, 
and animation of your title designs. 
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In this lesson, you’ll create different versions of an animated lower third and then save it as 
a template that you can reuse directly in the edit or cut page.

Completed title for lesson 7.

Styling Text in the Edit Page
To create an animated lower third title, you can begin in the edit page and temporarily use 
a video background to position the text. 

NOTE The Timelines bin includes a Backups bin with timelines saved at various 
stages of the lesson and a Completed Projects bin with finished compositions. 
These bins are both available for reference and reverse engineering the node trees.

1 Open DaVinci Resolve 18, and in the Project Manager, open the 
Fusion Lessons Part 2.dra project that you restored in the previous lesson.

2 From the Timelines bin in the edit page, load Part 2 -START. 
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3 Open the Effects Library and select the Titles category.

4 Drag the Text+ template into the timeline directly above the first clip, which contains 
our interview.

5 Select the Text+ clip and open the Inspector.

The Text+ template in the edit page is the same Text+ tool located in the Fusion page. 
You can begin creating titles in the edit page and then move to the Fusion page when 
you want to expand on the title animation.

6 In the Inspector’s Styled Text field, replace Custom Title with FULL NAME as the text 
we’ll use in our template.

7 Set the font to Open Sans and set the font typeface to Extrabold.
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8 Change the text Size slightly larger to around 0.1.

9 To make the text left justified instead of the default center justified, scroll down the 
Inspector and click the H Anchor Left button.

10 At the top of the Inspector, click the Layout tab.

TIP Similar controls (such as rotation) appear multiple times in the various tabs 
of the Text+ tool. As you’re learning, be careful to pay attention to which tabbed 
section the steps are being performed in.

Beyond the familiar text formatting options on the Text tab, the Layout tab is used to 
position the person’s name as a lower third title.

11 In the Inspector, drag over the Center X and Y fields to move the text to the left, lower 
third of the frame.

12 Click the Shading tab.
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The Shading tab is for styling the appearance of the text. Instead of using a single 
solid color, you can convert the fill type to a gradient.

13 In the Type options, choose Gradient.

In the gradient bar, you can assign the various colors that fill the text. The first white 
color stop sets the lower color of the gradient, the white color stop on the right sets 
the upper color, and you can add color stops along the bar to create multi-point 
gradients. The first color stop is selected by default, so you can set its color just 
by selecting it in the color swatch.

14 Open the color swatch and select a light, icy-bluish white color to set the lower 
gradient color.

15 To set the upper gradient color, click the white color stop on the right end of the 
gradient bar, and in the color swatch, choose a similar, darker icy blue.

TIP You can drag any color stop to reposition the spread of the gradient colors.

16 To add a new color stop to the gradient, click directly on the middle of the gradient bar.
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17 Drag in the color swatch to select bright white.

TIP To delete a color stop, drag it to the top of the Inspector.

To rotate the gradient angle so it spreads from left to right instead of top to bottom, 
you can use the Mapping controls under the color swatch.

18 Scroll down the Inspector and drag the Mapping Angle to the left until it reaches -90 
so the gradient travels horizontally across each letter.

19 From the Mapping Level menu, choose Line so the gradient is spread across the entire 
line of text, rather than each letter.

You can add the Text+ title in both the edit and cut pages. Consider it the go-to title for 
designing lower thirds and main titles because it has so many options. Here, it allowed you 
to correctly size and roughly position the text against a background video track. The other 
benefit of the Text+ title is that you can take it into Fusion and add some other elements 
along with some animation.
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Moving Text to the Fusion Page
Moving text from the edit page into Fusion is the same as moving a video clip or the Fusion 
Composition effect: just position the playhead and click the Fusion button.

1 Position the playhead over the Text+ title clip and click the Fusion button to go to the 
Fusion page.

As a continuation from the previous lesson, you’ll use a single-viewer layout. 

The title appears in the Fusion viewer precisely as you had it designed in the edit page. 
The node is labeled Template so you know it is a title template from the edit page. Let’s 
add a second line of text with the same attributes as our existing text.

2 Select the Template node and choose Edit > Copy or press Command-C (macOS) or 
Ctrl-C (Windows).

3 With the Template node still selected, choose Edit > Paste or press Command-V 
(macOS) or Ctrl-V (Windows).

A second Template node (Template_1) is created, and the two nodes are automatically 
merged. The original Template is connected to the background input on the Merge, 
and the new Template node is connected to the foreground input. Rearrange the 
nodes so that Template_1 appears above Merge1.

We’ll use a second Text node as a placeholder for the job title text in our lower third 
template. This will also allow us to animate the person’s name and their job title 
independently.

4 Select the Merge node and press 1 to display it in viewer 1.

5 Select the new pasted Template node, and in the Inspector’s Styled Text field, enter TITLE. 

TIP As a general rule, a change in font usually implies a change in meaning. 
Too many typefaces are distracting and can confuse the audience. Restrain 
yourself to using only one or two fonts in a single project. Use typefaces such 
as bold, light, or italics (as we have done here) to inject variety.
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6 Change the Font to Open Sans Light. 

The two text elements are seen in the viewer, but you still need to position the TITLE 
text under the FULL NAME text. 

7 At the top of the Inspector, click the Layout tab and drag the Center Y field to lower the 
text below the FULL NAME text.

8 To make sure you stay organized, rename each node based on the text you’ve entered: 
Template becomes NAME, and the new copied Template_1 becomes TITLE.

This is the general layout of the lower third title. The next steps will be to create some 
visual interest by animating the text.

Creating a Background Banner
The creation of graphical elements like background banners uses a slightly different 
approach than most motion graphics applications. You use a color generator as fill and 
a matte to cut the shape you want. We’ll create a rectangular background banner for our 
text. This makes the title stand out more when placed over video.

1 From the toolbar, drag a Background node into an empty area of the Node Editor. 
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The Background node is a color generator. It will create the background color of the 
banner background.

2 Press 1 to see the default black color in the viewer.

The Background node allows for both solid color and gradient backgrounds. For this 
banner, you will create a radial gradient.

3 In the Inspector, select Gradient from the Type menu and then choose Radial from the 
Gradient Type menu. 

The radial gradient has center color and an outer color represented on the gradient 
bar, and it also has a thin green line in the viewer.

4 Open the color swatch and select a medium blue color located in the center of the 
color swatch. 

5 Select the far-right color stop on the gradient bar and assign a dark blue, almost black, 
color from the color swatch. 

Next, you can add a mask to form the shape of the banner.

6 With the Background node selected, click the Rectangle mask tool in the toolbar.

Clicking any matte tool connects the matte into the blue effect mask input of the 
selected node. The rectangle mask trims the background into a smaller rectangle 
centered in the frame.
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7 In the Inspector, set the width to 1.0 and the height to 0.3.

8 Rename the background node to BANNER.

To position this correctly behind our text, you need to merge the banner using the text 
as the foreground.

9 Drag the output of Merge1 to the output of the BANNER node.
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10 Select the newly created Merge2 and press 1 to see it in the viewer.

Now that we can finally see all our elements in the viewer, you’ll need to position the 
banner under the text. You can do this by positioning the rectangle mask.

11 Select the Rectangle1 node and use the onscreen controls in the viewer to position it 
directly behind the text.

12 To make sure the new Merge2 is connected to the Media Out, drag the output of 
Merge2 to the input on the Media Out and replace the existing connection.

With the banner in place, we can now start our animation.

Revealing Text with Mattes
Static text implies “move along, nothing to see here,” and the audience tunes out. Even 
minimal text motion adds interest to flat type to help keep an audience focused long 
enough to read the message. You can animate text in many different ways in Fusion, but 
you’ll explore two of the most popular methods in this lesson. The first technique you will 
use is revealing the text with the use of a matte. 
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1 In the Node Editor, select the TITLE node and, from the toolbar, click the 
Rectangle tool.

The rectangle is added to the center of the frame, acting as a window of sorts. Since 
the text is positioned outside the rectangle, it is hidden from our view. We’ll use this 
rectangular window as a way to reveal our text through keyframing.

To start, the rectangle should be positioned lower to reveal the TITLE text, and it needs 
to be large enough to cover any potential title someone may enter into the template.

2 In the Node Editor, select the Rectangle2 node and drag its red transform controls 
in the viewer until the top line of the rectangle is aligned with the bottom of the FULL 
NAME text.
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3 Change the Width slider in the Inspector to 1.0 (Width, not Border Width), so the 
rectangle extends the width of the frame. The TITLE text reappears now that the mask 
is wide enough to reveal it.

You can now animate the Title text so that it begins outside the rectangle and then 
slides into place. 

4 Move to the start of the render range in the timeline.

5 Select the TITLE node and, in the Inspector, click the Layout tab.

6 To the right of the Center X and Y fields, click the Keyframe button.

7 Drag the Center Y parameter to the right until the TITLE text disappears above the 
rectangle mask.

8 Move the playhead to frame 15.

Here is where the TITLE text will reappear onscreen. 

9 Drag the Center Y parameter to the left until the TITLE text appears back into position 
below the FULL NAME text.

10 Move to the start of the render range.

11 Click the Play button to view the animation.

The TITLE text slides out, revealed only within the rectangular matte. Using a combination 
of position keyframes and mattes, you can create very complex animations with a 
straightforward setup. 
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Animating with the Follower
You can animate words using keyframes as you did to move the text in and out of the 
mattes, but you also have access to a special modifier designed specifically for animating 
text character-by-character. The follower is a sequential animation modifier that applies 
keyframe animation to your text with a custom delay between each character. For our 
animation, we will have each letter in the FULL NAME text rotate into view.

1 Select the NAME node and then select the Text tab in the Inspector.

To apply the Follower modifier, you use the Styled Text box in the Inspector.

2 Right-click the Styled Text box and choose Follower. 

Like the Character Level Styling you used in the previous lesson, the Follower is a 
modifier, and as with other modifiers, its controls appear in the Modifiers tab. 

3 At the top of the Inspector, click the Modifiers tab. 

To animate the follower, you keyframe the text how you want. You can keyframe 
position, rotation, size, or even color. Then, once you have designed the animation, 
you can decide how much delay to place between characters so that the animation 
ripples through your entire text string. 

TIP Many of the sections in the Follower Modifiers tab match those in the Tools 
tab. For the following steps, make sure you are making changes to the section 
in the correct tab—in this case, the Modifiers tab.
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4 In the Follower section of the Inspector, click the Transform tab.

We want the text to begin sideways and then rotate so we see each letter.

5 Move the playhead to the start of the render range.

6 Open the Rotate controls in the Inspector and click the Keyframe button next to the 
Y Rotation.

NOTE When using the Follower, you must enable keyframing on a parameter 
before you will see any changes in the viewer.

7 Drag the Y Rotation slider left to around -100.

The viewer now shows the text facing to the right. We’ll make this a quick spin that 
lasts only 10 frames.
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8 Move the playhead to frame 15 and drag the Y Rotation slider back to 0.

9 Play the animation to see the results so far.

You’ve created a 15-frame animation that the text spins onscreen. Now, using the 
Timing tab, you can delay the spin for each letter in the sentence. 

10 Click the Timing tab and drag the Delay slider to 2. 

Because you set the delay to 2 frames, the first letter begins to spin, and 2 frames 
later, the second letter begins to glow. Each subsequent letter animates 2 frames after 
the one before it. 

TIP The effects of the Follower modifier can be quite confusing when you’re 
first getting used to it. It’s usually a good idea to set keyframes first (as we’ve 
done here), and then apply a delay. If you want to set further keyframes, it’s 
often helpful to first remove the delay, set the additional keyframes, and then 
apply the delay again. In doing so, you’ll keep your sanity intact.

11 Play the animation to review it and then stop playback. 

The animation ripples through the text starting from the character on the left. 
However, at the start of the animation, you can still see the text onscreen. You can add 
additional parameter animations to the Follower, for instance, to fade each character 
on as it spins.

12 Move the playhead to the start of the render range.
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13 Click the Shading tab and then click the Keyframe button to the right of the 
Opacity slider.

14 Drag the Opacity slider to 0.

The viewer now shows the text completely faded.

15 Move the playhead to frame 15 and drag the Opacity slider back to 1.0.

16 Play the animation to see the added fade.

Almost all the controls in the Text tools tab of the Inspector can be animated using the 
Follower, including position, size, shearing, and color. By playing around for only a few 
minutes, you can see why this modifier is a fantastic tool for motion graphics.

Adjusting Keyframe Timing 
As you experienced in previous lessons, the Fusion page has an incredible Spline Editor 
for refining animation. However, it also includes a much easier way to modify the timing of 
animations. The Keyframes Editor can be used when you are not as concerned about the 
interpolation between keyframes, but about the timing between them. 

1 In the upper-right of the Fusion window, click the Keyframes button. 

To open more room for the Keyframes Editor, you can temporarily hide the Node Editor.

2 In the upper left of the Fusion window, click Nodes to hide the Node Editor.
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3 In the upper-right corner of the Keyframes Editor, click the Zoom to Fit button to fill the 
panel with the keyframe tracks.

TIP Dragging in the time ruler at the top of the Keyframes Editor will expand 
the tracks horizontally so you can zoom in to a specific area. 

The Keyframes Editor shows tracks much like a multilayered timeline on the edit page. 
However, the track stacking order in the Keyframes Editor has no bearing on the 
arrangement of images in the viewer. The tracks only adjust the timing of elements 
and keyframes. 

The nodes in the Node Editor are listed to the left in the header, and you can choose to 
view all nodes or only nodes with keyframes applied. 

4 From the Sort menu in the upper-right corner of the Keyframes Editor, choose 
Animated from the bottom of the menu to show only tracks with keyframes applied.

Thin vertical lines represent the keyframes on each node, but you can expand each 
track to show individual tracks for each parameter with keyframes.

5 In the header area to the left of the Keyframes Editor, click the disclosure arrows next 
to the NAME track to display the individual keyframe tracks for the Follower.
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TIP Selecting a tool’s name in the header also displays its controls in the 
Inspector and selects its node in the Node Editor.

Let’s have the FULL NAME animation last five frames longer. To do this, you’ll move the 
last two keyframes on the two tracks a few frames later in the timeline. 

6 Drag the red playhead to frame 20.

7 In the NAME track, drag a selection rectangle around the two ending keyframes on 
each track.

TIP When a keyframe is selected in the Keyframes Editor’s timeline, you 
can press Command-Delete (macOS) or Ctrl-Backspace (Windows) to delete 
the keyframe.

These keyframes represent the last keyframes for the Follower’s Rotation and Opacity 
animation. Dragging a selection rectangle around the keyframes selects them, as 
indicated by the yellow selection color.

8 With the keyframes selected, drag them to line up with the red playhead.

As you drag, a tooltip in the lower-left corner of the window displays the current 
frame number.
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TIP You can click in a gray area of the timeline to move the playhead by holding 
down Command-Option (macOS) or Ctrl-Alt (Windows) and clicking where you 
want the playhead to move.

Now, you can improve the timing of the TITLE text.

9 In the header area, click the disclosure arrows next to the TITLE track.

TIP When selecting Media In nodes, you can use the Keyframes Editor’s 
timeline tracks to trim and slide the start and end points, much as you would 
trim them in the edit page timeline.

Instead of just dragging keyframes, you can enter an exact frame number or an offset 
value to move them. Let’s move the TITLE text so it begins 10 frames later.

10 Select the two keyframes on the TITLE track Center : Path : Displacement track.

11 With the keyframe selected, in the lower right of the Keyframes Editor, from the Time 
dropdown menu, choose T Offset.

Entering a value in the T Offset field will move the selected keyframes forward or 
backward by the number of frames entered.

12 In the T Offset field, type 10.0 and then press Enter to move these two keyframes 
10 frames forward.

13 Click the Play button to view the results.
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Changing Interpolation 
in the Keyframes Editor
Although the Keyframes Editor doesn’t have the flexibility of the Spline Editor, you can still 
make some interpolation changes to smooth animations.

1 In the Keyframes Editor, right-click over the last TITLE keyframe on frame 25.

2 From the contextual menu, choose Smooth.

This applies a smooth interpolation to the last keyframe to give it a softer landing. 
Although you cannot change it as you can in the Spline Editor, sometimes the default 
setting is all you need.

3 Click the Play button to view the results.

4 When done reviewing, close the Keyframes Editor and open the Node Editor.
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Trying Out Versions
When designing the look of your title, you’ll often go through a few iterations of font, color, 
and layout. Fusion can help with these iterations by using versions. Each node can have 
up to six saved states, called versions. Each version saves a snapshot of the Inspector that 
you can return to at any time during your project. It’s a great way to try out different node 
settings without losing your previous work.

1 Move to the middle of the render range where all the elements are onscreen.

2 Select the BANNER node and, in the Inspector header, click the Versions button.

The versions are numbered starting with the default selection, Version 1. Clicking 
another number selects that version. Any changes you make from that point on will 
be saved for the selected version.

3 Click the Version 2 button.

4 Change the first color stop in the gradient to a more mint-green color.

You now have two different versions. You can switch back to version 1 any time by 
clicking the Version 1 button.

5 Select the Version 1 button at the top of the Inspector to see the initial 
outline gradient.

6 Click back on the Version 2 button to return to the updated look.

TIP Versions are saved only for the current node in the project. Adding a 
second node of the same type will not include the saved versions. However, you 
can save the current configuration as the default setup for a node by right-
clicking it and choosing Settings > Save Default.



201Trying Out Versions

Any node can take advantage of versions as you work out your design or composite. 
It makes for quick design changes if you or your client decide that you/they like an earlier 
look you created. It’s just one click away.

Timeline Versions
If you intend to make a more fundamental change to the composition—such as changing 
the entire layout or adding nodes to the comp—you may want to make a timeline version. 
Timeline versions are entire compositions that are saved for each clip that enable you to 
make minor or major changes in a composition while retaining access to previous versions.

1 In the upper left of the user interface toolbar, click the Clips button.

The Clips button displays a thumbnail timeline at the bottom of the Node Editor that 
shows every edit in the currently loaded timeline.

2 Right-click the currently selected thumbnail, which is the currently selected clip, and 
choose Create New Composition.

The previous animation is now saved as Composition 1, and Composition 2 is currently 
loaded. You can change the look of each element in this comp, and it will be saved as 
Composition 2.

3 Select the Merge2 node and, in the Effects Library, choose the Tools: Effect category 
and then click the Hot Spot tool. 

The Hot Spot node can be used to create custom lens-flare effects.
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4 Press 1 to see the Hot Spot effect in the viewer. Move the playhead beyond frame 20 to 
see the completed title build.

5 In the viewer, drag the Hot Spot center directly over the center of the text.

6 In the Inspector, slightly lower the Primary Strength and Hot Spot Size so the Hot Spot 
doesn’t overwhelm the text.

The Hot Spot can be customized in several ways to create the exact shape, size, and 
color you want.

7 Increase the Aspect to 5.0 so the Hot Spot matches the horizontal shape of the banner.

8 To change the color of the primary hot spot, click the Color tab and uncheck all but the 
Blue checkbox.
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9 Click the middle of the line to add a control point and lower the point until the hot spot 
has a subtle yellow tint.

For the final touch, you’ll add some hot spot streaks so it doesn’t appear so flat.

10 Click the Radial tab and enable the Radial On checkbox.

11 Increase the Radial Repeat slider all the way to the right.

12 To lessen the length and density of the streaks, lower the upper-right control point in 
the Curve Editor about halfway.

You can switch between timeline versions at any time.

13 In the Clips timeline, right-click thumbnail number 2 and choose Composition 1 > Load.

14 Load the composition you prefer to use for the template.

Now you have two clip versions saved: one with the Hot Spot and one without. The current 
version you have loaded is the lower third, which we’ll use to make a template that we can 
reuse in the edit page.
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Saving a Template
After going through the effort of creating this lower-third design, you may want to reuse it 
with small tweaks to fit different interview subjects. Rather than opening this entire comp 
over and over, you can save it as a single template in the edit page Effects Library. The first 
part of creating this template is to use Fusion’s macro creation feature to collapse all the 
nodes into one single node that displays only the parameters you want to be able to tweak. 

1 Click in an empty area of the Node Editor and then select the NAME node.

2 Hold the Command key (macOS) or the Ctrl key (Windows) and select the TITLE node.

3 Now, press Command-A (macOS) or Ctrl-A (Windows) to select all the remaining nodes.

The order you select the nodes is the order they appear in the macro list, making it 
easier to place the most important nodes at the top of the list.

4 Right-click over any of the selected nodes and choose Macro > Create Macro.

The Macro Editor window shows every node and every parameter in the node tree. 
There is a field at the top to name the macro.
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5 In the Macro Name field at the top of the window, name the macro 2D TRAINING 
LOWER THIRD.

The list of nodes and parameters can be a bit daunting at first, but you are really only 
interested in the top two text nodes. We’ll only want the template to provide controls 
for changing the text and size.

6 In the macro list, click the disclosure arrow next to Image to hide those parameters.

7 Click the checkbox to the right of the Styled Text field, and then replace the Styled Text 
with the SUBJECT NAME.

By clicking the checkbox next to Styled Text, you have selected it to be displayed 
in the edit page Inspector. The label that will show next to this text field will be 
SUBJECT NAME.

8 In the macro list, click the disclosure arrow next to NAME to hide all those parameters.

9 Click the disclosure arrow next to TITLE, close the Image section, and then enable the 
checkbox for Styled Text.

So that this styled text is not confused with the previous settings related to the TITLE 
text, let’s rename this parameter.
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10 Change the Styled Text name to JOB TITLE.

11 Click the Close button and click Yes in the warning dialog to save the template.

A Save window appears, allowing you to choose where on your hard drive the macro 
will be saved. The default location saves it for access through the Fusion page only. To 
get it to show up in the edit page, you ‘ll need to change the location.

12 In the Save window, select the Templates folder and then select the Edit > Titles folder.

Mac path to Titles folder

If any of the folders don’t yet exist, you may need to create them.

Windows path to Titles folder. You may need to create the Edit and Titles subfolders.

This location saves the template so it will show up in the edit page Effects Library.

13 Click Save in the window, and then quit and relaunch DaVinci Resolve.
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14 Open the Fusion Lessons Part 2 project and switch to the edit page.

15 In the Effects Library, select the titles category and scroll down to locate the 2D 
TRAINING LOWER THIRD template.

16 Drag the template to the timeline and place it over the existing title.

17 Select it to view the controls in the Inspector.

Completed node tree for lesson 7.

You’ve completed this lesson on type and title animation by animating in multiple ways, 
modifying those animations, and designing a look. You started with the Text+ tool in the 
edit page and then brought it into the Fusion page to build a more complex animation 
using keyframes and the Follower, using both node versions and timeline versions to save 
different looks and animations of your composition. Finally, you saved the title animation 
as a template that can be accessed in the edit page.

Lesson Review
1 True or false? Timeline versions save only the appearance of text.

2 True or false? You apply the Follower to text by right-clicking in the Styled Text box 
where you type the text.

3 True or false? Only one word can be entered into a Text+ node.

4 True or false? Adding a keyframe to a parameter in the Inspector will cause that 
keyframe to appear in both the Keyframes Editor and the Spline Editor.

5 True or false? Clicking a version button in the Inspector for a selected node will also 
save the settings for any node connected to the selected node.
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Answers
1 False. Timeline versions save the entire composition in its current state.

2 True. You apply the Follower to text by right-clicking in the Styled Text box where you 
type the text.

3 False. A single Text+ node can include multiple lines of text.

4 True. The Keyframes Editor and the Spline Editor show all keyframes on all parameters.

5 False. Clicking a version button in the Inspector saves only the settings for the 
selected node.



Time
This lesson takes approximately 
50 minutes to complete.

Goals
Identifying a Clip’s Resolution 210

Keyframing a Motion Path 211

Auto-Orienting Objects 216

Straightening Out Alpha Channels  217

Painting a Motion Path 218

Linking Parameters 223

Making Acceleration Adjustments  226

Applying Random 
Animation Modifiers 229

Customizing Motion Blur 232

Practice Exercise 234

Lesson Review 235

Lesson 8

Animating with 
Keyframes and 
Modifiers
In this lesson, you’ll move beyond 
title animations into full motion 
graphic design. A motion graphics 
designer creates every animated logo, 
infographic, and design element in a 
commercial, TV show, or web video. 
When you take on the role of motion 
designer, you aim to convey a message 
by animating graphics. Although 
that often includes text, as we have 
explored in the previous two lessons, 
now you’ll work on more general 
animation techniques. The motion 
design you’ll create here borrows a 
lot from major Hollywood movies, 
reality TV shows, and promotional 
videos. You will create a vintage travel 
map look, complete with a plane and 
animated travel line. You’ll use different 
animation techniques, including 
a mixture of keyframes, simple 
expressions, and modifiers, as you 
sharpen your animation skills.
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Completed composite for Lesson 8.

Identifying a Clip’s Resolution
To start this Fusion composition, you’ll use the same project and timeline you used in the 
previous two lessons. This project and timeline contain a vintage map, which you can use 
as the background for your plane and painted flight path line.

NOTE The Timelines bin includes a Backups bin with timelines saved at various 
stages of the lesson and a Completed Projects bin with finished compositions. 
These bins are both available for reference and reverse-engineering the 
node trees.

1 From the edit page in the Fusion 18 Lessons Part 2 project, load the Part 2-START 
timeline and move the playhead to the vintage map clip.

This map is a simple 4K image in an HD timeline. You’ll use it as the background behind 
your animated plane. Because a project’s resolution in the edit page uses the master 
timeline settings, clips brought into a project are usually scaled automatically to fit the 
timeline’s resolution.
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2 Click the Fusion page tab or press Shift-5.

3 Select the MediaIn1 node and press 1 to load it into viewer 1.

4 Hold the Command key (macOS) or the Ctrl key (Windows), position the mouse pointer 
over viewer 2, and scroll the middle mouse wheel until you see the resolution in the 
upper-right corner of the frame.

The resolution displayed in the upper-right corner of the Fusion viewer shows a UHD 
resolution (3840 x 2160). Although your timeline resolution in the edit page was 
1920 x 1080, the Fusion page sets its composition size based on the original clip’s size. 
Therefore, you are always compositing with the highest resolution, direct from the source. 
On returning to the edit page, the Media Out node scales down the final result to fit the 
edit page timeline’s resolution.

Keyframing a Motion Path
With your project set, you’ll keyframe a plane across the map to create a motion path that 
you can then reuse for other elements in the project. To keyframe the plane’s position, 
you’ll first import the graphic and then apply a Transform node. The plane graphic you 
can use in this composition is already in the media pool.

1 In the upper-left corner of the DaVinci Resolve window, click the Media Pool button 
to open the media pool.
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2 From the Travel Map bin, drag the Biplane with the alpha.tif file into an empty area of 
the Node Editor.

3 With the MediaIn2 node selected, press 1 to display it in viewer 1, then press F2, and 
rename the node BIPLANE.

4 Select the MediaIn1 node and rename the node MAP.

For this lesson, you’ll continue using viewer 1 in a single-viewer layout to give yourself 
a good amount of design space.

5 Drag the output of the BIPLANE node to the output of the MAP node to create a Merge 
node with the biplane as the foreground.

6 Select the Merge node and press 1 to see the composite in the viewer.
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The biplane is displayed over the background map, but it is clearly too large to fit 
within the vintage map background.

7 Select the BIPLANE node and, in the toolbar, click the Transform tool.

TIP While the Merge node contains transform controls—and we could use 
those to animate the plane and adjust its size—it’s usually considered better 
form to explicitly add a Transform node. This makes the node graph more 
readable: coming back to the project several days later, you can immediately 
identify that the Transform is doing the moving of the plane. It would be far less 
easy to intuit that it’s the merge performing the movement just by looking at 
the nodes in the graph.

8 In the Inspector, adjust the plane’s size to 0.20.

The plane is now more proportional to your map. We can begin keyframing it across 
the map to simulate a flight path.

9 Drag the playhead to position it at the start of the render range.

10 Hold the Command key (macOS) or the Ctrl key (Windows), position the mouse pointer 
over viewer 1, and scroll the middle mouse wheel until you have a bit of room around 
the frame. You’ll use this space to position the plane out of the frame.
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11 Using the plane’s center control in the viewer, drag the plane offscreen left, just off the 
coast of Mexico.

12 As you would in the edit page, click the Keyframe button for the center X and Y controls 
in the Inspector.

You have now set a keyframe for the first frame of this composition. As you move the 
playhead and drag the plane to a new location on the map, a keyframe will be added 
automatically, and you will begin to create a motion path.

13 Move the playhead to frame 25, and then drag the plane in the viewer to the 
northernmost part of Canada to add a second keyframe.

As you drag the plane, a line representing the motion path is drawn in the viewer.

14 Move the playhead to frame 50 and drag the plane to the southern tip of Africa.

15 On frame 75, move the plane over China.
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16 Finally, move to frame 100 and drag the plane offscreen, somewhere near New Zealand.

TIP Each control point along the path represents a keyframe. Command-click 
(macOS) or Alt-Click (Windows) on the path in the viewer to add a control point 
that does not correspond to a keyframe. This allows you to change the spatial 
shape of the path without having to manage temporal adjustments.

With the basic flight path of the plane created, you’ll quickly smooth the path, so it is 
less linear. 

17 In the viewer toolbar, click the Select All Points button.

18 Click one of the points (all points should remain selected), and then press Shift-S or 
click the Smooth button in the viewer toolbar to smooth the plane’s path. 

The path for the plane now has smooth curves as it travels across the map.

19 Press the Play button to review the animation.

Like the character level styling and the Follower that you used in previous lessons, 
the spline shape created by keyframing includes a modifier that converts the spline 
into a path.

You can use that path modifier to drive the animation of other elements. 
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Auto-Orienting Objects
This animation would be better if the nose of the plane followed the direction of the plane’s 
path. Instead of keyframing the angle of rotation for the plane, you can connect the angle 
to the path modifier and have Fusion dynamically animate the orientation of the plane.

Then, as the plane moves along the path, the plane’s angle also changes accordingly, 
making it “turn” at each bend of the path. In the future, if you adjust the path in the viewer, 
the plane’s angle also adjusts according to the path curvature.

1 Select the Transform node in the Node Editor.

2 In the Inspector, right-click the angle parameter and choose Connect To > Path > Heading.

The Connect To menu is used to link a parameter to an existing modifier. In this case, 
the modifier is the path you created by keyframing the plane. Connecting the angle 
parameter to the path modifier auto-orients the parameter.

3 Return to the start of the render range and play the animation.

The path modifier changes the angle of the plane dynamically, based on its movement 
along the path.
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Straightening Out Alpha Channels 
To better integrate the plane with the map, let’s give the plane a more weathered, 
vintage look.

1 Select the Transform node and, in the toolbar, click the Color Correction tool.

2 In the Inspector, use the color wheel to tint the plane to better match the background 
and increase the lift to about 0.25 to give the plane a faded, sepia-tone appearance.

As you adjust the lift on the plane, the background map also brightens. You’ve been in 
this situation before. It’s the problem that occurs when you perform color correction 
on an image with a premultiplied alpha channel. Just as we did with the “Eat At Joe’s” 
graphic, you can enable the Pre-Divide/Post-Multiply checkbox in the color corrector to 
fix the issue.
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TIP If you increase the gamma instead of the lift, you’re more likely to 
see a white halo around the image instead of a brightening background. 
However, the root cause of this behavior and its solution are the same.

3 In the Inspector, click the Options tab, and then select the Pre-Divide/Post-
Multiply checkbox.

TIP Alternatively, you could deselect the checkbox and insert an Alpha 
Divide node before the color correction and an Alpha Multiply after the 
color correction.

With the airplane looking good, you can enhance this project by having a classic, red-
dotted line animate along with the plane, highlighting its flight path.

Painting a Motion Path
In Fusion, you can use paint strokes for visual effects and animated motion graphics.

No matter what the task, painting always starts with a Paint tool. Unlike using multiple 
brush and shape tools to achieve the painting style you want, Fusion includes a single 
versatile Paint tool that incorporates many brush types and paint styles. To paint the path 
across our map, you’ll add a Paint node directly after the MAP node.

1 Select the MAP node and, in the toolbar, click the Paint tool.

The Paint tool is added directly after the MAP node. At the top of the viewer is a toolbar 
for the selected Paint node. The toolbar offers several strokes and paint styles suitable 
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for motion graphics or retouching shots. The paint stroke style that is comparable to 
drawing a spline path is the Polyline Stroke brush.

2 In the viewer toolbar, click the Polyline Stroke.

Unlike other paint stroke styles with which you could paint out the path using one 
continuous brushstroke, the Polyline Stroke functions similarly to a Bézier-style 
drawing tool: you click to add control points that create a painted stroke.

For your plane path, you’ll only need to add two points to create a line of any length, 
anywhere on the screen. Once you have a polyline stroke, you can modify it to use the 
plane’s path to define the stroke shape 

3 Click over Brazil and then click again over Australia.
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Where you click doesn’t really matter; as you’ll see, we’re about to replace this initial 
stroke entirely.

You now have a polyline paint stroke that we can modify with the path modifier. 
However, the path modifier currently exists only on the Transform node where you 
created the keyframes. You’ll need to make it available to all other tools.

4 Select the Transform tool and click the Modifiers tab.

The Modifiers tab shows the Path 1 that you created when you keyframed the plane.

Modifiers are just optional extensions to a tool’s main feature set. For instance, you 
used the Transform tool to create a spline through position keyframes. Creating a 
spline using position keyframes automatically creates a path modifier. That modifier 
can then be published and made available to any object that can make use of a path. 
Therefore, the first step is to publish the path so the paint stroke can use it.
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5 At the bottom of the Modifiers tab, right-click over the label “Right-click here for shape 
animation” and choose Publish.

At the top of the Inspector, the Modifiers tab shows the path: polyline, which is now 
published and available for other tools.

6 Select the Paint node and select the Modifiers tab if it isn’t already selected.

7 At the bottom of the Inspector, expand the stroke controls section. From here, you can 
connect to the published path polyline.

8 At the bottom of the stroke controls, right-click over the label “Right-click here for 
shape animation” and choose Connect To > Path 1: Polyline > Value.

The simple polyline paint stroke you created now takes the shape of the motion path. 
Once you have a paint stroke, any changes are made in the Modifiers tab.
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9 At the top of the Modifiers tab in the Inspector, expand the brush controls (you might 
need to double-click the PolylineStroke1 section to expand it first). Change the Size to 
about 0.01 and drag the Softness slider all the way to the left.

10 In the apply controls, change the color to a vibrant red.

11 In the stroke controls, drag the spacing slider all the way to the right to create a 
dotted line.

Sliders in the Fusion page can only go so far, but that does not mean the parameter’s 
value is restricted. You can enter values larger than the limit of the slider. Doing so will 
scale the slider’s range to allow for the new larger value.

12 In the spacing numeric field, enter 1.5 and press Enter.

The dotted line in the viewer now has more spacing between dots, but more importantly, 
the slider range has grown so that you can drag to 1.5 and even a bit beyond. Almost every 
slider in the Fusion page includes this extended-range capability. 
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Linking Parameters
To add more visual interest, you’ll animate the dotted line so that it follows the plane. The 
hard way to do this is just to keyframe the line, but if you change the plane’s speed, you’ll 
then need to go back and adjust the paint stroke’s animation as well. Fusion allows you to 
link the animation of one parameter to any other parameter, even if the parameters are 
completely different.

1 In the Modifiers tab, drag the Write On End slider back and forth to see the results in 
the viewer.

The Write On control has Start and End values that you can change by dragging the 
sliders. Dragging the End slider changes the end of the paint stroke, creating a paint-
on effect. You can animate this control by connecting it to the path’s displacement 
property so that it writes on at the same rate as the plane’s position along the path.

2 Right-click the Write On’s End handle and choose Connect To > Path1 > Displacement.

3 Drag the playhead through the render range to watch the path write on, following 
the plane.

The Connect To menu command provides a very easy way to connect two parameters, 
but it doesn’t allow much flexibility. For instance, what if we wanted the paint stroke 
to lead the plane by just a few frames instead of following the exact same position as 
the plane? The Connect To menu has no way to do that, but you can link parameters in 
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other ways. These alternatives may require a bit more work but give you much greater 
flexibility. First, you’ll remove the connected displacement from the End handle of 
the write on.

4 Right-click the Write On’s End handle and choose Remove Path1 Displacement.

Now, the displacement parameter you want to link to is located on the Modifiers tab of 
the Transform node, since this is where the path was generated.

5 In the Node Editor, select the Transform node and click the Modifiers tab. If Path1 isn’t 
already expanded, double-click it to expand it.

The Transform’s path modifier includes the displacement and heading parameters that 
we connected to earlier.

6 Drag the playhead back and forth to see how the displacement parameter animates 
based on the time in the composition.

As you drag through the render range, the displacement parameter is animated to 
move the plane along the path. This is the control to which you want the End slider of 
the paint Write On to link.

7 With the Transform node selected, from the upper-right corner of the Path1 
Inspector’s section, click the Pin button to prevent Path1 from closing when you select 
another node.
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By pinning the Path1 Inspector, you can select another node and see the two nodes’ 
controls at the same time. This setup makes it possible to link the two parameters from 
different nodes.

8 In the Node Editor, select the Paint node and then select the Modifiers tab in the 
Inspector.

9 In the Write On End field (under Stroke Controls) type = (equals sign) and press 
Return or Enter.

Typing an equals sign in any numeric field opens a simple expression field. This 
expression field gives you the option of linking two parameters by typing the name of 
the parameter you want to link or by linking the two parameters using a pick whip.

TIP A pick whip is a graphic line that you draw between two parameters as a 
shortcut method of creating an expression.

10 In the Inspector, drag from the plus icon on the left of the expression field up to the 
Displacement label in the Path1 controls.

11 Play the composition to see the linked animated paint stroke.

These animated elements look good so far, but as we said, this method offers some 
flexibility over the Connect To menu. You can customize the speed or position of the 
dotted path by modifying the expression that you added with the pick whip.
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12 In the expression field, insert +.1 at the end of the expression. By adding +.1 to the 
expression, you are offsetting the displacement by 10%, moving it ahead of the 
plane’s displacement.

13 Play the composition to see the offset paint stroke.

Since you won’t be linking any more parameters right now, you can unpin the Path1 
from the Inspector.

14 In the Node Editor, select the Transform node.

15 In the upper-right corner of the Inspector, click the Pin button to release the Path1 
controls in the Inspector. The Path1 controls will close when you select another node.

This simple pick whip example animates one parameter based on the value of another.

If you modify the speed or acceleration of the plane, the paint stroke inherits the 
same adjustment.

Making Acceleration Adjustments 
Unless you’re trying to create a very robotic animation, you’ll seldom use linear motion 
as we have here. Controlling how quickly and smoothly elements move from one state to 
another is a crucial step in motion graphics. By default, the Fusion page applies a linear 
interpolation between keyframes, so animations move at a constant rate. However, we can 
return to the Spline Editor and have the plane slowly accelerate as the path dips into 
southern Africa and then slow it down again when it reaches the top of the path on 
the right.

As we make the change, the linked paint stroke follows along, inheriting the same 
acceleration changes.

1 In the upper right of the Fusion window, click the Spline button to open the 
Spline Editor. The Spline Editor header on the left side of the panel shows all the 
animated parameters.

2 Select the checkbox next to the Displacement parameter.
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3 In the upper-right corner of the Spline Editor, click the Zoom to Fit button to fill the 
graph area with the selected displacement spline.

Changing the acceleration of the plane along the path consists of smoothing the spline 
between keyframes and then adjusting the spline handles to increase or decrease the 
rate of acceleration.

4 Drag a selection rectangle around all the keyframes in the Spline Editor.

5 In the lower-left corner of the Spline Editor, click the Smooth button or press Shift-S to 
smooth all the keyframes.



228 Lesson 8 Animating with Keyframes and Modifiers

6 Right-click one of the keyframes and choose Flat.

This will slow the animation just before and just after the keyframe.

7 Play the animation to see the results.

You produced a more realistic animation just by smoothing the interpolation and flattening 
the rate of change on specific keyframes.
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Applying Random 
Animation Modifiers
Modifiers can do so many amazing things for your animations, from converting splines 
to paths, creating rippling animations for text, and even animating any parameter using 
randomly generated values. Random animation can come in very handy when trying to 
create a wiggling position animation or flickering lights using brightness controls.

To complement this vintage animation, you’ll use one of DaVinci Resolve’s built-in filters to 
create a flickering old-style film look.

1 Close the Spline Editor and select the Merge1 node in the Node Editor.

You’ll add a filter effect to the entire composition by placing it directly after the 
Merge1 node.

2 In the upper left of the interface, click the Effects Library and, from the OpenFX 
category, open the Resolve FX Texture subcategory of filters.
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3 Click the Film Damage tool to add it to the Node Editor and then press 1 to see the 
results in the viewer.

4 Play the composition to review the newly added filter.

The Film Damage filter adds some film scratch lines, a slight vignette, and a sepia 
tint to the composition. With all the parameters in the Inspector, you have a great 
deal of control for customizing the effect. One addition that would make it more 
realistic would be a bit of flickering light simulating an old film projector bulb on its 
last bit of energy. Instead of animating this effect, we can use the Perturb modifier to 
automatically generate random animation.

5 In the Inspector, right-click over the Focal Factor label.

The Focal Factor parameter adjusts the strength of the vignette. If you apply a random 
animation to this slider, it will give the appearance of a weakening light bulb.
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6 Choose Modify With > Perturb from the contextual menu.

7 Play the composition and let the animation cache to RAM to review the flickering 
animation.

The effect is less of a flickering projector bulb and more of a slow pulse. Like many 
modifiers, you can control several properties to get the look you want.

8 Click the Modifiers tab at the top of the Inspector.

At the top of the Modifier tab is the Value setting. The Perturb Value setting uses the 
current focal factor setting as a starting point. Dragging the Value slider is similar to 
dragging the Focal Factor slider.
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Other controls—such as strength, wobble, and speed—control how far the focal factor 
parameter varies from the initial value setting, how erratic the motion is, and the 
speed of the motion. Keeping the Strength setting at a lower value keeps the flickering 
from getting too dark or too bright. Keeping the Wobble and Speed higher creates a 
faster, more chaotic energy to the animation.

9 Lower the Strength to 0.5 to make the change in brightness less drastic.

10 Increase both Wobble and Speed to 10 and play back the animation.

The Perturb modifier is extremely flexible; you can add it to polylines, grid meshes, and 
even color gradients to wiggle or randomize almost any parameter you want to animate.

Customizing Motion Blur
As we did with the text in the previous lesson, the last refinement you’ll make to this 
animation is to increase the photorealism with some motion blur.

1 Move the playhead in the middle of the timeline where the plane is onscreen.

2 Unlike the previous lesson where the Text+ node created the motion, here the 
Transform1 node is creating the motion. So, start by selecting the Transform1 node 
connected to the biplane.
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3 In the Inspector, select Tools, then click the Settings tab, and select the Motion 
Blur checkbox.

The quality and shutter angle of the motion blur are the two most commonly used 
controls for improving the look and spread of the blur; however, increasing these two 
controls also increases rendering time.

4 Increase the Quality to 6 and the Shutter Angle to 200.
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The Quality parameter increases the number of times the image is replicated to create 
blur. The Shutter Angle simulates the shutter angle in a camera. Higher numbers 
create a smoother “smear” between samples. Setting this parameter to 360 is similar 
to having a shutter in a camera open for an exposure of one whole frame.

TIP Right-clicking to the right or left of the transport controls allows you to 
disable motion blur for the entire composition.

Now, you can return to the edit page and use DaVinci Resolve’s smart cache to render 
and view your animation.

5 Click the edit page, and then choose Playback >Render Cache > Smart. Once the cache 
is complete, play back the animation.

You have completed your vintage biplane animation and are ready to show your clients 
your design.

Completed node tree for Lesson 4.

Practice Exercise
Located in the Travel Map bin in the media pool, you’ll find Dr Jones with alpha.tif. Try 
to add this silhouette to your plane comp and have it follow an inverse path of the plane’s 
path (when the plane is at the top of the map, Dr Jones is at the bottom, and so on).

1 In the media pool Travel bin, drag the Dr Jones tiff to your comp in the Fusion page and 
resize him to appropriate proportions.

2 Use a Transform node to keyframe Dr Jones so he follows the same path as the biplane 
but inverted.
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3 Create a blue painted path that follows Dr Jones. 

Here’s a final image of how your composite might look.

Lesson Review
1 True or false? You cannot connect the output of a Media In node directly to the input of 

a Paint node.

2 True or false? To attach a paint stroke to a path, you must publish the path.

3 True or false? When using an image with a premultiplied alpha channel, you must 
divide the alpha prior to color correcting it. Then it must be multiplied again before 
being connected to a Merge node.

4 True or false? To auto-orient an object along a motion path, you right-click over the 
Center X and Y parameter and choose Connect To > Path > Heading.

5 True or false? The Displacement parameter controls an object’s position along a 
motion path.



236 Lesson 8 Animating with Keyframes and Modifiers

Answers
1 False. You can connect the output of a Media In node directly to the input of a 

Paint node.

2 True. To attach a paint stroke to a path, you must publish the path.

3 True. When using an image with a premultiplied alpha channel, you must divide 
the alpha prior to color correcting it. Then it must be multiplied again before being 
connected to a Merge node.

4 False. To auto-orient an object along a motion path, you right-click over the Angle 
parameter and choose Connect To > Path > Heading.

5 True. The Displacement parameter controls an object’s position along a motion path.



Part lll

3D Compositing
Something that truly sets Fusion apart is its 3D system. In addition to its 
compositing toolset, Fusion includes a robust 3D authoring environment, complete 
with lighting effects, 3D camera matchmoving, materials and shaders, 3D titles, 
particles, and the ability to import complex geometry and animation using the 
industry-standard FBX and Alembic file formats. In this section, you’ll learn how to 
navigate, perform basic scene setup, work with particles and 3D titles, and even 
perform a digital set extension using the powerful 3D Camera Tracker.
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Lesson 9

Setting Up 
a 3D Scene

Many visual effects are about 
reproducing the characteristics of 
the real world, such as perspective, 
atmosphere, depth cues, and occlusion 
of objects in a scene. And while you 
could create these effects using 2D 
compositing, they become much easier 
to do in a 3D compositing environment.

Fusion’s 3D compositing includes the 
ability to position multiple elements in 
3D space. You can add cameras, lights, 
3D shapes, and apply a host of tools 
specifically designed for generating 
3D visual effects and motion graphics.
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This lesson and the following one combine to introduce you to the basic construction of a 
3D scene by creating a broadcast news graphic. You’ll learn how to navigate in 3D space 
and use some of the everyday tools for 3D compositing and motion graphics.

Completed composite for Lesson 9.

Placing Elements on 3D Shapes
Instead of creating a Fusion composition from the timeline, you can create a Fusion 
composition in a bin. This is often appropriate when creating motion graphics where you may 
not be ready to edit it into a timeline, but you need to begin creating the graphics for a project.

NOTE The Timelines bin includes a Backups bin with Fusion comps saved at 
various stages of the lesson, available for reference and reverse-engineering 
the node trees.

1 Open DaVinci Resolve. In the Project Manager, right-click and choose Restore 
Project Archive.

2 Open R17 Fusion Guide Lessons folder > Fusion 17 Lessons Part 3 dra.

This project includes all the content required for the remaining lessons in this book.

3 Once the archive opens in the edit page, right-click in the Media > 3D Globe bin and 
choose New Fusion Composition.
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4 In the dialog, name the clip BREAKING NEWS and click Create.

Similar to the Fusion composition generator you used in earlier lessons, this Fusion 
composition can be opened in the Fusion page without any media associated with it 
and without creating a timeline.

5 Right-click over the BREAKING NEWS clip in the bin and choose Open in Fusion Page. 
For this project, you will use elements from the media pool to create a 3D scene.

NOTE It’s much easier to work with 3D objects if you have two viewers, so if 
your user interface is configured with a single viewer, correct that now.

6 In the upper-left corner of the Fusion page, click the Media Pool button and select the 
3D Globe bin.

This bin contains a few still images that you will use to create a stylized globe and a 
moon for our broadcast news graphic.

7 From the 3D Globe bin, drag Earth.tif into an empty area of the Node Editor and press 
1 to display it in viewer 1. Close the media pool to give yourself room to work.

This is a stylized map of the Earth that has an alpha channel, as you can tell from its 
checkerboard background. Again, let’s get organized right from the start by renaming 
each new element.

8 In the Node Editor, select the MediaIn1 node, press F2, and rename this image EARTH.

Any video clip, still image, or 2D generator cannot be part of a 3D scene without first 
connecting to an Image Plane 3D node or a Shape 3D node.
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9 With the Earth node selected, open the Effects Library, and from the Tools > 3D 
category, click the Shape 3D tool. Then press 1 to view the Earth image in 3D space.

The Earth image now appears in a 3D viewer. It is placed on a 3D image plane and can 
be rotated and viewed from any angle.

10 While holding down the middle mouse button, Option-drag (macOS) or Alt-drag 
(Windows) left, right, up, and down in viewer 1.

By using the modifier key and middle mouse combination when dragging, you can 
rotate around the image to see it from alternate angles. To be clear, you are not 
rotating the image itself; you are changing your view, as if you were walking around 
the image. You can also change the view to see it from the top or bottom.

TIP For flat 3D objects, you can use an Image Plane 3D instead of a Shape 3D 
node. The Image Plane 3D retains the aspect ratio of the image or video clip 
connected to it.

11 Open the media pool, and from the 3D Globe bin, drag grid.tif into an empty area of 
the Node Editor. Press 2 to display it in viewer 2. Press F2, rename this image GRID, 
and then close the media pool again.
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12 With the Grid node selected, open the Effects Library, and from the Tools > 3D 
category, click the Shape 3D tool. Press 2 to view the grid in 3D space.

The grid is also displayed in a 3D viewer, but the two images are not connected and 
cannot interact. Each exists in its own 3D world.

However, you can combine 3D images to exist in the same 3D world using a Merge 3D 
node located in the last group of tools in the toolbar.

While the Merge node is the fundamental 2D compositing tool, the Merge 3D node is 
the fundamental 3D compositing tool.
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13 Drag the output of GRIDS’s Shape 3D node to the output of EARTH’s Shape 3D node to 
create a Merge 3D. Press 2 to load Merge3D1 into viewer 2.

Although you might see no visual difference compared to the Grid view, the Merge 3D 
node allows you to connect other 3D images, so they will exist in the same 3D space. 
Currently both images overlap in exactly the same space, hence the reason why little 
seems to have changed.

The viewer shows the images on top of each other. To give the appearance of a more 
realistic 3D view, you can enable default lights.
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14 Right-click in viewer 2 and choose 3D Options > Lighting.

TIP One of the most common issues that newcomers experience when 
working with Fusion is an inability to see the effect of lighting in the 3D scene. 
First, an OpenGL preview of the lighting must be enabled for each viewer 
in order to preview the lighting effects in the 3D environment (using the 
right-click method described in the previous step). Second, lighting must be 
enabled in the Renderer3D node (more on this in the next lesson). Finally, in a 
Merge 3D, Pass Through Lights must be enabled to appropriately illuminate 
all desired objects (more on this later in this lesson).

15 Preview the light by holding the Option key (macOS) or the Alt key (Windows) and using 
the middle mouse button to drag around in viewer 2.

The default lighting provides a soft directional light that comes from the upper right 
of the 3D world. The light object is not visible in the viewer or the Inspector; it merely 
provides some default shading to the objects so they appear more three-dimensional 
while you work.
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Navigating in 3D
Unlike the standard Merge 2D node, the Merge 3D node can connect multiple clips and 
images. The Merge 3D node has no foreground or background because the order of 
elements as seen in the viewer is determined by their Z-position values. This behavior 
makes it extremely important that you understand how to view and move elements 
in 3D space.

1 In the Node Editor, select the Shape3D2 node. This is the grid’s Shape 3D node.

2 In the Inspector, click the Transform tab.

In Fusion’s 3D world, the origin point of the coordinate system is in the center of the 
world (X = 0, Y = 0, and Z =0). Each element you add to the 3D world will start at this 
0,0,0 location. X is the “horizontal” axis, Z is the “depth” axis, and Y is the “vertical” axis.

TIP In many other applications (e.g., 3D slicing software, 3D Studio Max, Unreal 
Engine) the Z axis is the vertical axis, and the Y axis is the depth axis. Therefore, 
be careful if you’re simply copying and pasting values between applications.

To move an image in 3D space, you use the Shape 3D node (or the Image Plane 3D 
node), which adds 3D positioning, rotation, and pivot controls to an image.
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3 In the Inspector, drag the X Translation to move the grid slightly to the right.

The X Translation moves the grid to the left or right. You can perform the same 
transform operation using the red arrow in the viewer. Other viewer arrow overlays 
move the object up and down (the green, Y translate arrow) or toward and away from 
you (the blue, Z translate arrow).

4 In the Inspector, drag the Z Translation slightly to the right until the grid is in front of 
the Earth.

Unlike 2D compositing with a Merge node, you do not change the inputs to the Merge 
3D node to get the grid in front of or behind the Earth image. That ordering is done by 
altering the Z Translation value and the angle at which you view the composite.

5 In viewer 2, Option (macOS) or Alt (Windows) drag right while holding down the middle 
mouse button until the Earth rotates in front of the grid.
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You have changed your viewing perspective; so, even though the Z Translation sets 
the grid in front of the Earth, your Perspective view of the scene determines the 
layer order.

The following key and mouse button combinations are extremely useful when working 
in a 3D viewer:

 — Pan: Drag while holding down the middle mouse button.

 — Rotate: While holding down the middle mouse button, Option-drag (macOS) or 
Alt-drag (Windows).

 — Zoom in and out: Hold down Command (macOS) or Ctrl (Windows) and scroll the 
middle mouse wheel.

Now, let’s get back to a default starting point and begin to build the planets.

6 In the Inspector, click the gray dot under the X and Z Translation controls to reset 
them to 0.0.

7 In viewer 2, Option (macOS) or Alt (Windows) drag left using the middle mouse button 
until the Earth and grid are facing front.

Dragging in the viewer while set to Perspective view only changes the angle from 
which you are viewing the objects, not the objects themselves. It is similar to moving a 
camera around your subjects.

TIP You can use the Perspective view axis control in the lower-left corner to 
orient yourself and the viewer. When you move the Perspective view so that 
the green arrow points up, the red arrow points right, and the blue arrow 
points directly toward you, the Perspective view is at a default front view in 
the 3D world.

Intuitively moving the Perspective viewer to different angles and moving objects in 3D 
space are essential activities in 3D compositing. In upcoming lessons, you’ll get more 
practice with these techniques.
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Using Shapes in 3D
The Shapes 3D node is a flexible node that enables you to wrap video or images around 
basic 3D shapes. For this 3D planet scene, you’ll apply the grid and the Earth images to 
spherical shapes and practice moving them in 3D space.

1 Select the grid’s Shape3D2 node and, in the Inspector, click the Controls tab.

The Controls tab allows you to select different primitive 3D shapes to wrap the 
image around.

2 From the Shape menu, choose Sphere.

The grid changes from a flat plane to a sphere. This sphere is very large, so it 
encompasses the entire image of the Earth and obstructs it from view.
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3 Drag the radius slider to around 0.2.

The grid is now small enough to reveal the Earth image.

4 In the Node Editor, select the Earth’s Shape3D1 node and, in the Inspector’s Controls 
tab, in the Shape menu, choose Sphere.

The Earth is mapped onto a sphere shape that surrounds the smaller grid. The alpha 
channel contained in the Earth image creates some transparent areas where the grid 
can be seen.

5 In viewer 2, hold down the Command (macOS) or Ctrl (Windows) key and scroll the 
middle mouse button to zoom out the viewer a bit until you can clearly see the top and 
bottom of the Earth sphere.
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6 While holding down the middle mouse button, Option-drag (macOS) or Alt-drag 
(Windows) right and left in viewer 2 to rotate your view around the Earth and grid. 
Then, return to the original Perspective view position.

Fusion provides a true 3D environment with 3D shapes, rotation, and object depth. 
At the moment, the grid is located inside the Earth sphere because both objects 
occupy the center location of the 3D world at the X, Y, and Z Translation coordinates 
of 0,0,0. Let’s move the grid into a more practical moon-like position.

7 In the Node Editor, select the grid’s Shape3D2 node.

8 Using the arrow overlays in the viewer, drag the red X translate arrow to the right until 
the grid reaches the edge of the viewer.

You now have a modern, high-tech Earth with its grid moon in perfect position to begin 
animating them.

Entering Simple Expressions
To suggest reality, the planets need to rotate. The Earth needs to rotate around its own 
axis, while the grid needs to rotate around its own axis while also orbiting around the 
Earth. Let’s start with the Earth rotation, but instead of using keyframes to create the 
rotation, we’ll use a simple expression.

1 Select the Earth’s Shape3D1 node, and in the Inspector, click the Transform tab.

Expressions can be simple conditional statements, mathematical equations, or links 
to other parameters that generate animation. The pick whip you used in Lesson 8 to 
animate the dotted line is a shortcut to writing a simple expression. When you used the 
pick whip, you exposed an expression field that was populated by the parameter name 
you chose. For this exercise, you’ll enter a simple expression directly in the expression 
field to create a rotation animation. The expression will simply create a link based on 
the current frame in the project to the degree of Y rotation applied to the Earth.
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2 In the Y Rotation number field, type = (equals sign), and then press Return or Enter to 
open the expression field.

In the expression field, you can enter a simple expression to control the Y rotation.

3 Click in the expression field, type time*10, and press Return or Enter.

TIP The time expression is always written in lowercase type.

Although this procedure may seem cryptic at first, it is easy to understand. The word 
“time” is a special reserved placeholder expression that Fusion will replace with the 
value of the current frame number (the frame the playhead is currently parked at). So, 
at frame 12, Fusion will replace “time” in the expression with the value 12. At frame 34, 
it will replace it with 34, and so on.

The asterisk (*) is the computer programming symbol for multiply. So, in effect what 
this little expression is saying is, “Take the current frame number and multiply its value 
by 10.” So, at frame 12, Y Rotation will be 12 x 10, which equals 120 degrees of rotation. 
At frame 34, Y Rotation will be 34 x 10, which is 340 degrees of rotation, and so on.
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TIP A list of additional expression examples can be found in the 
DaVinci Resolve Reference Manual.

4 Play the animation and see that the Earth is rotating on its Y axis. Park the playhead on 
different frames and confirm that the expression provides the values we expect it to.

This movement is a bit fast, so you can easily change the expression and try new 
speeds just by changing one number.

5 Click in the expression field and change the number from 10 to 1. You can do so even 
as the animation is playing, making it very easy to try several different values.

Now, you can animate the grid. The easiest way to do so is to link the rotation of the 
grid to the rotation of the Earth, as you did back in Lesson 8 with the plane and the 
dotted line.

6 In the upper-right corner of the Inspector, click the Pin button to prevent the Earth’s 
Shape Inspector from closing when you select another node.

By pinning the Earth’s Shape Inspector, you can select another node and see the two 
nodes’ controls at the same time.

7 In the Node Editor, select the grid’s Shape3D2 node.

The grid’s Shape3D2 controls appear at the top of the Inspector, while the Earth’s 
Shape3D1 controls remain open in the Inspector below.
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8 In the grid’s Shape3D2 controls, click the Transform tab. In the number field to the 
right of the Y rotation slider, enter an = (equals sign) and press Enter to open an 
expression field under the rotation control.

Instead of entering an expression, you’ll use a pick whip to link the two parameters  
together.

9 At the top of the Inspector, in the grid’s Shape3D2 controls, drag from the plus icon on 
the left of the expression field to the Y Rotation label in the Earth’s Shape3D1 controls.
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TIP If you have limited screen real-estate, you can click the disclosure triangles 
to collapse the various Inspector sections, thus making a shorter distance to 
drag your pick whip.

10 Play the composition to see the linked animated shapes.

Although that worked, the grid is rotating slowly. We would like it to rotate a bit faster 
than the Earth’s rotation to make it more visible. It is easy to do so by modifying the 
expression that you added with the pick whip.

11 In the expression field, insert *2 to the end of the expression. Again, the * symbol 
represents multiplication. By multiplying the expression by 2, you’re increasing the 
grid’s rotation to be two times faster than the Earth’s rotation.

12 Play the comp to see the shapes rotating.

These rotating elements look good so far. Since you won’t be linking any more 
parameters right now, you can unpin the Earth’s Shape 3D from the Inspector.

13 In the Node Editor, select the Earth’s Shape3D1 node.

14 In the upper-right corner of the Inspector, click the Pin button to release the Earth’s 
Shape Inspector. The Earth’s controls will close when you select another node.

Animation via expressions allows you to animate without keyframes. So, no matter how 
you change your composition, the rotation never stops; it just recalculates and continues 
along its course, counting upward and rotating.
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Creating Multiple Axes of Rotation 
The grid also requires an orbital center as well as the axis of rotation. The orbital center will 
be used to rotate the grid around the Earth.

To create a second point of rotation to orbit the grid around the Earth, you’ll need to add 
a new pivot point for the grid. The 3D equivalent of the Transform tool that you used when 
2D compositing is the Transform 3D. It includes a complete set of 3D transforms, including 
rotation and pivot.

1 Select the Grid’s Shape3D2 node and, from the Effects Library, go to the Tools > 3D 
category and click the Transform 3D tool.

Inserting a Transform 3D node adds a second pivot point to the grid. The grid has its 
own pivot point based on the Shape 3D node that acts as the grid’s axis of rotation. 
The Transform 3D node adds an additional pivot in the center of the 3D world that will 
act as the grid’s orbital center.

Transform pivot point 
(Centered in the 3D world)
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2 With the Transform 3D selected, drag the Y Rotation slider back and forth to see the 
results of the added pivot point. Then reset the Y Rotation to 0.

Connecting the two transforms to an object creates a hierarchy, so that one transform 
can control or influence the other. A transform that controls others is called a parent, 
while a transform that is controlled by another is called a child. In this comp, the parent 
is the Transform 3D node, while the child is the Shape 3D node. Moving or rotating 
the Transform 3D node will move or rotate the grid, but moving or rotating the Shape 
3D node will not impact the Transform 3D node.

TIP When you’re rotating only one object on a single axis, you can use the 
pivot controls to offset the object’s axis of rotation.

Parent

Child

Child

3 Select the Grid’s Transform 3D node and, in the Transform tab, double-click the Y 
Rotation field and press = (equals sign), and then press Return or Enter.

4 In the expression field, enter time*1.5 and then press Play to see the orbital rotation.
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Based on the location of the Transform 3D’s pivot, the grid swings around behind the 
Earth but also still rotates around its own pivot.

You can change the starting point of the orbit just by adding or subtracting the 
degrees to modify the position. For instance, if we subtract 90 degrees from the 
starting point of the orbit, it should start with the grid in front of the Earth.

5 At the end of the expression field, enter time -90 and then press Return or Enter.

6 Play the comp to see the spheres rotating.

As you review this animation, look over the node tree and think about what each node 
is actually controlling. Where are the textures coming from, and what is driving the 
animation? Think about having to extend this beyond two planets and adding a third. 
Examining a node tree is one of the benefits of the node tree interface: you can see exactly 
how each object is processed.

Adding Lights and Cameras
3D scenes in the Fusion page can include cameras and lights. You use the cameras and 
lights much like you would in the real world to frame and illuminate objects how you see fit.

The Perspective view and the default lighting you’ve been using in the viewers are 
automatically present whenever you create a 3D composite. However, they are primarily 
there so you can see objects and view them from different angles and are not intended to 
be used in your final rendering. Although you do not need to add more lights or a camera 
to a 3D scene, doing so adds significant creative control over the final appearance.
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1 From the toolbar, drag a new Merge 3D node to an empty area of the Node Editor.

Although you can connect everything into a single Merge 3D, things can get a bit 
tangled and unwieldy if you choose that path. Even on simple composites, as we have 
here, it’s wise to keep things organized by using multiple Merge 3D nodes to group 
items together. We’ll use a new Merge 3D to connect our lights. Similar to standard 2D 
Merge tools, you can connect Merge 3D nodes together, creating a more organized 
and flexible, yet still singular 3D world.

2 Select the Merge3D2 node and, in the Effects Library, from the Tools > 3D category, 
select the Light subcategory.

3 In the Light subcategory, click the Directional Light tool to add it to the Node Editor, 
connected to the Merge3D2 node.

The Directional Light is added to the scene and connected to the Merge3D2 node.

Now, you’ll connect the Merge3D2 node and the Merge3D1 node.
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4 Drag the output of the Merge3D2 node to the Merge3D1 node to connect it.

When a light is added to a scene (directly to a Merge 3D or indirectly through a 
connecting Merge 3D), the default lights in the scene are disabled, and only the lights 
connected to the node tree illuminate the objects in the scene. However, we do not see 
any lights illuminating our scene because, by default, lights are not passed from one 
Merge 3D to another. This default setting allows you to combine 3D objects into one 
scene but light them independently.

TIP Holding the Option key (macOS) or the Alt key (Windows) and clicking on a 
connection line will add a router that allows connection lines to bend instead of 
having diagonal lines overlap other nodes.

5 Select the Merge3D2 node and, in the Inspector, click the Pass Through 
Lights checkbox.

Now any lights you connect to Merge3D2 will illuminate all the objects in Merge3D1.
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6 Select the Directional Light node and, in the Transform tab of the Inspector, use the Y 
and Z Rotation controls to set the light as if it were coming from the upper-right corner 
of the frame.

The directional light made the scene too dark in areas located opposite to the light’s 
direction. You can add an ambient light to fill in those dark areas.

7 Select the Merge3D2 node again and, in the Effects Library, click the Ambient Light tool.

8 Select the Ambient Light node and lower the light’s intensity to around .300.

Your entire 3D scene is now lit using only two lights. With that in place, you can start to 
work on framing your composite by introducing a camera.
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Why Are There Different Light Types?
The Fusion page includes four lights that you can add to a scene, each with its own 
characteristics:

Ambient light illuminates an entire scene equally—similar to adding a gain 
brightness—because it has no position or rotation. It is used primarily to fill in 
areas that other lights may leave too dark.

Directional light has a clear direction but lacks a specific source location. You do 
not control its position, but you can use rotation controls to indicate from where in 
the scene the light appears to be coming. This light is akin to sunlight, because no 
matter how far away an object may be, there is no light fall-off.

Point light has a clear position in space that emits light in all directions; therefore, 
only its position affects the light, not its rotation. A light bulb is a good example of 
a point light. Unlike both ambient and directional lights, a point light may fall off 
with distance.

Spot light comes from a specific point and has a clearly defined cone with fall-off 
to the edges of that cone. This is the only light capable of casting shadows.

Setting Up and Animating a Camera
Even without a camera, you can set up the Perspective view to see your scene from 
different angles. This can often stimulate ideas on how ultimately you may want the scene 
framed. To show as much of the arc animation from the moon as possible, let’s position the 
Earth slightly to the left using just the standard Perspective view.

1 Move the playhead to the start of the timeline. In viewer 2, hold down the middle 
mouse button and drag to position the frame so the Earth is against the left edge.
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You can now add a camera and connect it to the Merge3D1 with the moon and 
Earth objects.

2 Select the Merge3D1 in the Node Editor.

3 With the Merge3D1 node selected, click the Camera tool in the toolbar to add it to 
the Merge3D1 node.

You can set the viewer to display the camera output, using the Perspective axis label in 
the lower-left corner of the viewer.

4 In the lower-left corner of viewer 2, right-click the Perspective axis label, and choose 
Camera3D1.

Now you’re able to see the output of the camera in viewer 2, which is similar to looking 
through the camera’s viewfinder.

Since we never framed the camera, it is located at the center of the 3D scene inside the 
Earth sphere, which is not where we want our camera.

Rather than tweaking a lot of parameters to essentially match what we have in the 
Perspective viewer, you can copy the Perspective view to the camera.

5 In the lower-left corner of viewer 2, right-click the Perspective axis label and choose 
Perspective from the menu to return to the default Perspective view.

6 Right-click the Perspective axis label again and choose Copy PoV to > Camera3D1, and 
then switch back to the Camera3D1 view.

Copying the viewer’s perspective point of view (POV) to the camera repositions the 
camera so it matches the perspective framing.
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This is where having two viewers comes in handy. It will be easier to animate the 
camera if viewer 1 shows us the Perspective view where we can manipulate the 
camera’s position, while viewer 2 shows the camera output.

7 In the Node Editor, select the Merge3D1 node and press 1 to display it in the viewer.

8 In viewer 1, right-click the Perspective axis label again and choose Perspective.

For our animation, we’ll create a simple pull back on the camera to expose more space 
on the right. We’ll use this space in the next lesson when we add 3D text.

9 If you haven’t already, move to the start of the render range.

10 Select the Camera3D1 node and, in the Inspector, click the Transform tab.

11 In the Transform tab, click the Keyframe button to the right of the Z Translation 
parameter.

This sets our starting keyframe. Now, we’ll set an ending keyframe and move the 
camera back a bit.

12 Move to the end of the render range.

You can use the Inspector to move the camera or change the camera’s position 
directly in the viewers.

13 Position the mouse cursor over viewer 1, hold the Command key (macOS) or the Ctrl 
key (Windows) and scroll the middle mouse wheel until you can clearly see the Earth 
and the camera in the frame.
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The camera, like all objects in a 3D scene, includes three arrows as translation controls in 
the viewer. The green arrow moves the camera up and down on the Y axis, the red arrow 
moves it side to side on the X axis, and the blue arrow moves the camera in and out on the 
Z axis. Since we want to move the camera back a bit, we’ll drag the blue arrow in viewer 1.

14 In viewer 1, drag the camera’s Z Translation blue arrow back, away from the spheres, 
until the Inspector’s Z Translation is set around 4.5.

Moving the Z translate adds an ending keyframe for the animation.

15 Play the comp to see the camera animation.

For this lesson, everything is now in place. You have planets in orbit, a well-lit scene, and 
an animated camera move. In the next lesson, you’ll finish this broadcast news design 
by adding 3D text. You’ll also learn how to render your 3D scene and add 2D image-
processing effects to add the final polish.

Completed node tree for Lesson 9.
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Practice Exercise
Let’s try expanding this space with other elements. Located in the 3D Globe bin are two 
additional images: a moon.tif and a Streaks.PSD file. We’ll add both of these textures to our 
projects and animate them based on the instructions below.

1 Replace the grid texture with the moon.tif texture. Keep the same animation and size.

2 Use the Streaks image on another sphere that is slightly larger than the Earth’s radius 
and make the streaks appear to travel around the Earth’s outer atmosphere.

TIP The streaks might not look angular once added to the sphere shape.

To correct this, increase the amount of detail, or tessellation, of the streaks by 
adjusting the base subdivisions and height subdivisions in the Inspector.



267Lesson Review

Lesson Review
1 True or false? A Media In node must go through a Shape 3D node or an Image Plane 

3D node before it can connect to the Merge 3D node.

2 True or false? The center of Fusion’s 3D scene uses the following coordinates: x = 0.5, 
y = 0.5, z = 0.5.

3 True or false? To link two different parameters together, you enter a + (plus) sign in the 
value field to expose the expression field.

4 True or false? Lights must be added to a scene using their own Merge 3D node. They 
cannot be connected into a Merge 3D that already has objects connected.

5 True or false? In the viewer, a green arrow on a camera, light, or 3D object moves the 
object along the Y axis.
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Answers
1 True. A Media In node must go through a Shape 3D node or an Image Plane 3D node 

before it can connect to the Merge 3D node.

2 False. The center of Fusion’s 3D scene uses the following coordinates: x = 0, y = 0, z = 0. 
A 2D scene uses x = 0.5 and y = 0.5 as the center of the viewer.

3 False. To link two different parameters together, you enter an = (equals sign) in the 
number field to expose the expression field.

4 False. Lights, 3D objects, and cameras can all be connected to the same Merge 
3D node, but it makes for better organization and flexibility if you separate them.

5 True. In the viewer, a green arrow on a camera, light, or 3D object moves the object 
along the Y axis, up and down.
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Completed composite for Lesson 10.

Adding 3D Text to a Scene
With motion graphics, the animation is central, so it’s often a good idea to first build your 
animation and set the timing of the graphic using simple versions of your design objects. 
Later, you can apply the final materials and look. That’s the method you’ll follow here: in the 
first half of the lesson, you’ll animate very simple 3D text and shapes, and then you’ll refine 
their look in the second half.

NOTE The Timelines bin includes a Backups bin with Fusion comps saved at 
various stages of the lesson, available for reference and reverse-engineering the 
node trees.

1 In the Project Manager, open the Fusion 17 Lessons Part 3.dra project.

2 In the edit page Timelines bin, right-click Lesson 10 START and choose Open in 
Fusion Page.

This composition opens in the Fusion page with our globes, lights, and camera 
animation from the previous lesson. We’ve started this composition as if you 
completed the practice exercise from Lesson 9, with the added yellow streaks 
and a new moon look.



271Adding 3D Text to a Scene

The standard 2D Text+ node cannot be connected into a Merge 3D composite; it 
only connects to 2D composites. When you begin a 3D composite, as you did in the 
previous lesson, you must use a Text 3D node to add text.

3 Select the Merge3D1 node and press 1 to see it in viewer 1.

4 From the toolbar, drag the Text 3D tool into an empty place in the Node Editor. Press 2 
to display that node in viewer 2.

You now have a 3D viewer with access to 3D text controls, but we’ll proceed with steps 
that are very similar to using a standard 2D text node. 

5 With the text 3D node selected, go to the Inspector, and in the Styled Text field, type 
BREAKING NEWS using two lines of text. Click in the viewer and press Command-F 
(macOS) or Ctrl-F (Windows) to frame the letters.

As with 2D text, you can assign a font, size, and other text properties.

6 Set the typeface to Open Sans Bold Italic and the Size to 0.5.

You also have your choice of 3D controls, such as extrusions and bevels.
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7 Scroll to the bottom of the Inspector and click the disclosure arrow to open the 
extrusion parameters.

These parameters can add depth to text and give titles a greater sense of weight and 
substance.

8 Set the Extrusion Depth to 0.1, and the Bevel Depth and Bevel Width to around 0.02.

9 Right-click in viewer 2 and choose 3D Options > Lighting to enable the default shading 
in the viewer.

TIP You might need to zoom in to the viewer to see the changes in the bevel 
depth and width.

10 While holding down the middle mouse button, Option-drag (macOS) or Alt-drag 
(Windows) in the viewer to view different angles of the text in the perspective view.

The text is lit using default lights that more clearly show the results of the extrusion and 
beveled edges. That’s all the effort you will put into the look right now.



273Animating 3D Text

Animating 3D Text
You can animate 3D text using keyframes, expressions, and modifiers just as you can 
any object. We’ll create a simple keyframe for our 3D text and then connect it into 
the 3D scene.

1 Select Text3D1 again if it has become deselected, and move the playhead to frame 40. 
In the 3D Transform tab (second icon from the right) of the Text 3D Inspector, click the 
Keyframe button next to the X Rotation parameter.

NOTE There are in fact two sections in the Text3D Inspector labeled 
“Transform.” The first is for transforming text items (character-by-character, 
word-by-word, or line-by-line). The second—indicated by a 3D axis icon—is for 
3D transforms of the entire text object. Be sure to make the changes in these 
steps in the second Transform tab for 3D transforms.
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2 Using the X Rotation slider, drag to the right until the text is almost face down, with an 
X Rotation value of around 60 degrees.

3 Move the playhead to frame 60 and set the X Rotation to 0 so the text is 
rotated upright.

4 Play the animation to review it.

This will create a quick tilting animation, but the hinge of the rotation is at the bottom 
of the text. It would look nicer if the text rotated around a pivot between the two text 
lines. You can change the rotation pivot point using the Pivot controls.

5 Move the playhead somewhere after frame 60. This will make it easier to view the pivot 
point position.

6 In the Inspector, open the Pivot controls.
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7 Using the Y Pivot slider, drag to the right until the pivot point in the viewer sits between 
the two lines of text.

8 Play the animation to review the new rotation pivot point.

The text now rotates using a pivot point located between the two lines of text for a 
more symmetrical rotation.

Animating Text in a Scene
The rest of the animation can best be set by viewing it in context of the camera and the 3D 
scene. So, we’ll need to connect the text into the main node tree.

1 Select the Merge3D1 node in the Node Editor.

Instead of going to the Effects Library to get a tool, if you know the name of the tool 
you want, the quickest way to add it to the Node Editor is to use the Select Tool dialog.

2 Press Shift-Spacebar to open the Select Tool dialog.
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As mentioned in earlier lessons, the Select Tool dialog allows you to search for any tool 
in the Fusion page by typing a few characters or the tool’s shortcut.

3 Type merge to search for the Merge 3D tool.

4 From the list of tools, select the Merge 3D tool and click Add to add the tool directly 
after the selected Merge3D1 node.

A new Merge3D3 node can now be used to connect the text into the composition.

5 Drag the output from the Text 3D node to the input of the Merge3D3 node.

6 Select Merge3D3 and press 2 to see it in the viewer.
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7 Right-click over the perspective axis control and choose Camera3D1 to view the 
camera output in the viewer.

The text is obscured by the Earth and needs to be moved off to the right, as well as 
brought forward toward the camera so that it doesn’t run into the rotating moon.

8 Select the Text 3D node and drag the X Translation slider to the right to move the text 
out from inside the Earth sphere, around 1.5 to 2.0.
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9 To bring the text forward, drag the Z Translation slider to bring the text forward, 
around 2.5.

The text appears black in the frame because the lights are not being passed through 
the Merge nodes. Before you continue animating the text, let’s enable the lights to 
pass through to the Merge3D3.

10 Select the Merge3D1 node and, in the Inspector, click the Pass-Through 
Lights checkbox.

Now that the text is illuminated, you can continue animating. The current position of 
the text is where the text should end up at the end of our animation, so you can set a 
keyframe on frame 60 for the Z value. The X value will remain at the same value for the 
duration of the shot, so there is no keyframing needed on that parameter.

11 Move the playhead to frame 60, select the Text 3D node, and click the Keyframe button 
for the Z Translation parameter.

Now, you’ll move back to frame 40 and position the text forward until it is out of frame 
behind the camera. To make it easier to see exactly what the text is doing, you’ll view 
the perspective view in viewer 1, while you see the camera’s output in viewer 2.

12 Select the Merge3D3 node in the Node Editor and press 1 to see it in viewer 1. Then 
set the Perspective Axis menu to view the perspective view, if needed.
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13 In viewer 1, position the perspective view so that you can see the entire scene with 
the camera.

14 Move the playhead to frame 40 and drag the Text 3D node’s Z Translation slider until 
the text is behind the camera, with the Z Translation value around 5.0.

15 Play the animation to review it.

Now you have a hard-hitting breaking news animation that flies in from behind the 
camera. You can give the graphic a bit more visual interest by adding some other animated 
3D elements.
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Playing Around with 3D Shapes
The next addition to your broadcast design will be to add some 3D rectangular shapes that 
will fly by the camera. Adding design elements can contribute a sense of movement to a 
composition as well as kinetic visual interest. You will start with only one shape and then 
use the Duplicate node to place multiple offset, cloned shapes in your scene. Like the text, 
you’ll first create these elements independent of the main composition and then merge 
them in later.

1 Click in an empty area of the Node Editor to the right of the Text node.

We’ll use the Select tool dialog to add a Shape 3D node. By clicking in an empty area of 
the Node Editor, you are identifying where the node will be located when you add it.

2 Press Shift-Spacebar to open the Select Tool dialog, and type in shape.

3 From the list of tools, select the Shape 3D tool, and click Add to add the tool to the 
Node Editor.

4 Press 1 to view the Shape 3D in the viewer, and then click in the viewer and press the 
F key to fit the selected shape in the viewer.
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Using this Shape 3D, you’ll deform a cube to make it into a flat rectangle.

5 In the Inspector, use the Shape menu to change the shape from plane to cube. Next, 
you’ll flatten the cube but leave a small amount of depth to make it a slab.

6 In the Inspector, deselect the Lock Width/Height/Depth checkbox and then lower the 
Depth parameter to 0.2 to create a thin rectangular slab shape.

7 Right-click in viewer 1 and choose 3D Options > Lighting to enable the default shading 
(if it isn’t already enabled).

Bending, Twisting, and Shearing 3D Shapes
Motion graphics is a design process and is experimental in many ways. You often return to 
various parameters at a later time and tweak them as the project grows. Let’s experiment 
with giving this static rectangle a bit more punch by deforming it a bit.

1 With Shape3D3 selected, open the Effects Library, choose Tools > 3D, and click the 
Bender 3D tool to add it to the Shape3D3 tool.
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2 Press 1 to see the Bender 3D node in the viewer.

The Bender 3D tool is used to bend, taper, twist, or shear the geometry it is connected 
to—in our case, the flat rectangular shape.

3 In the Inspector, drag the Amount slider back and forth.

The default configuration is set to bend the geometry along the Y axis, but there are 
other settings that might be more appropriate for our broadcast design.

4 Reset the Amount slider, and then change the Bender Type to Shear and drag the 
slider to the left until it is set around -0.5.

This shape has some attitude to it. We’ll use this as the base shape for our 
design element.
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Duplicating 3D Shapes
From this one 3D element, you will create duplicates and offset them in regard to position. 
Doing so will fill out your scene and add more visual interest than just the spheres and the 
text. The easiest way to duplicate an object multiple times is to use the Duplicate 3D node.

1 Select the Bender3D1 node and, from the Effects Library, click the Duplicate 3D tool to 
add it to the Node Editor. Then press 1 to see it in the viewer. 

You can use the Duplicate 3D node to quickly duplicate the geometry connected to its 
input. Once you set the number of copies, you can create repeating patterns with an 
array of objects.

2 At the top of the Inspector, in the Last field, type 10 to create that number of copies.

3 Drag the X Offset to the right to spread out the 10 copies until there is space between 
each one, with an X Offset value of around 1.3.

The X Offset creates a line of 3D rectangles.

TIP Setting the First field value higher than 0 will exclude the original shape 
and show only the copies.
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4 With the Duplicate 3D node selected, click in an empty area of viewer 1 and press F to 
fit all the replicated rectangles in the viewer.

You have 10 copies of a rectangle spread out. Each copy is a copy of the previous copy, 
so the parent is copied, then the copy is copied, and the copy of the copy is copied, 
and so on. By default, all the copies line up in a row; however, the Jitter tab includes 
controls for offsetting each copy.

5 At the top of the Inspector, click the Jitter tab.

6 In the Inspector, drag the Y and Z Translation sliders to about 0.5.

You now have 10 3D rectangles that have more of an energetic look. To do any more 
with these rectangles, such as animating them, it will help to see them in context with 
the rest of the composition.
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7 Drag the output of the Merge3D3 to the Duplicate3D1 node output to create a new 
Merge 3D. Press 2 to load the new Merge3D4 node into the viewer.

The rectangles appear dark in the viewer because the Merge3D3 node is not passing 
the lights through to the new Merge node.

8 Select the Merge3D3 node and, in the Inspector, click the Pass-Through Lights checkbox.

Now that we can see the rectangles in context with the other objects and the lighting, 
we can correctly position and animate them.

The Duplicate 3D node can only offset the copies. To move the entire row of duplicated 
rectangles, you move the original object.
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9 Select the Shape3D3 node and use the onscreen controls to position the shape in the 
lower-left corner of the frame.

10 To ensure that they do not intersect with the Earth sphere, in the Inspector, click the 
Transform tab and drag the Z Translation to 1.5.

The move forward has made the rectangles a bit too large for this scene, so you’ll need 
to scale them down.

11 Drag the scale slider down between 0.6 and 0.7, and then use the Y Translation to 
position them slightly higher in the frame.
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Now, using some simple keyframing, we can slide the 3D shapes through the frame.

12 With Shape3D3 still selected, move the playhead to frame 60.

As soon as the text is in place, on frame 60, we’ll have the rows slide in from the right.

13 In the Inspector, drag the X Translation slider until the rows are completely offscreen, 
around 5.0.

14 Click the Keyframe button to the right of the X Translation slider to set the 
first keyframe.

15 Move the playhead to frame 110 and drag the X Translation slider to the left until the 
rows are offscreen, around -15.0.

16 Play the composition to see the animation. 

Each rectangle now slides across the screen and eventually out of frame.

The Duplicate 3D node is a powerful tool and is fun to experiment with. You can even 
connect multiple Duplicate 3D nodes together to create larger arrays of objects. The 3D 
motion graphics possibilities are endless.
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Working with Materials
In the first part of this lesson, you focused on your 3D scene animation, but now you 
will improve its look. Fusion uses materials to manipulate the appearance of 3D objects. 
Materials in a 3D environment cover an object like the skin or clothing of a person.

Simple materials can be applied to objects using the built-in Materials tab in each object’s 
Inspector, or more sophisticated materials can be created using Fusion’s Shader nodes. 

We’ll begin learning about materials in Fusion using the easiest method first: the built-in 
Materials tab located in the Inspector of each 3D object.

TIP Sometimes the term texture is used interchangeably with material, but a 
texture is just an image applied as part of the overall material.

1 In the Text 3D node’s Inspector, select the Shading tab.

Using the Shading tab controls, you can tint the text with a color and, to some extent, 
give the surface a dull or shiny appearance.

2 Move the playhead to frame 60 to see the Text 3D in the viewer.

3 In the Inspector’s color swatch, select a vibrant red color.

The color swatch at the top of the Inspector sets the diffuse color of the object. The 
diffuse color is the raw color of an object. You can also separate the color of the face 
from the beveled edges.
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4 Above the color swatch, disable the Use One Material checkbox.

Disabling the checkbox displays controls at the bottom of the Inspector for the Bevel 
material. The default is a white color, which looks good with the red text. However, you 
can also change the specular highlight on the material.

5 Scroll down the Inspector to view the Bevel material’s Specular parameters.

The Specular settings help to create highlights for shiny materials. There are two main 
controls for determining how shiny the material will appear. The Specular Intensity 
controls the brightness level of the highlights, while the Specular Exponent slider 
determines whether the highlight appears small and sharp like the highlights of metal 
or wide and soft like plastic.

TIP The Text 3D uses a Shading tab while other 3D objects use a Materials 
tab. The controls are similar in that they provide Diffuse color controls and 
Specular controls.

6 To get a broader flat highlight over the beveled edges of the text, drag the Specular 
exponent slider down to around 1.0.

Using the built-in Shader or Material tab for any object is the simplest method of 
controlling the object’s surface appearance. A more advanced method is to use 
Fusion’s Shader nodes.
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Using Shader Nodes
In 3D animation applications, objects use illumination materials called shaders to give 
surfaces a more realistic appearance. Fusion comes with a few shader templates in 
the Effects Library’s Templates category, but you can very easily build your own. For 
this exercise, we’ll build a very simple reflective surface for our Shape 3D slabs. Let’s 
get started.

1 In the Effects Library, select Tools > 3D > Material.

These material shaders are the building blocks for any material you want to apply to 
a 3D surface. They might have very unusual names, but they are common to most 
3D modeling applications. To keep it on a very introductory level, you can use Blinn 
for general-purpose surfaces like plastic, wood, or any rough surface, and it is similar 
to the default Shader tab you used on the Text 3D. Cook Torrance and Ward are 
more advanced shaders for creating shiny metal or glass. The Reflect node is used in 
conjunction with other Shader nodes for adding reflections. Let’s use Cook Torrance 
and the Reflect node to build a shiny reflective metallic surface for our Shape 3D slabs.

2 Drag the Cook Torrance shader to an empty area of the Node Editor near the 
Shape3D3 node.

3 Press 1 to see the shader in the viewer.
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TIP You might want to pan the Node Editor by dragging while holding down 
the middle mouse button to give yourself more room on the right side as you 
build out the material.

The viewer changes to a material viewer and shows the shader’s results on a sphere, 
but that shape has nothing to do with the actual project; it’s just intended to help 
you visualize how the material will look in a 3D environment. Fusion also adds default 
lighting to the viewer, so you can see how the material’s surface responds to light.

TIP If you want to see the material displayed as a different object, right-click in 
the viewer and choose from a list of 3D shapes.

4 In the Inspector, select a very light blue/gray diffuse color from the color swatch.

One of the main differences between using the built-in Material controls on an object 
and using Shader nodes is the ability to mix textures with the diffuse color. You 
can use premade textures or generate them in Fusion. We’ll take a few seconds to 
generate our own.
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5 From the toolbar, drag a Background tool just above the Cook Torrance node.

We will set the basic color and texture size in the Background node.

6 In the Inspector, select a medium gray color for the background.

7 In the Image tab, disable the Auto Resolution checkbox and enter a width and 
height of 256.



293Working with Materials

When you’re creating textures, it’s preferable from a graphics card memory standpoint 
to keep them small and square (powers of two) in resolution.

8 From the Effects Library Filter category, click the Filter node to connect it to the output 
of the Background node in the Node Editor, and then press 1 to see it in the viewer.

9 In the Inspector, set the Filter type to Noise and the Power to 10 and then uncheck the 
Animated checkbox so the noise pattern does not change over time.

You have just created a very simple gray noise texture. Since we are making a metallic 
texture, it would be more realistic to transform this noise into striations or banding as 
you might see on brushed metal. We can do this with a directional blur.

10 From the Effects Library’s Blur category, click the Directional Blur node to connect it to 
the output of the Filter node in the Node Editor, and then press 1 to see it in the viewer.

11 In the Inspector, set the Length to 1.
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12 Drag the output of the Directional Blur to the yellow Diffuse color input on the Cook 
Torrance node.

13 Select the Cook Torrance node and press 1 to see it in the viewer.

Now we have a good base for our brushed metal material, but we need to add 
reflections to make it truly look like metal.



295Working with Materials

Adding Reflections
Reflections are best created by adding a Reflect node directly after your primary 
Shader node.

1 With the Cook Torrance node selected, from the Effects Library 3D > Materials 
category, click the Reflect node and then press 1 to see it in the viewer.

The Reflect node will be used to layer a reflection image over the top of your diffuse 
material from the Cook Torrance node. So the first step is to bring in an image you can 
use as the reflection image.

2 Open the media pool, and then from the 3D Globe bin, add the Italian Nights image to 
the Node Editor near the Reflect node.

3 Press 1 to see the image in the viewer.

This HDR (high dynamic range) equirectangular image can be used as a reflection map 
for surface materials created in Fusion. Even though it is a flat image, equirectangular 
images represent 360 degrees—just like the maps of the world you’ll see with the 
polar caps stretched out at top and bottom. But just connecting that into a reflect 
node will not give you a realistic reflection.
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4 Hold down the Option (macOS) or Alt (Windows) key and drag the output of the Media 
In node to the center of the Reflect node, then first release the mouse button, and 
then release the Alt or Option key.

5 From the dropdown menu, choose Reflection Color Material, and then select the 
Reflect node and press 1 to see it in the viewer.

Although this looks OK, the image does not have the right distortion if it indeed was 
a reflection. To create a more realistic reflection, you must put the image through a 
sphere map before it goes into the Reflect node. 

6 Select the Media In node and then press Shift-Spacebar to open the Search window.
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7 Enter the word sphere and then press Enter to insert the Sphere Map node between 
the Media In and the Reflect node.

The Sphere Map takes the image and uses it to simulate the environment surrounding 
an object, creating the correct warping distortion around the sphere’s edges.

8 Move the playhead to frame 75 to see the duplicated Shape 3D elements in the viewer.

9 Drag the output of the Reflect node to the green material input on the Shape 
3D 3 node.
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The rectangles now have a reflective brushed metal material applied.

TIP If you want to apply material shaders to 3D text, you must add a Replace 
Material node after the Text 3D node and connect the shader to the Replace 
Material node. 

This shows just how easy it is to make custom materials.

Take the time to explore other template shaders that come with DaVinci Resolve, because 
they will help you understand how more complex shaders are made.

Converting 3D into a 2D Image
Every 3D scene ends with a Render 3D node that converts the 3D environment into a 
2D image. Once you add the Render 3D node, additional 2D image processing can be 
inserted, and you can render the output directly into the edit page timeline via the Media 
Out node. The Render 3D node is not just a conversion node from 3D to 2D; it also includes 
several render processes that can enhance the look and quality of your comp. The most 
significant of those is adding depth of field.

1 In the Node Editor, select the Merge3D4 node and, from the toolbar, click the Renderer 
3D tool to add it to the Node Editor.
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TIP With smaller display resolutions, you might need to temporarily hide the 
Inspector in order to see the Renderer 3D icon.

2 Press 1 to see the Renderer 3D output in viewer 1.

The Renderer 3D is set to render the default perspective view camera, so the first item 
you will want to take care of is to choose the camera you want to render.

3 In the Inspector, choose Camera3D1 from the Camera menu. 

The Renderer 3D node includes two render engine options:

The software renderer engine uses only the system’s CPU to produce the rendered 
images. It is usually much slower than using the OpenGL renderer engine but 
produces consistent results on all computers.

The OpenGL renderer engine employs the GPU processor on the graphics card to 
accelerate rendering. Using this method, the output might vary slightly from system 
to system, depending on the graphics card in use. The increased speed of the OpenGL 
renderer engine makes it possible to customize supersampling and 3D depth-of-field 
options. For these reasons, the OpenGL renderer engine is most commonly used.
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4 In the Renderer Type menu, choose OpenGL Renderer.

You should notice little if any difference in the viewers because this 3D composite 
hasn’t taken advantage of any special compositing operations that would differentiate 
the two render engines. However, you should see a difference between the 
perspective view in viewer 2 and the Renderer 3D output in viewer 1. Lighting is not 
initially enabled for the Render 3D node as it is in the viewer. You’ll need to enable 
lighting to get the shading you see in the perspective view.

5 In the Inspector, select the Enable Lighting checkbox to see the effects of your 
directional and ambient lights.

One last check is to make sure the Render 3D is set to output the correct resolution for 
your shot. In this case, the project resolution is set to 1920 x 1080, so that is what the 
Renderer 3D should be set to as well.

6 In the Inspector, click the Image tab, and make sure the width and height values match 
the project resolution of 1920 x 1080.

Right now, your project looks nice but still a bit flat. You can remedy that by adding 
depth of field.
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Configuring Depth-of-Field Effects
To give your project more photorealism, you can simulate a camera’s shallow depth of 
field setting. Depth of field (DoF) is the range before and after the focal plane that appears 
acceptably sharp. Areas outside that range are increasingly out of focus.

The first step in setting up depth of field is to enable it in the Renderer 3D node. You’ll then 
set up the camera’s focal plane.

1 In the Renderer 3D Inspector, click the Controls tab and enable both the Accumulation 
Effects and then the Depth of Field checkboxes.

The higher the quality, the better the depth of field will look, but the longer and 
harder the computer will have to work to process the effect. The default amount of 32 
samples is usually sufficient. The amount of DoF blur changes the size of the in-focus 
area. The lower the number, the more of the image remains in focus.

2 Decrease the amount of DoF blur to 0.05 and play through the animation to preview it.
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The scene is clearly blurred, but the text never comes into focus. Just as with a real-
world camera, you need to set the focal point so that the camera is focused on the 
area where the text lands.

3 When you’re finished previewing the animation, stop playback. Select Merge3D4 and 
press 2 to load it into the viewer (if it isn’t already loaded). Right-click the camera axis 
control in viewer 2 and select the top view.

TIP If you need to, in viewer 2, hold down the Command (macOS) or Ctrl 
(Windows) key and scroll the middle mouse wheel to frame the viewer so that 
you can clearly see the text, spheres, and the camera.

The top view will make it easier to precisely focus the camera on the text.

4 In the Node Editor, select the Camera3D1 node and, in the Inspector, scroll down to 
open the Control Visibility section.

You can determine where the camera is focused by using a focal plane in the top view. 
The focal plane is like the focal point in a camera. It tells the camera where to focus in 
the 3D scene.

The focal plane is not visible by default, but you can enable it and set its position in the 
Camera node’s Inspector.
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5 Select the Focal Plane checkbox.

In viewer 2, a green rectangle is displayed in the camera’s angle of view outline to 
represent the focal plane.

6 Move the playhead to frame 60 of the composite. This is where the text is in its final 
landing position.

To focus on the text at this frame, you can position the focal plane directly over 
your text.
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7 In the Inspector, adjust the Focal Plane slider until the green focal plane intersects with 
your text in viewer 2.

The focal plane is now fixed at the location where your text lands, causing the text to 
be in focus in viewer 1.

Since the camera pulls back during the course of the comp, the text will eventually be 
out of focus again, so you’ll need to keyframe the plane of focus.

8 Click the Keyframe button to the right of the Focal Plane slider.

9 Move to the end of the render range and adjust the Focal Plane slider again to be 
directly over the text.

Since there is no text at the start of the composition, you can focus on the sphere and 
have it rack focus as the text comes into view.

10 Move to the start of the render range and adjust the Focal Plane slider to be directly in 
front of the Earth sphere.

11 Press the Spacebar to preview the now-in-focus animation.
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Depth of field adds a significant enhancement to the look of graphics. When creating a 3D 
motion graphics design, you cannot just depend on 3D processing within the Merge node. 
The Render 3D options, as well as other 2D image processing, can also enhance the design.

TIP If you regularly want a node to appear with certain settings already configured, 
you can right-click over the node in the Node Editor and choose Settings > Save 
Default. Any time you add that node to a Node Editor, it will come preset with the 
current configuration.

Adding 2D Look Design
The output of the Renderer 3D node is a 2D image that you can use like any 2D source 
image. Once you configure the Renderer 3D node, its output can be used like any image in 
your node tree. We’ll add a Background node to create a solid color background and then 
add a standard Merge node with our Renderer 3D as the foreground.

1 Click in an empty area below the Renderer 3D node and then press Shift-Spacebar to 
add a Background node.

The Background node will create a solid black background that we will use 
for our comp.

2 Drag the output of the Renderer 3D node to the output of the Background node.
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Dragging the two outputs together creates a Merge node with the Renderer 3D as 
the foreground.

3 Press 2 to see the Merge node in the viewer.

With the composite now in 2D, you can add image-processing filters to 
enhance the look.

4 Click the Effects Library button to open the Effects Library.

The Effects Library includes all the Fusion page’s compositing tools, as well as all the 
Resolve FX that you might have used previously in the edit and color pages.

5 In the Effects Library, click the Open FX category and then select the Resolve FX 
Light category.

6 Drag the lens reflections from the Effects Library to the connection line between the 
Renderer 3D and the Merge nodes.
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The Lens Reflections node is added to the comp, simulating flaring lens effects based 
on the shape and motion of highlights in the shot. The simulated reflections also move 
based on the animation of the elements, thereby creating an animated effect without 
adding keyframes to do so. However, the effect is a bit too strong, so let’s lower 
its intensity.

7 In the Inspector, click the Settings tab and drag the Blend slider to around 0.5 to lower 
the intensity of the lens reflections.

3D compositing is often too clean and sharp on its own, so adding a 2D image-
processing pass can create a more organic-looking composite.

8 Drag the output of the Merge 1 node to the Media Out node.

Using the combination of Shape 3D, Merge 3D, Render 3D, and regular Merge nodes, you 
can create multiple 3D and 2D sections within a single composite, which makes Fusion’s 3D 
compositing extremely powerful.

That’s it for this lesson, but you should go back and modify each parameter to your liking. 
Don’t be afraid to mix and match new 2D filters to see how they affect each other too.
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Hopefully, you have a good understanding of building a 3D scene with text and objects 
and repurposing those as templates. Also, the idea of building animation first, developing 
the look second, and then finishing the final render with color correction, glows, and 
filter effects will help structure your projects. You can build upon a lot of the powerful 
techniques over these past two lessons and take your motion graphics to the next level 
using Davinci Resolve 18.

Completed 3D text node tree in Lesson 10.
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Lesson Review
1 True or false? The 2D Text+ node cannot be connected into a Merge 3D node.

2 True or false? Depth of Field is enabled in the Camera 3D node.

3 True or false? 2D image processing like blurs and color correction can be added 
anywhere after a Merge 3D node.

4 True or false? The last node after any 3D compositing must be a Renderer 3D node.

5 True or false? Only a 3D foreground, background, a light, and a Camera node can be 
connected to a Merge 3D node.
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Answers
1 True. The 2D Text+ node cannot be connected into a Merge 3D node. Only Text 3D 

nodes can be used for text in a 3D composite.

2 False. Depth of Field is located in the Renderer 3D node.

3 False. 2D image processing nodes can only be placed before any 3D node or after a 
Renderer 3D node.

4 True. A Renderer 3D node is required at the end of any 3D compositing to convert the 
3D scene to a 2D image.

5 False. Unlike the standard 2D Merge node, there is no foreground or background 
limitation on a Merge 3D node. An unlimited number of 3D elements can be connected.
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Lesson 11

Exploring 3D 
Particle Systems

Fusion’s very powerful 3D particle 
system generates large numbers 
of automatically animated objects. 
The objects can be any image, movie 
file, polygon shape, text, or Fusion 
generator. Particles have infinite uses 
in just about every type of project. 
You can create practical effects such as 
fire and rain or create more abstract 
motion graphics designs. Fusion 
also includes particle-specific tools 
to simulate physical phenomena—
wind, gravity, and bounce—as well 
as forces that allow particles to be 
attracted to or repelled by other 
objects. With so many ways to build 
and manipulate particles, it’s easy 
to become overwhelmed with the 
possibilities. So, in this lesson, you’ll 
focus on building some simple blowing 
smoke for the music video clip from 
Lesson 5. You’ll learn about Fusion’s 
essential particle tools and their many 
artistic options. 
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Completed particles for Lesson 11.

Setting Up a Particle System
To start, you’ll use a 3D composition that is already set up for you. Unlike the 2D green-screen 
shot you worked on in Lesson 5, this shot from the same music video is set up as a full 3D 
scene. Since we’ll be working in 3D, the particles will be able to surround every element in the 
scene. You’ll begin by adding the essential nodes to create particles and get them moving.

1 In the Fusion 18 Lessons Part 3.dra project, open the Lesson 11 START timeline. 
Position the playhead over the Fusion clip and click the Fusion page button.

2 In the Node Editor, select the Media Out node and press 2 to see it in the viewer, 
if necessary.
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3 Select the Merge 3D node, press 1 to see it in the viewer, and then set viewer 1 to 
display the perspective view.

This node tree includes a 3D layer for the band, a purple underlay containing the 
background elements broken into different 3D layers, and a camera. All you need to do 
is add some apocalyptic blowing smoke to this scene.

Any time you create a particle system in Fusion, you must start with two nodes: a 
Particle Emitter node that generates the particles, and a Particle Render node that 
renders the results.

4 From the toolbar, drag the pEmitter tool into an empty area of the Node Editor, above 
the Merge 3D node.

5 With the pEmitter selected, go back to the toolbar and click the pRender to add it to 
the Node Editor.
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TIP You could use a pImage Emitter node instead of a pEmitter node. The 
pImage Emitter node is best used in special cases when you want to take an 
image and treat each pixel of the image as if it were a particle. Otherwise, 
in all other cases, you would begin with a pEmitter node connected to the 
pRender node.

When starting with particles, your first choice is whether to generate particles for a 
2D or a 3D composition. For this exercise, you will create a 3D particle system because 
doing so will allow us to create a sense of depth for the particle smoke.

6 In the Node Editor, select the pRender node and, in the Inspector, ensure that the 
Output Mode is set to 3D.

To view the particles, you need to view only the pRender node. All other particle nodes 
are visible only through the pRender node.

TIP The names of all particle-specific nodes begin with a p: pSpawn, pBounce, 
pTurbulance, and so on. This naming convention makes it easy to locate and 
identify particle-specific nodes.

7 Press 1 to view the pRender in viewer 1.

Because the pRender node is set to 3D, the viewer shows a 3D scene. The pRender is 
all you will view for a while, so you can open up more space in the interface by using 
just a single viewer.
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8 In the upper-right corner of viewer 1, click the Single-Viewer button.

You now have one viewer to work in and more room for the rest of the interface. 
You can improve performance by not viewing any nodes that are not particle nodes. 
Even though viewer 2 is hidden, viewing the Media Out in viewer 2 will still impact 
performance.

9 Select the Media Out node and press 2 to stop it from viewing in viewer 2. Most of your 
actual particle setup begins in the pEmitter node.

Confirm that the second display indicator dot at the lower left of the MediaOut1 node 
is now dark.

10 In the Node Editor, select the pEmitter.

A particle system is divided into two primary parts: the particle emitter and the 
particle cells.

The particle emitter is the source of the particle cells. By default, the viewer displays 
this emitter as a green wireframe sphere, but you can easily change it into almost 
any shape, including a rectangle, a line, text, or a polygon. It defines the area that 
produces the particles.

The particle cell is the object that is multiplied and animated by the particle emitter. 
By default, it is represented by small white points within the sphere, but as with the 
emitter, the particle cell can be any image or built-in particle cell object. The default 
small white points tend to be difficult to see clearly, so temporarily we will set the style 
of the particles to be a larger object.

11 In the Inspector, click the Style tab.

The Style tab includes a menu in which you can choose the object to be used for the 
particle cells.
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12 In the Style menu, change Point to Blob.

Blobs are soft white circles that can be useful when creating glowing bokeh effects.

We’ll use them here temporarily, just to get our particles started. Next, let’s work on 
getting these particle cells moving.

TIP Bokeh is a Japanese term that refers to the blurring in defocused images, 
and more commonly the blooming highlights produced. They take the shape of 
the camera’s mechanical aperture, either circular or faceted, depending on the 
aperture mechanism.

Adding Motion to Particles
The default tab in the Inspector for the pEmitter is the Controls tab. There, you can start 
to define how many cells are generated and in which direction they move. To give your 
particle cells some movement and a trajectory, you use the Velocity and Angle controls 
in the Inspector. It’s easier to perform motion-based adjustments on particles while the 
comp plays.

1 Click the Play button to begin playing the comp.

2 Click back on the Controls tab in the Inspector.

Particle cells start with no motion. They require some force that makes them move. 
So, when you first click the Play button, the particle cells appear to fill up the sphere 
emitter shape, but they don’t go anywhere.
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3 In the Velocity section of the Inspector, set the Velocity value to about 0.2.

All the particle cells shoot to the right at a steady, constant rate. To change the angle of 
direction, you can use the Angle control.

4 Below the Velocity setting, adjust the Angle to 180, causing the particles to emit 
to the left.

The Angle setting determines a clockwise or counterclockwise angle, so a setting of 
180 causes all the particle cells to move in the opposite direction.

If you want to produce more natural-looking particles, you need to add variation to a 
setting. For instance, to impose a more natural look on your particle cells, they should 
not all move at the same constant speed. Adding variance to the velocity will cause 
some individual particles to move slower and some to move faster.

5 Set the Velocity Variance to 0.1. Doing so causes some particles to move 5% faster and 
others 5% slower than the current 0.2 velocity setting.

The number of particles generated on each frame is determined by the Number 
setting. The default Number setting of 10 generates 10 particle cells on every frame, 
which may be too many for what we’re creating, so let’s lower that number.

6 Set the Number to 0.3 to create one particle roughly every three frames. That doesn’t 
sound like a lot, but smoke doesn’t require many particles, and you can always change 
the number later if needed.

The last step in your initial setup of a particle system is to determine how long the 
particles last. You control the duration of the particles through the Lifespan value. Your 
composition is 42 frames long, as you can see by the render range End value to the left 
of the time ruler. You will want all your particles to end after frame 42 to ensure that 
they last for the entire composition and do not just disappear midway.
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7 Set the Lifespan to 50 to ensure that all your particle cells will last the entire duration 
of the composition.

These settings are the essential parameters for the initial setup of any particle system. You 
set the number of particles, the general speed, and the direction in which they should travel.

The other essential set of controls determines the size, position, and shape of the emitter. 
While you’ve been using the emitter’s default sphere shape, it’s now time to explore its 
other options.

Defining the Emitter Shape
The emitter is the source from which particles are generated. If you were creating 
fireworks, the emitter would be a small point on the ground. If you were making rain 
or snow, the emitter would be a rectangular shape that hovers over the scene. For the 
blowing smoke, you want the particles coming from the area offscreen to the right of the 
band and deep enough to cover the entire 3D scene. To redefine the emitter shape, you 
use the Region tab in the pEmitter Inspector.

1 In the Inspector, click the Region tab.

The Region menu in the Region tab is the primary control that defines the object used 
as the emitter. Once you decide on the basic shape, you can then use the Transform 
controls to position and scale the emitter object how you need it.
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2 In the Region menu, change Sphere to Cube.

The viewer now shows the particle cells emitting from a cube shape. To make a larger 
emitter area for the particles, you can make the cube taller and deeper. You’ll size it 
roughly for now, and you can return to refine it after you connect the particles into the 
larger 3D scene.

3 At the top of the Inspector, set the Height to 0.5 and the Depth to 1.0.

When you connect the particle system into the 3D scene, you’ll need to position it based 
on the objects in the scene. For now, you’ll leave it here.

Using Images for Particle Cells
It’s unusual to stay with the small white blobs for your particle cells. In fact, the cells can 
be almost any object you choose. Often, you’ll use one of the built-in shapes to get started 
and later switch to an image or small movie file when you have completely configured the 
cells’ motion. You set the cells’ appearance in the Style tab.

1 From the Particles bin in the media pool, drag the Noise clip to an empty place in the 
Node Editor, near the pEmitter. Then press 1 to see it in the viewer.
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The file is a small 200 x 200-pixel movie that somewhat resembles some type of vapor 
like clouds, smoke, or fog. It was created using Fusion’s Fast Noise generator.

NOTE You can learn to create the noise movie in Appendix B.

Although this movie is just a single puff of smoke, you can make it into larger plumes 
by connecting it into the pEmitter. The Style tab where you previously selected the blob 
type also allows you to choose to use an image from the node tree for your particles.

2 Select the pEmtter node and, in the Style tab’s Style menu, choose Bitmap.

Bitmaps allow you to connect and use images as particle cells.

When you set the style to bitmap, a yellow input is displayed on the pEmitter node that 
allows you to connect any image in the Node Editor.

3 Drag the output of the Noise movie to the green, style input on the pEmitter.

NOTE Be careful to connect MediaIn1 to the green input. Simply dragging to 
the pEmitter node and releasing will default to the yellow region input. This 
would use the image to define where particles are born, rather than how they 
are styled.

For the remaining exercises in this lesson, you’ll need two viewers to see the final 
output and the 3D perspective view.
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4 In the upper-right corner of the viewer, click the Dual-Viewer button.

5 Select the Merge 3D node and press 1, and then select the Render 3D node 
and press 2.

To make sure your smoke fits well into the 3D scene, you’ll connect the particles into 
the Merge 3D node.

6 Drag the output of the pRender node to an open input on the Merge3D1.

For the first time, you are able to see the particle smoke integrated into our scene.

7 Click the Play button to view the smoke in the scene.
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Yeah, not very impressive…yet. A few issues prevent the particles from looking like 
smoke. The particles are very small, sparse, and too light to match the light in the comp. 
All these issues are easy to fix, but before we dive in too deep, let’s optimize the playback 
performance of our composition.

Optimizing Performance
The larger your composition grows, the longer it takes to load into RAM for playback.

You can improve the performance for playback in several ways. One way is to limit the area 
of the viewer that gets updated when you play the composition.

1 In the upper right of viewer 2, click the dropdown menu next to the Region of 
Interest button.

2 From the Region of Interest menu, choose Set.

3 Drag a wide rectangle around the three band members in viewer 2.

4 Click the Play button to watch the composition.
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TIP During playback, clearing one of the viewers of any image will also increase 
performance.

Only the portion of the frame outlined by the region-of-interest rectangle is updated as 
the composition plays. The smaller the rectangle, the better performance you will see 
playing back a composition.

Controlling the Timing 
and Look of Particles
OK, now that we have better playback performance, we can get back to creating our 
particle smoke. The most obvious problem is the small size, so we’ll adjust the size first, 
and then match the color.

1 In the pEmitter Style tab, set the Size to 0.5 and the Size Variance to .05.

Some of the smoke particle cells are now larger, and some are smaller. As with most 
other particle settings, adding variance to the size brings a more natural appearance 
to the particle system.

The emitter also must be corrected. First, the emitter is centered in the frame, so the 
particles are generated in the frame instead of offscreen to the right. Second, the 
particles should already be covering the frame at the start of the shot, but currently 
they are only starting to generate on frame 1. Let’s deal with the positioning problem 
first. All we need to do is position the emitter off to the right side of the frame.

2 At the top of the Inspector, select the Region tab.
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3 While looking at the perspective view, drag the X Offset slider to the right until the 
green emitter outline in the viewer is positioned off to the right of the band.

The second issue requires you to give the particles a running head start before the 
composition starts. You can pre-generate particles to ensure that the smoke is already 
covering the frame on frame 1.

4 Select the pRender node and, toward the bottom of the Inspector, set the Pre-
Generate Frames slider to 40.

Setting the slider to 40 causes the particles to render on frame 1 in the state they 
would appear on frame 40 of the composition.
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5 Click the Play button to view the smoke in the scene.

Although better, the transparency for the particles isn’t perfect, and the particles still 
end too early. The problem with the timing is that earlier you set the lifespan of the 
particles to 50 frames. At the time, that seemed long enough, but now the particles 
are pre-generating 40 frames, so their life must be extended.

6 Select the pEmitter node, and then select the Controls tab and increase the 
lifespan to 100.

This should be long enough to cover the pre-generated frames for the duration of 
our composition.

The particles now last long enough for the composition, but when they overlap they 
appear to have very hard edges. This is a result of the fast Z-depth sorting that Fusion 
performs by default. The behavior is corrected when you render the 3D particles 
using the Render 3D node.

7 Select the Render 3D node in the Node Editor.

8 At the bottom of the Inspector, set the Transparency menu to Sorted (accurate).

All these adjustments have created a much more realistic effect. You can further improve 
the integration of the smoke into the scene with a small amount of color correction.
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9 Select the pEmitter node and, in the Style tab of the Inspector, open the Color Controls 
section, and then expand the Color swatch section.

The color swatch in the Color Controls is for setting an overall color to all the particles.

10 Set the color swatch to a light yellow/green tint to match the background light.

The lack of transparency in the color makes it appear more like thick fog than blowing 
smoke. You can introduce more transparency in two ways. First, you can use the Alpha 
slider under the color controls swatch to add transparency to the color.

11 Under the color swatch, drag the Alpha slider down to around 0.5.
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12 You can control the overall blend of the particles by going to the top of the Inspector 
and adjusting the Gain control to between 0.2 and 0.3

Lastly, to add more randomness to the motion, you’ll add a spin animation to the particles.

13 Select the Controls tab in the Inspector and set the Z spin to 1.

A 10-degree spin is added to each particle cell on every frame. This will add a tumbling 
animation to the particle cells. As with every aspect of particles, increasing the 
variance for a given parameter will make them appear much more realistic.

Increase the Z spin variance to 0.5.
So far, you have used just a few fundamental controls, but even these controls can realize 
a multitude of particle variations. As you have experienced, a small change to one of these 
parameters can yield big results. Beyond the basic controls are several additional nodes 
specifically designed for particles that can add character and increase the realism in particles.

Introducing Particle Forces
The pEmitter and pRender nodes are the essential requirements for your particle 
system, and they offer a wealth of control, but you can apply a variety of particle forces or 
behaviors to shape the flow and speed of your particles. From respawning new particles, 
to bouncing off objects in the scene, customizing particles is just a matter of stringing 
together other particle nodes between the pEmitter and pRender nodes.

TIP The only nodes that you can add between the pEmitter and pRender nodes 
are particle-specific nodes with names that start with a lowercase p, such as 
pTurbulence or pSpawn. You cannot add standard image-processing nodes such as 
Blur or Color Corrector between the pEmitter and pRender nodes.
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1 Above viewer 2, click the Region of Interest button to disable it.

It will be easier to see the affect turbulence has on the particles if you view the entire 
frame, even at a diminished performance.

2 With the pEmitter node selected, open the Effects Library, select the Tools > Particles 
category, and then click the pTurbulence tool.

The pTurbulence node adds random chaos to the particle cells’ motion, making it 
appear more unpredictable and more natural. Let’s adjust the turbulence to increase 
the variety of movement among the particle cells.

3 Set the density to 75.0. This will cause steadier, less chaotic movement to our particles 
while still adding some turbulence.

4 Play the particle composition to view the results. 

Congratulations! You just created your first particle animation!

You now have a clearer understanding of how to use Fusion to create realistic particles. 
It is an extremely powerful and fun aspect of DaVinci Resolve 18.

Completed particle node tree for Lesson 11.
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Lesson Review
1 True or false? The end of every particle system requires a pRender node.

2 True or false? To make particles glow, you can add a soft glow between a pEmitter and 
a pRender node.

3 True or false? The pRender node controls how many particles are generated, as well as 
the size and color of the particles.

4 True or false? Setting the velocity to 1.0 will cause the particles to move down in 
the frame.

5 True or false? Configuring particles to work in 2D or 3D occurs in the pRender node.



330 Lesson 11 Exploring 3D Particle Systems

Answers
1 True. Every particle system must end with a pRender node.

2 False. Only particle nodes can be inserted between a pEmitter and pRender node.

3 False. The pEmitter node (not the pRender node) controls how many particles are 
generated, as well as the size and color of the particles.

4 False. Velocity has nothing to do with direction.

5 True. The pRender node includes an Output Mode menu where you can set the 
particles to work in 2D or 3D.
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Lesson 12

3D Camera Tracking

One of the most difficult tasks in 
budget filmmaking is set design. 
Without a lot of money—and a small 
army of carpenters—it’s a challenge to 
make your set look like ancient Rome, 
or the command bridge of a high-
tech starship, or an alien planet with 
three moons. Typically, efforts to turn 
your cousin’s basement into a secret 
government research lab will end up 
looking like your cousin’s basement.

Fusion changes all that. Using its 
powerful 3D Camera Tracker node, you 
can create enhanced set designs with 
surprisingly little effort.
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During this lesson, you’ll learn how to set up, perform, and refine a 3D track in order to 
realistically add a pirate ship off the coastline of a simple beach shot.

NOTE This lesson uses the Camera Tracker node, which is available only in 
DaVinci Resolve 18 Studio.

Completed composite for Lesson 12.

Rotoscoping for 3D Tracking
Camera tracking uses sophisticated photogrammetry to recreate a virtual 3D scene that 
corresponds to the physical set in your live-action scene. The position, movement, and 
focal length of your camera are recreated in Fusion’s 3D space, along with the spatial 
locations of landmarks within your set.

While the intricacies of photogrammetry are far beyond the scope of this book, here’s a 
simplified explanation of the process: the Camera Tracker uses the relative speeds and 
movement directions of items in your scene to determine where they are in space. When 
you ride in a car or train, you observe that objects closer to the car move more quickly than 
objects in the far distance. The Camera Tracker can use this motion parallax to calculate 
the position of each element in the physical scene and calculate where a virtual camera 
should be to replicate the same parallax within the computer.
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This calculated parallax works convincingly as long as everything in your shot is “nailed 
down.” Objects within the shot that exhibit independent motion—such as those pesky 
actors who always seem to find their way into visual effects shots—can confuse the 
calculations and produce poor results because their speed is not dependent solely on their 
distance from the camera. Therefore, before you can perform a 3D camera track, you need 
to use mattes to identify which objects you want to track and which you want to ignore.

1 In DaVinci Resolve 18, open the Fusion 18 Lessons Part 3.dra project.

2 From the Master bin, load the Lesson 12-START timeline and play the first clip in 
this timeline.



334 Lesson 12 3D Camera Tracking

As it plays, try to identify objects in the clip that will require garbage matting—that is, 
locate the objects in the shot that exhibit independent motion with respect to the shot 
(things that aren’t “glued to the set”).

In this shot, the actors and the ocean obviously have independent motion. The rock 
outcropping and the beach move only because the camera moves. You’ll matte these 
two elements separately.

TIP Sometimes (and this is one of those times) it’s easier to first create mattes 
of the objects you’re trying to track, and then subtract the objects you’re trying 
to avoid tracking. Fusion’s masking tools make it easy to do these subtractions, 
as you’ll see shortly.

3 With your mouse still over the first clip, switch to the Fusion page and move the 
playhead to the start of the clip.

4 Double-click in the gray space of the Node Editor to deselect any selected nodes.

5 Press Shift-Spacebar to open the Select Tool dialog and type polygon to add a 
polygon tool.

6 Create a very rough outline around the rock outcropping at the start of the render 
range. You might want to pan the viewer to allow you to draw the shape beyond the 
left edge of frame.

7 Advance the playhead to the last frame in the render range: frame 126.
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8 In the viewer toolbar, click the Select All Points button.

9 Move and reshape the polygon to fit the rocks. Once you’ve roughly moved the shape 
into place, you can click away from the points to deselect all, and then click and drag 
individual points to reshape as needed.

TIP Emphasize speed over accuracy. As long as you keep the rocks mostly 
within your garbage matte, the Camera Tracker algorithm can ignore stray 
pixels that fall on either side of the matte edge. Your garbage matte shape 
should require no more than a dozen control points.

10 Move to roughly the middle of the clip, around frame 60, and reshape the polygon to 
fit the rocks.

Unless you need to move individual points, it’s easier to keyframe the polygon using 
a shape box.
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11 Click the Select All Points button again, and then press Shift-B to enable the shape box 
around the entire polygon. Drag the control handles on the shape box to stretch and 
resize the polygon shape to encompass the rock.

12 Press Shift-B again to dismiss the shape box.

13 Scrub through the clip to make sure the shape consistently fits the rocks. Reshape 
the polygon using the shape box or individual control points in areas where it 
needs refinement.

TIP Pressing the Option-Left or Right Arrow key (macOS) or Alt-Left or 
Right Arrow key (Windows) will move the playhead to the previous and 
following keyframes, respectively.

14 When you’re done keyframing the shape, select the Polygon node, press F2, and 
rename the node rocks_gshape.

15 Press Command-Left Arrow (macOS) or Ctrl-Left Arrow (Windows) to move to the start 
of the render range at frame 11.

16 Double-click again in the gray space of the Node Editor to deselect all nodes. Press 
Shift-Spacebar, and then press Enter or Return immediately to repeat the previous 
Polygon tool selection.
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17 Repeat the previous matte process to draw and animate a shape around the 
foreground beach.

18 Select the new Polygon node, press F2, and rename it beach_gshape.

19 Click an empty space in the Node Editor and add two more unconnected Polygon nodes.

20 Repeat this rotoscoping process to add and animate two smaller shapes for the pirates 
running up the beach. Starting at the end of the render range on frame 128 might be 
easier because the pirates are larger and clearer in this part of the shot.
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21 Rename these new polygons SR_pirate_gshape for the pirate on the right and 
SL_pirate_gshape for the pirate on the left (SR and SL for screen right and screen 
left, respectively).

At the moment, these are just unconnected polygons. To make them into a mask that you 
will use with the Camera Tracker, you need to combine them.

Combining Garbage Mattes
To create a single mask for your camera track, you must connect all the masks and 
combine them so that the actors are subtracted from the beach and rocks mask. You’ll 
start by combining the two main mattes: the rocks matte and the beach matte.

1 Connect the output of rocks_gshape into the effect mask input of beach_gshape.

2 Select the beach_gshape and press 1 to display its output in viewer 1.

In viewer 1, you can confirm that the two images are combined. The Camera Tracker 
tracks the white areas and ignores the black portions of the matte. It will track the 
rocks and the beach, but the pirates are not “glued” to the set, so they must be 
excluded from the tracking because they overlap with the rocks.

3 Connect the output of the beach_gshape to the effect mask input of SL_pirates_gshape.



339Combining Garbage Mattes

4 Select SL_pirates_gshape and press 1 to display its output in viewer 1.

5 In the Inspector, set the Paint Mode to Subtract.

You can see that the SL_pirates_gshape is now cut away from the main garbage matte. 
You’ll repeat this procedure for the SR_pirates_gshape and reposition nodes in the 
Node Editor to clean things up a bit.

6 Connect the output of the SL_pirates_gshape to the effect mask input of the SR_
pirates_gshape and display the SR_pirates_gshape in viewer 1.

7 In the Inspector, again set the Paint Mode to Subtract.

8 In the Node Editor, drag all the connected Polygon nodes to rearrange them into a 
neat column.

9 Select the lined-up Polygon nodes and press Shift-Spacebar to open the Select 
Tool dialog.
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10 Type underlay and press Return or Enter to add an underlay that surrounds the 
selected nodes.

We’ll use the underlay to group all the matte nodes visually.

11 Command-click (macOS) or Ctrl-click (Windows) each of the Polygon nodes to deselect 
them. Press F2 and rename the underlay garbage_matte.

The underlay surrounds the selected nodes, making it easier to locate and move these 
nodes as your node tree grows.

Preparing the Camera Tracker
With all the manual labor out of the way, it’s time to set up the tracker and let it do all the 
hard number crunching.

In case you were unable to complete the mattes for all the frames, we’ll jump ahead and 
open a completed version of the previous exercise. You can access previously saved 
versions of a composite directly from the clip in the Fusion page.

1 In the upper-left corner of the DaVinci Resolve window, click the Clips button to display 
a thumbnail timeline.

Along the bottom of the window, a thumbnail is shown for each edit in your timeline. 
The currently selected shot is highlighted with a red outline. Because each Resolve 
user tends to create and keyframe garbage mattes differently, you’ll use a saved 
version of the garbage mattes.
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2 Right-click the first thumbnail and choose Rotoscope done > Load.

This new composite will appear similar to the one you just created, but it includes all 
the mattes created and animated.

3 Click the Clips button to hide the thumbnail timeline.

4 Select the Media In node and press Shift-Spacebar. Type cam and, from the list of 
tools, select the Camera Tracker. Click OK to add the tool to the Node Editor.

NOTE The Camera Tracker requires DaVinci Resolve 18 Studio. If you’re 
working with the standard version of DaVinci Resolve, you can continue with 
the lesson after the solve section is complete.

The Camera Tracker is added to the Node Editor with the MediaIn1 node connected to 
its input. To use all the garbage mattes that you created, you must connect them into 
the track mask input of the Camera Tracker.

5 Connect the output of the SR_pirates_gshape to the track mask input of the Camera 
Tracker node.
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6 Press Command-Left Arrow (macOS) or Ctrl-Left Arrow (Windows) to move to the start 
of the render range at frame 11.

The Camera Tracker starts by generating a cloud of trackers informed by areas of 
contrast in the image. The first job is to tune the settings for this particular shot to get 
a good set of tracks.

7 Select the Camera Tracker node and press 2 to display it in viewer 2.

8 In the Camera Tracker’s Inspector, enable Preview Autotrack Locations.

The small green dots indicate features that would be tracked if you were to begin 
tracking now, but you want to track a lot more features than these to improve the 
tracking data. You can always delete features later if they are inaccurately tracked.

9 Reduce the Detection Threshold to around 1.8 and the Minimum Feature Separation 
to around 0.01.

The Detection Threshold determines how much contrast an image feature must 
display for it to be considered trackable. Minimum Feature Separation determines how 
close tracking features can be to be considered unique. By lowering these two sliders, 
you should have a significant number of trackable features displayed in the viewer.
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The Camera Tracker uses an optical flow-based algorithm to follow pixels from frame 
to frame. You can further refine the tracking using a pattern recognition-based 
method similar to the normal Tracker in Fusion: a planar tracker algorithm that 
works well when you have large areas of planar transformations in a shot. Or, you 
can continue using optical flow, which works well for a shot like this with very few 
crisscrossing objects or motion blur.

10 Click the Auto Track button to begin tracking.

The Camera Tracker steps frame by frame, calculating the positions for all the tracking 
points. Obviously, the more tracking points you have created, the longer the process takes. 
When it gets to the end of the render range, the Tracker moves backward frame by frame 
to refine the existing points.

Solving for the Camera
Once auto tracking is completed, you can begin to enter known camera parameters and 
finally calculate the 3D representation of your live-action set. While Fusion can estimate 
much of the camera information, the more information you provide about the physical 
camera that captured the scene, the better the results will be. Often, the information is 
logged on set, but you can also examine a clip’s metadata in Resolve’s Metadata Inspector 
to see if useful information is listed there.

This footage was shot with a Blackmagic Ursa 4K using a focal length of 12.65 mm. At a 
minimum, you should enter the focal length to solve the camera track.

TIP If you don’t know the focal length, you can use trial and error, entering your 
best guess for the focal length until you get a satisfactory result. Fusion will 
attempt to refine the focal length from your initial guess, but you’ll need to be “in 
the ballpark” with your initial guess to succeed.
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1 Click the Camera button to switch to the Camera tab.

2 Enter a focal length of 12.65 and set the film gate to Blackmagic URSA/Production 4K 
16:9. Resolve automatically enters the correct aperture settings for that camera type.

TIP You can often ignore mild lens distortion (as in this shot), but when 
working with lenses that have more distortion, you can select the Refine Lens 
Parameters checkbox to automatically correct the distortion.

Time to solve the camera track!

3 Click the Solve button to switch to the Solve tab and click Solve. 

Depending on your computer, the solve may take several minutes to calculate.
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When the solve is completed, the reward for your efforts will be a list of information. But 
the first line is the key: the average solve error.

An average solve error of around 0.5 means that, on average, any digital environment work 
should be just over a half a pixel off, at most. Typically, you want to get this error value 
below 1 at a minimum, and ideally below 0.5. No matter where your average solve error 
ended up, let’s refine the solve a bit more to see whether you can get the error below 0.5.

NOTE Depending on whether you’re using the saved Rotoscope Done composition 
or the composition with your animated garbage mattes, your average solve error 
will be different from the value in the preceding figure.

Refining the Solve
The average solve error is also called the reprojection error, because it measures how 
closely the computer model of your live-action set can predict and recreate 3D locations 
in the physical set.

Imagine replacing your live-action camera with a digital projector placed at exactly the 
same location as the camera, pointing in the same direction, and using the same lens.

If your virtual set is perfectly reprojected back onto the scene using the virtual camera 
image, every projected pixel should line up perfectly with the object in the physical scene. 
If the reprojected pixels miss their marks, that’s a reprojection error.

The solve error is measured in pixels and refers to, on average, how far pixels are 
misaligned from the original scene.
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Looking at the viewer, most of the tracked features appear green to indicate a reprojection 
fit. You’ll also see a few of the tracked features colored red to indicate that they have an 
unacceptable reprojection error. To improve the overall solve quality, you can delete the 
features with high errors.

TIP Solving is a computationally demanding and RAM-intensive process, but it is 
also an iterative process as you refine the calculation. Deleting too many tracking 
markers and resolving can cause problems when your computing power is not up 
to it. If you plan on doing multiple iterations, it is advisable to make a copy of the 
original Camera Tracker node after each solve.

1 Select the Camera Tracker node.

2 In the viewer, drag a selection over a group of red trackers.

The trackers will highlight yellow to indicate that they are selected.



347Refining the Solve

3 In the Inspector, click Delete to remove the high-error tracked features.

This shot doesn’t have many red trackers clumped together, which makes it very 
difficult to select more than a handful of them at once. The Inspector provides an 
easier way to select trackers when manual selection is difficult.

The Maximum Track Error determines how poorly a feature was tracked during the 
solving phase. The Maximum Solve Error determines how poorly a feature reprojects 
based on the final scene.

4 In the Solve tab, set the Maximum Track Error to 0.2 and the Maximum Solve Error to 3.0.

If you push these values too far, you might actually find the reprojection error 
worsening. By starting with a value of 3.0, you avoid deleting too many points at once.

5 Click Select Tracks Satisfying Filters to select for deletion all the tracks with errors 
worse than the ones you just set.

6 Click Delete to remove the high-error tracked features.

7 Click Solve again to resolve the scene with a leaner, more accurate sample of features.
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At this point, you’ve achieved the goal of reducing the solve error a little lower than your 
initial results. It’s probably not worth the effort to further reduce the error.

NOTE Your solve errors will almost certainly be different from those shown here. 
For example, slight differences in the positions of your garbage matte shapes 
will change the accuracy of your solve. These differences are negligible, though, 
and you’ll almost certainly achieve similar or better results by following the steps 
described here.

On tougher shots, you’ll often repeat the solving and error reduction process several 
times, lowering the error rate a little more each time until your solve fails (and you must 
return to the solve values that you previously saved as a backup), or you achieve your 
desired average solve error goal of less than 0.5.

Setting the Ground Plane 
and Exporting the Scene
At this point, the Camera Tracker node has computed a virtual 3D scene that matches 
the original live-action scene to within slightly less than half a pixel. But before you can 
play with this new scene, you need to establish some ground rules. In fact, you need to 
establish a ground.

The Camera Tracker has no access to camera accelerometer data, so it doesn’t know if the 
camera was level, tilted, upside down, or on its side. Before you begin working with the 3D 
scene, you need to tell the Camera Tracker where the ground is located.
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NOTE If you were unable to get a satisfactory track, there is a saved version of the 
composition with the camera track completed. Open the Clips timeline, right-click 
the selected thumbnail, and choose Solve Done > Load. You can now follow the 
lesson using the composition 3D node tree.

1 Click the Export tab at the top of the Inspector.

2 Click the disclosure arrow next to 3D Scene Transform.

The options for setting the ground plane aren’t made visible until you switch to 
Unaligned.

3 In the Aligned menu, choose Unaligned. The option to set the ground plane becomes 
visible in the orientation section.

In Fusion’s 3D coordinate system, X is the horizontal axis, Y is the vertical axis, and Z is 
the depth axis. So, the default XZ plane is the typical ground plane as defined by the 
horizontal (X) and depth (Z) directions.
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TIP In some shots, the ground may never be visible. In such a case, it might 
make more sense to use another plane to identify the ground. For example, if 
a green-screen wall has clear tracking features, selecting the XY plane would 
allow you to lock camera direction to the green-screen wall, even when the 
floor wasn’t visible in the shot or didn’t track well.

4 Move to the start of the render range.

Here you have a clear view of the “ground” of the beach. To set the ground plane, you 
first select all the tracking points that tracked features located on the beach.

5 In the viewer, drag through the trackers on the beach to select them.

6 Shift-click any beach track points that you may have missed with your selection.

7 In the orientation section, click Set from Selection. The Camera Tracker adjusts the 
scene rotation to align with the selected feature tracks.

Finally, you need to tell the Camera Tracker where the origin point—the center of our 
3D universe—should be. It can be anywhere that’s convenient. We’ll select a feature 
track point from the center of the beach and set it as the origin point.
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8 Move to the last frame of the render range. Hover your mouse pointer over the viewer 
and notice how Fusion offers a readout of the solve error for the specific feature 
beneath the pointer.

9 Select a feature with a reasonably low solve error located somewhere on the beach.

10 In the Origin section, click Set from Selection.

The Camera Tracker sets the center of the internal 3D scene to the selected feature.

Now that the ground plane is set, it’s finally time to export the solved 3D scene.

11 Reset the Unaligned menu option to Aligned to lock in the ground plane adjustments.
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12 At the top of the Inspector, click the Export button.

A group of five nodes representing the created 3D scene is automatically created in 
the Node Editor.

13 Drag to reposition the new nodes, as desired.

Congratulations! You’ve performed your first 3D track.

The new nodes create a 3D scene that includes a Merge 3D, Camera 3D, Ground Plane, 
and Point Cloud 3D node, and a Camera Tracker renderer.

With the 3D camera track performed, it’s now time to take all that quality data and turn it 
into movie magic. This will be a fairly straightforward composite of adding the 2D pirate 
ship out on the horizon.
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Positioning Objects in a 3D Set
To add a ship to the horizon, most of the heavy lifting is already done for us, and we can 
achieve the result with just six more nodes. Let’s dive in.

1 From the 3D Tracking bin in the media pool, drag PirateShip.png into the Node Editor.

2 Press 1 to see the PirateShip.png in viewer 1.

To composite this ship into our 3D scene, just like the Earth and moon we used back in 
Lesson 9, the Media In node must be placed on a 3D shape. We don’t need a sphere 
this time, so we can just use an Image Plane 3D node.

3 With the Media In selected, use the Select Tool dialog to add an Image Plane 3D node. 

We can then connect the image plane into the Merge 3D node.
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4 Drag the output of the Image Plane 3D and connect it into the Merge 3D node. Then 
select Merge3D1 and press 1 to see the Merge 3D in viewer 1.

5 Select ImagePlane3D1, click in the viewer, and press F to frame it.

6 Press Command-Left Arrow (macOS) or Ctrl-Left Arrow (Windows) to position the 
playhead at the start of the render range.

The ship is composited into the 3D scene but is clearly too large and not in the 
right location.
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We want the ship to appear far off on the horizon, so we need to push it far back in 
the scene and then scale it up. It is easiest to do this while viewing the output of the 
Camera Tracker 1 Renderer node.

7 In the Node Editor, select the Camera Tracker 1 Renderer node and press 2 to view the 
output in viewer 2.

8 Select the Image Plane 3D node and, in the Inspector’s Transform tab, use the Z 
Translation slider to push the ship out in Z until it’s sufficiently distant but doesn’t 
disappear behind the image of the beach. The Z Translation value will be around -40.

9 At the bottom of the Inspector, use the Scale slider to increase the size of the ship to 
around 20.0.

NOTE Depending on your choice of ground plane and origin, your ship 
won’t perfectly match the one pictured above. You might need to adjust the 
Translation Z and Scale values to get a closer match.

10 Adjust the X and Y Translation controls to position the pirate ship just to the right of the 
rock outcropping and just below the horizon line. (The images in this book used the 
following values: X Translation: 18, Y Translation: 9, if you happen to be following along 
with one of the provided saved versions.)
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11 Adjust the Z rotation to level the ship to the horizon (for the book version of the 
project, around value 6.0).

12 Play the composition to see how the ship matches the camera move.

That’s all it really takes to add the ship and have it match the camera move from the 3D 
track. Now comes the compositing part, where you must make it appear as if the ship fits 
naturally in the beach setting. That will require some lighting and color correction.
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Matching Color and Light
Compositing isn’t just about placing one object on top of another. At this point, you 
probably know that. Although the ship follows the camera motion perfectly, it still needs 
work to look realistic. One of the nice things about Fusion’s 3D space is that when there 
are no 3D lights in a scene, it simply passes pixel data straight through. This means that we 
can add a simple color correction to the ship graphic in MediaIn2 to create the illusion of 
sea haze atmospherics over the ship.

1 Select MediaIn2, press Shift-Space to bring up the node selection tool, and choose a 
Color Compressor node.

2 Select MediaIn1 and press 1 to load it into viewer 1 (viewer 2 should still have the 
CameraTracker1_Renderer node loaded into it).

To sample the blue sky (which will be our “sea haze” reference), we need to load the 
background image into a viewer.

3 Select ColorCompressor1 and drag its Eyedropper tool to sample the sky right where 
the pirate ship will be.
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4 Drag Compress Hue, Compress Saturation, and Compress Luminance all the way to 1.0

The result…is not pretty. First, we have a problem with the edges of the image being 
overcorrected. We can use a little trick to fix this.

5 Drag from the output of MediaIn2 to ColorCompressor1’s blue, mask input.

This step uses the ship’s own alpha channel as a mask for the color correction, thus 
preventing the color correction from affecting the edges.

The second issue is that our initial values wash out the ship almost completely. 
Let’s correct that.
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6 Play with the Compress Hue, Compress Saturation, and Compress Luminance sliders to 
get a “sea haze” effect. Values of 0.7, 0.5, and 0.55 should work nicely.

You now have a pirate ship sitting convincingly in the water off the headland.

You can see how easy it is to add elements into a 3D-tracked shot. Having 3D tracking built 
in to DaVinci Resolve 18 Studio means that with a bit more effort you can transform simple 
sets into grand period pieces or galactic starships. And best of all, there’s no waiting for a 
separate studio to deliver the visual effects to you. As the composite progresses, you can 
instantly see how it works in the scene and make changes without causing massive delays.
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Completed node tree for Lesson 12.

Practice Exercise
For this exercise, you’ll camera track a new beach shot. This one also requires some 
rotoscoping of the actors and ocean. Then, you’ll take an image of a pirate’s flag and place 
it convincingly (more or less) on the beach:

1 Select the second edit in the timeline.

2 Create mattes for the areas you want to avoid (pirates, swashbucklers, and ocean).

3 3D track and then solve the track.

4 Set the ground plane and export the scene.
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5 From the media pool, add the flag.psd and composite it anywhere along the beach.

Lesson Review
1 True or false? 3D camera tracking is available only in DaVinci Resolve 18 Studio.

2 True or false? It’s OK to have the Camera Tracker follow people and moving cars since 
they will help with calculating the parallax.

3 What piece of camera information should be entered into the Camera Tracker for 
solving to work?

4 When setting the ground plane for a floor in the frame, should the coordinates be set 
to XY, XZ or YZ?

5 True or false? Adjusting the Maximum Solve Error and the Minimum Track Length can 
potentially improve a high solve error.
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Answers
1 True. 3D camera tracking is not available in the free version of DaVinci Resolve 18.

2 False. You only track objects that are “nailed to the set.” All other moving objects 
should be eliminated using a garbage matte.

3 The lens focal length must be entered to solve the 3D track.

4 XZ are the appropriate coordinates for a ground plane because X represents the 
horizontal axis, and Z represents depth. The other two coordinates are more 
appropriate if the ground is not in the frame, such as for a wall.

5 True: Adjusting the Maximum Solve Error and the Minimum Track Length can 
potentially improve a high solve error.

Congratulations!
Congratulations! You just completed some high-end professional visual effects and motion 
graphics from the comfort of your own computer workstation. Hopefully, this training 
guide has opened your eyes to the power and flexibility of node-based compositing, as 
well as the awesome visual effects tools available as standard in DaVinci Resolve.

Test your skills by taking the online assessment: www.blackmagicdesign.com/products/
davinciresolve/training

http://www.blackmagicdesign.com/products/davinciresolve/training
http://www.blackmagicdesign.com/products/davinciresolve/training
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Appendix A

Creating a 
Light Wrap

This appendix is an optional exercise 
for the green screen you created in 
Lesson 5. Once you’ve completed the 
green-screen lesson, the last color 
correction you should consider making 
on a green-screen composite is the 
useful yet horribly overdone light wrap 
effect. The idea is to add a simulated 
spill light from the composited 
background. Had this guitarist really 
been playing on an apocalyptic rocky 
ledge, the eerie green/yellow sunlight 
would have spilled around him, tinting 
the edges just as the green-screen spill 
did. Building a light wrap in a node tree 
is a simple process now that you have a 
foreground with a nice alpha channel.
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Completed light wrap.

Overview of a Light Wrap
A light wrap is essentially the creation of a new foreground image. It is made up of an edge 
matte of the foreground that has an inner blur.

Then, a blurred background image will act as the new, simulated spill.
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All of that will be merged over the top of the current foreground image to add a subtle 
spill color around the edges that matches the background light directly behind your 
foreground subject.
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Staying Organized with Color
Before we expand the green-screen node tree you created in Lesson 5, you should 
consider organizing your node tree before it becomes a tangled web of nodes and 
connection lines. The Fusion page includes several ways to help you organize your 
composites beyond simply naming the nodes. Before our node tree expands, let’s start 
getting organized using color to outline the different parts of our tree.

1 Return to the Fusion 17 Lessons Part 1.dra project.

NOTE You will need to enable the DaVinci YRGB Color Managed setting in the 
Settings window if you have disabled it since completing Lesson 5.

2 From the Timelines bin, double-click the Part 2_START timeline, and then go to the 
fourth and final red marker, which is the green screen you created.

NOTE If you did not finish Lesson 5, you can use the Lesson 5 completed 
timeline located in the Timelines > Completed bin.

3 Click in an empty area of the Node Editor directly above the Delta Keyer and two 
mattes that you created.

4 Open the Effects Library and choose Tools > Flow.
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5 From the Flow category, click the Underlay tool.

The Underlay tool is added to the Node Editor and encompasses the Delta Keyer, 
garbage matte, and holdout matte in a rectangular outline. The Underlay tool is not an 
effect but an organizational tool that helps you group parts of your node tree using a 
background color. Let’s rename the underlay and assign a color to make it stand out in 
the Node Editor.

6 Hold the Command key (macOS) or Ctrl key (Windows) and click the Delta Keyer to 
deselect it.

7 Right-click over the Underlay title bar and choose Rename from the menu. Then 
rename the underlay to MATTES.

8 Once you save the name, right-click over the title bar again and choose Set 
Color > Orange.

TIP Moving the underlay by dragging the title bar moves all the nodes 
encompassed in the underlay rectangle.
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This one underlay organizes our key and its auxiliary mattes into a group. As you 
expand the composite with the light wrap, you can add another underlay, using a 
different color to distinguish the different areas from each other.

9 Click in an empty area of the node tree between the Color Corrector 1 and the 
Merge1 node.

10 From the Effects Library, click the Underlay tool to add it to the Node Editor.

NOTE You might want to move nodes around to create more room between 
the underlay and the Merge1 node.

11 Rename the underlay to LIGHT_WRAP and set its color to blue.
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Combining Mattes
Now you’ll make two copies of the matte from the Delta Keyer to create an edge matte 
that will represent the matte for the light wrap. An edge matte is a matte that just masks 
around the edges of the foreground subject.

1 From the toolbar, drag two Matte Control tools inside the underlay.

2 Connect two additional outputs from the Delta Keyer, one to each of the Matte 
Control nodes.

3 Select MatteControl1 and press 1 to view the alpha channel. In the Inspector, increase 
the Blur slider to around 2 or 3.

4 Select MatteControl2 and press 1 to view its alpha channel.

Matte controls are used for a variety of operations on mattes. You can use the matte 
from the foreground input to combine in any number of ways with the matte from 
the background input. For our purpose, we will connect the two Matte Controls and 
subtract one from the other.
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5 Connect an output of MatteControl1 to the green foreground input of MatteControl2.

6 In the Inspector of MatteControl2, set the Combine menu to Combine Alpha and set 
the Combine Op menu to Subtract.

You have just created the edge matte you need for the light wrap. The blurrier you make 
the matte, the more the color from the background image will spread around the edges of 
the foreground subject.

Merging the Light Wrap 
and Foreground 
The remaining task for the light wrap is a simple merge composite. You’ll use the edge 
matte and fill it with the background and then merge that over the top of our musician.

1 Drag a Merge node from the toolbar and place it under the MatteControl2 node.
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2 Drag the output of the MatteControl2 node to the blue mask input of the Merge2 node 
to create the effects mask for your composite.

3 Disconnect ColorCorrector1 from the Merge1 node.

The final result of the light wrap will become the new foreground for this Merge1, so 
this connection is no longer needed.

4 Connect the output of the ColorCorrector1 node to the yellow background input on 
the Merge2 node.

It might seem counterintuitive to connect the color-corrected guitarist to the 
background input, but remember that you are going to merge a blurred background 
over the top of him using the edge matte you created.

5 Drag a second output from the ColorCorrector2 node into the green foreground of the 
Merge2 node.

The light wrap is essentially complete. However, spill light from any light source is a 
diffused light. It should not have detailed, sharp edges. That being the case, you must 
soften the spill colors coming from the ColorCorrector2 node using a Blur node.
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6 To soften the spill from the background clip, insert a Blur node between the 
ColorCorrector2 and the Merge2, and then, in the Inspector, increase the Blur 
slider to around 10.

The output of Merge2 is now your new foreground image, and you can connect it to 
Merge1 as such.

7 Drag the output of Merge2 to the foreground input of Merge1 and then view Merge1 
in either viewer to see the final result.

The light wrap is just one more piece that you can add to a green-screen composite to 
make it appear that much more realistic. Since you have complete control over it, adjust 
the amount of Blur and the Gamma of the matte in the Matte Controls to see how it affects 
the strength and spread of the light wrap “spill.”



Time
This lesson takes approximately 
10 minutes to complete.

Goals
Using Fast Noise for Particle Cells 374

Rendering from the Fusion Page 378

Appendix B

Creating Smoke 
with Fast Noise

The Fast Noise tool is a very flexible, 
organic-looking noise generator. It is 
a common technique for generating 
particles like clouds and water caustics. 
The following steps take you through 
the process of creating the single 
smoke movie you used to create the 
particles in Lesson 11.
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Using Fast Noise for Particle Cells
Fast noise is particularly good at creating vapors like smoke or clouds. However, since 
fast noise can be very demanding on your computer because it must generate the image 
in real time as you create the particles, it’s often easier just to render out the fast noise 
as a short, small movie. You can then use that small, less taxing movie as the image for 
your particles.

1 Open a new project in DaVinci Resolve.

2 Add a Fusion composition effect to the timeline and leave it at the 5-second duration.

3 Click the Fusion page button.

4 From the toolbar, drag the Fast Noise tool to an empty place in the Node Editor.

The Fast Noise tool is a very flexible, organic-looking noise generator. It can be useful 
for a wide range of effects from clouds to water caustics, and in our case, smoke.

The first thing to do when making an image to be used as a particle cell is to set a 
resolution as small as possible. Most particle cell images should be less than 200 x 200 
pixels so they use very little graphics card memory.

5 In the Inspector, click the Image tab and uncheck the Auto Resolution checkbox.

6 In the Width and Height fields, enter 200 x 200.

The Image tab is primarily used for setting the resolution. The majority of controls for 
the noise are located in the Noise tab. Here, we’ll control the tonal quality of the noise 
as well as the auto-animation feature.
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7 Click back on the Noise tab and set the Detail to 5 to give more texture to our smoke.

8 Increase the Seethe Rate to 0.1 to create a slow smoldering animation for the noise.

Now that the noise texture looks right, we need to shape it. We cannot have the noise 
go to the edges of the frame boundary or those sharp edges will appear in each 
particle cell. To fix this, you will make the noise use a radial gradient and set the outer 
edges of the gradient to be transparent.

9 Click the Color tab and set the Type to Gradient.

10 From the Gradient Type menu, choose Radial.

Switching to a radial gradient displays a gradient line in the viewer. Using the green 
gradient line, you will set the center point of the gradient and the outer edge.
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11 Using the handle on the left end of the green gradient line, drag the point to the 
center of the viewer.

12 Using the handle on the right end of the green gradient line, drag the point in toward 
the center of the viewer, about one third of the way from the edge.

Now you can add some transparency using the alpha control in the Inspector.
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13 In the Inspector, click the first color stop on the left end of the gradient bar and set the 
color to a middle gray.

14 Click the last color stop on the right end of the gradient bar and set the color to black 
and the Alpha slider to 0.

15 Play the Fast Noise effect in the viewer to see your puff of smoldering smoke.

Now you can render out this movie and use it in your particle system.
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Rendering from the Fusion Page
If you render this Fast Noise generator using the Media Out node, it will render using the 
timeline resolution. You need to render it using the 200 x 200 resolution you set in the 
Image tab of the Fast Noise tool. You can do this by adding a Saver node.

1 Open the Effects Library and go to the Tools > I/O category.

2 Drag the Saver node to an empty location in the Node Editor.

3 Drag an output from the Fast Noise into the yellow input on the Saver node.

The Saver node is unique because it allows you to render out any part of your node 
tree as EXR image files. It will use the resolution based on the image that’s connected 
to its input. In your case, it will render out at 200 x 200 pixels since that is the 
resolution of the Fast Noise generator.

4 Select the Saver node and, in the Inspector, click the Browse button.

5 Navigate to a location where you want the image files to be rendered and create a 
folder for them to reside within.

6 At the top of the window, name the image files noise and then click Save to close 
the window.

The File field at the top of the Inspector is now populated with the location of the file 
and the filename with an .exr extension.

7 In the menu bar, choose Fusion > Render All Savers  
to begin the rendering process.

8 Once the rendering is complete, click OK in the dialog.

You can now test your render by importing the EXR files 
into the media pool. The Fast Noise generator is a fantastic 
tool to experiment with when creating particle effects. It’s 
the perfect tool to turn to when trying to create organic vapor effects.
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Index

SYMBOLS
* (asterisk), using with 

expressions, 252, 255

NUMBERS
2D image, converting 3D into, 298–305
2D look design, adding, 305–308
3D

axes of rotation, 256–258
converting into 2D images, 298–305
entering expressions, 251–255
lights and cameras, 258–265
navigating in, 246–249
using shapes in, 249–251

3D camera tracking. See also camera; 
Camera Tracker

autotracking, 342–343
camera tracker, 340–343
exporting scenes, 348–352
garbage mattes, 338–340
ground plane, 348–352
matching color and light, 357–360
refining solves, 345–348
reprojection error, 345
rotoscoping for, 332–338
solve errors, 345–348
solving for camera, 343–345

3D coordinate system, Fusion, 349
3D objects, working with, 241
3D Options, Lighting, 245
3D particle systems

adding motion to, 316–318
defining emitter shape, 318–319
optimizing performance, 322–323

particle forces, 327–328
setting up, 312–316
timing and look of, 323–327
using images for, 319–322

3D set, positioning objects in, 353–356
3D shapes. See also shapes

bending, 281–282
duplicating, 283–287
materials, 288–298
placing elements on, 240–245
playing around with, 280–287
shearing, 281–282
showing copies of, 283
twisting, 281–282
using, 249–251

3D text
adding to scenes, 270–273
animating, 273–279

3D tracking, rotoscoping for, 332–338

A
acceleration adjustments, 

making, 226–228
alignment of images, nudging, 59–61
Alignment slider, 164
alpha channels

embedding into images, 84–87
explained, 81
and mattes, 51–52, 77–78
straightening out, 217–218
using, 11

Alt key. See keyboard shortcuts
ambient light, 262
Angle setting, using with particle 

systems, 317
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animating
3D text, 273–279
acceleration adjustments, 226–228
alpha channels, 217–218
animation modifiers, 229–232
auto-orienting objects, 216
cameras, 262–265
dotted line, 223–226
with Follower, 192–195
identifying clip’s resolution, 210–212
with keyframes, 34–35
keyframing motion path, 211–215
linking parameters, 223–226
motion blur, 232–234
painting motion paths, 218–223
splines, 143
text in scenes, 275–279

animation
modifiers, 229–232
slowing, 228

anti-aliasing, alpha channels, 111
area averages, selecting, 134
asterisk (*), using with 

expressions, 252, 255
auxiliary mattes, rotoscoping, 140–146
axes of rotation, creating, 256–258
axis control, Perspective view, 248

B
background, lining up, 146–148
background and foreground, color 

correcting, 148–150
background banner, creating, 186–189
Background node, 305
Background tool, 292
Backups bin, 126, 158, 180, 210, 240, 270
Balance slider, 136
banner, creating, 186–189
bending 3D shapes, 281–282
Blackmagic Cloud, media sync, xiv
blobs and particle systems, 316

blue-screen keying. See green-screen key
Blur Size, Inspector, 32. See also Directional 

Blur node; motion blur
bokeh and particle systems, 316
Bold, setting font to, 168
breaking news animation, 273–279
Brightness Contrast node, 110
B-Spline curve, adjusting 

smoothness of, 142
B-Spline tool, drawing shapes with, 141

C
caching, enabling, 36
camera. See also 3D camera tracking

Solve button, 344
solving for, 343–348

Camera button, 344
camera motion, restoring, 61–64
Camera Tracker. See also 

3D camera tracking
Aligned setting, 349
origin point, 350–351
preparing, 340–343
Unaligned setting, 349–351
using, 332

cameras and lights. See also 
3D camera tracking

adding, 258–265
focal length, 343–344

certification, getting, xiii
CG (computer generated), 2
Channel Booleans node, 78
Character Level Styling, 166
Checker Underlay, deselecting, 134
chroma, defined, 133
Cineon LOG tool, adding, 129
Clean Plate node, 136
clip resolution. See also resolution

identifying, 210–211
retaining, 68–72
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clips
aligning using nudging, 58–61
creating in timeline, 55

Clips button, 201, 340–341
Clone Apply Mode button, 105
Clone tool, painting with, 102–106
cloud. See Blackmagic Cloud
clouds. See Fast Noise
color

managing for visual effects, 126–129
staying organized with, 366–368

color and light, 3D camera 
tracking, 357–360

color correcting elements, 148–150
color correction. See also secondary color 

correction
background and foreground, 148–150
Lift control, 20

Color Corrector node, adding, 16–17, 
31, 149–150

color management, 126–129
color page, 45, 151–153
color space. See linear color space
color stops

adding to gradients, 183
deleting, 184

color swatch, materials, 288–289
color wheel, Inspector, 217
colors of connections, nodes, 14
Command key. See keyboard shortcuts
Completed Projects bin, 158, 180, 210
composite

explained, 12
finalizing, 119–121

compositing
Darken Apply mode, 77–79
images, 131

Composition effects, 174
composition resolution, controlling, 73–77
Connect To command, 224
connection lines, adding router for, 260

Contrast slider, 109
control points. See also points

adding, 215
moving, 120

Cook Torrance shader, 290, 294
coordinate system, Fusion, 114
Copy command, 165, 185
corner pinning images, 112–114
credit roll

aligning text with tabs, 162–166
converting to pixel values, 172–173
formatting lines, 166–168
Fusion Generator, 158–159
implementing, 171–172
keyframes, 174–177
logos and graphics, 168–170
Text+ node, 160–161

credits
grouping into categories, 162–166
rolling, 171–172

Ctrl key. See keyboard shortcuts
curves, creating, 141

D
Darken Apply mode, using for 

compositing, 77–79
DaVinci Resolve, downloading, xiv
Delta Keyer node, 133, 145, 148
Design Training and Certification 

program, xiii
Detection Threshold, Camera Tracker, 342
Directional Blur node, 293–294. 

See also Blur Size
directional light, 262
Directional Light tool, 259–261
divide and conquer technique, 142, 145
DoF (depth of field) effects, 

configuring, 301–305
downloading

DaVinci Resolve, xiv
and installing lesson files, xv
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dual viewer setup, choosing, 61, 71, 132. 
See also viewers

Duplicate 3D node, 283–285, 287

E
Earth’s Shape Inspector, 253
edit page

returning to, 36
styling text in, 180–184
using layers from, 42–45

Effects Library. See also VFX (visual effects)
adding effects from, 79–82
contents of, 306
Flow category, 366–367
Underlay tool, 368

emitter shape, defining, 318–319
Enable Lighting, Inspector, 300
Erode control, 138
Erode Dilate node, 83–84
expression field, opening, 225
expressions, entering, 251–255

F
Fast Noise

rendering from Fusion page, 378
using for particle cells, 374–377

Film Damage tool, 230
Filter node, 293
Flow category, Effects Library, 366–367
Focal Factor label, Inspector, 230
focal length, camera, 343–344
focal plane, DoF effects, 301–305
Follower, animating with, 192–195
fonts, best practices, 185. See also text
foreground and background, color 

correcting, 148–150
frame numbers, Fusion page, 11
frames

filling viewers with, 171
freezing, 102–103

freeze frames, 103
lighting, 119–121

Fusion
3D coordinate system, 349
interface, 2–4

Fusion clips
aligning using nudging, 58–61
creating in timeline, 55

Fusion Composition effect, 159
Fusion coordinate system, 114
Fusion generator, 158–159
Fusion page

adding effects, 16–22
adding vignettes, 35
animating with keyframes, 34–35
Color Corrector icon, 16–17
combining images, 12–16
frame numbers, 11
Gain slider, 20–21
Gamma control, 21–22
masks, 26–28
moving text to, 185–186
navigating, 4–6
Node Editor, 6–12
node flow, 22–25
node names, 10
panning around views, 6
RAM playback, 11
rendering from, 378
returning to timeline, 36
secondary color correction, 28–33
time ruler, 11
tracking in, 46–51

G
Gain, setting, 20–21, 33, 93, 135
gamma settings, 21–22, 93, 129, 138. 

See also LOG gamma
gamma versus lift, 218
gamut, adding, 129
garbage mattes. See also mattes

combining, 338–340
and holdout mattes, 145
using with Polygon, 116
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gradient colors, repositioning 
spread of, 183

Gradient Extrapolation, 176
Gradient Type menu, Radial 

setting, 375–376
graphics and logos, inserting, 168–170
green-screen content, color for visual 

effects, 126–129
green-screen key, pulling, 132–136
ground plane, setting for Camera 

Tracker, 348–352

H
HDR (high dynamic range), 295
Height setting, Inspector, 319
holdout matte, rotoscoping, 144–145
holes in keys, fixing, 82–84
Hot Spot node, 201

I
Image Plane 3D node, 242, 246
image processing, 45
Image tab, Inspector, 300
images. See also RGB image

aligning, 59–61
combining using nodes, 12–15
combining with mattes, 115–117
compositing, 131
corner pinning, 112–114
embedding alpha into, 84–87
fitting into viewer, 5, 71
using for particle cells, 319–322

Inspector
Blur Size, 32
Clone Apply Mode button, 105
collapsing sections of, 255
color wheel, 217
Delete for 3D camera tracking, 347
Enable Lighting, 300
Export tab, 349
Focal Factor label, 230
Fusion page, 3

Height setting, 319
High threshold slider, 81
Image tab, 300
Jitter tab, 284
Modifiers tab, 167
Options button, 18
Pivot controls, 274
Pre-Matte tab, 136
Region tab, 318
Replace Mode, 149
Shape menu, 281
Size control, 64
Size slider, 169
Soft Range slider, 138
Transform1 Center Y controls, 169
Velocity section, 317
X Transform, 247
Z Translation, 247–248

interrupted trackers, fixing, 91–92. See also 
Tracker node

J
Jitter tab, Inspector, 284

K
key color, sampling for, 134
keyboard commands, Fusion page, 4
keyboard shortcuts

closing mattes, 142
control points, 120
Copy command, 165, 185
Fusion page, 3
line break, 166
node rearrangement, 70
nodes, 22, 24
Paste command, 165–166, 185
playhead movement, 46, 143, 198, 336
render range 3D camera, 336
resizing images in viewer, 71
rotating views, 251
Select All command, 204
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keyboard shortcuts (continued)
Select Tool dialog, 93
spill correction, 150
switching nodes, 14
undoing commands, 25
viewer and frames, 171
zooming, 6
zooming timeline, 43

keyframe timing, adjusting, 195–199
keyframes

animating with, 34–35
deleting, 197
editing, 146, 196, 199
fitting images into viewer, 5
Fusion page, 6
setting and looping, 174–177, 195

keying process, applying to mattes, 126
keys, fixing holes in, 82–84

L
layers, using from edit page, 42–45
Lens Reflections node, 307
lens-flare effects, 201–202
lesson files

copying, xiv
downloading and installing, xv

Lifespan, setting for particle systems, 318
Lift control, color correction, 20
lift versus gamma, 218
light and color, 3D camera 

tracking, 357–360
light wraps

color correction, 153
color organization, 366–368
combining mattes, 369–370
creating, 364
merging with foreground, 370–372
overview, 364–365

lighting 3D scenes, 245
lights and cameras, adding, 258–265. 

See also 3D camera tracking

line break, creating, 166
linear color space, 130–131
lines

formatting, 166–168
pick whip, 225

LOG gamma, 130–131. See also 
gamma settings

logos and graphics, inserting, 168–170
luma key, blurring, 32
Luma Keyer, 28, 77–78, 82
LUT (Lookup Table), 128–129

M
Macro Editor window, 204
masks

as mattes, 53
working with, 26–28, 31

match moves, 42
match moving, Planar Transform, 117–118
materials. See also Replace Material node

displaying as objects, 291
reflections, 295–298
shader nodes, 290–294

Materials tab, 288–289
Matte Control node, 84, 369–370
mattes. See also garbage mattes

and alpha channels, 77–78
clamping areas of, 139
Clean Background control, 139
Clean Foreground control, 139
closing, 142
combining, 369–370
combining with images, 115–117
drawing, 51–57
keying process, 126
lining up backgrounds, 146–148
masks as, 53
performing changes to, 119
refining, 136–140
revealing text with, 189–191
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rotoscoping, 140–146
sending to color page, 150–153

Media In node, 6, 10, 296
Media Out node, 6–7, 151
media pool, opening, 12, 146, 211
Merge node

displaying, 12, 108, 169
transform controls, 213
using with light wrap, 370–372

modifiers
linking parameters to, 216
using, 220–221, 229–232

motion, adding to particles, 316–318
motion blur. See also Blur Size

customizing, 232–234
disabling, 234
enabling, 121

motion path
keyframing, 211–215
painting, 218–223

mouse commands, Fusion page, 4
multiply symbol, using with 

expressions, 252, 255

N
Node Editor

hiding, 195
panning, 291
Rectangle tool, 190
working in, 6–11
zooming, 5

node flow, 22–25
node names

Fusion page, 10
underscores and spaces, 45

node trees
completing, 93
constructing, 63

nodes
colors of connections, 14
connecting and disconnecting, 15

default settings, 305
inserting, 25
laying out, 14
Luma Key, 28
moving, 16
and pipes, 14–15
rearranging, 70
re-enabling, 22
removing, 24
renaming, 12
selecting, 204
switching, 14
versus tools, 8
unloading from viewer, 32
using to combine images, 12–15

nudging clips, 58–61

O
objects

auto-orienting, 216
positioning in 3D set, 353–356
rotating, 257

Opacity slider, 195
OpenGL renderer engine, 299–300
Option key. See keyboard shortcuts
Options button, Inspector, 18

P
pages, image processing, 45
Paint tool, 104, 218
panning

Node Editor, 291
viewers, 6, 54, 105

parallax, occurrence of, 49
parameters

linking, 223–226
linking to modifiers, 216

particle cells, using fast noise for, 374–377
particle forces, 327–328
particle systems. See 3D particle systems
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particles
adding motion to, 316–318
p nodes, 327
setting color for, 326
timing and look of, 323–327
Z spin variance, 327

Paste command, 165–166, 185
pEmitter node, 314, 316, 327
performance, optimizing, 322–323
Perspective Axis menu, 278
Perspective view

axis control, 248
lights and cameras, 258

Photoshop PSD layers, 106–111
pick whip, defined, 225
pImage Emitter node, 314
pipes and nodes, 14–15
Pivot controls, Inspector, 274
pixel values, converting to, 172–173
planar surfaces, tracking, 98–102
Planar Transform, match moving, 117–118. 

See also Transform node
plates, VFX (visual effects), 11
Play button, 198
playback, pausing and starting, 16
playhead, moving, 46, 143, 198, 336
point light, 262
points, managing, 53–54, 57. See also 

control points
Polygon mask tool, 52
Polygon nodes, deselecting, 340
Polygon tool, 115
Polyline Stroke, 219
Position slider, 164
Post Multiply Image option, 86
POV (point of view), copying to camera, 263
premultiplied alpha channels, 111
pRender node, 314, 324, 327
PSD layers, Photoshop, 106–111

R
radial gradient, 375–376
RAM playback, Fusion, 11
Rectangle tool, 190
reflections, adding, 295–298
Region tab, Inspector, 318
Render Cache, 36
render range 3D camera, 342
Renderer 3D tool, 298–299
rendering from Fusion page, 378
Replace Color, Matte tab, 148–149
Replace Material node, 298. 

See also materials
Reset UI Layout, 2, 61
resolution. See also clip resolution

of clips, 68–72
of compositions, 73–77

RGB image, combining with matte, 84–87. 
See also images; sRGB color space

rotating 
objects, 257
views, 251

rotation point, creating, 256–258
rotoscoping

for 3D tracking, 332–338
mattes, 140–146

router, adding for connection lines, 260

S
Saturation, setting, 33
screens and signs

corner pinning images, 112–114
finalizing composite, 119–121
match moving, 117–118
mattes and images, 115–117
painting with Clone tool, 102–106
Photoshop PSD layers, 106–111
Planar Transform, 117–118
tracking planar surfaces, 98–102

secondary color correction, 28–33. See also 
color correction

Select All command, 204
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Select All Points button, viewers, 335
Select Tool dialog, 93
Shader nodes, 290–294
Shading tab, using with text, 183
Shape 3D node, 242, 246, 280
shapes. See also 3D shapes

drawing with B-Spline tool, 141
using in 3D, 249–251

shearing 3D shapes, 281–282
Shift key. See keyboard shortcuts
signs and screens

corner pinning images, 112–114
finalizing composite, 119–121
match moving, 117–118
mattes and images, 115–117
painting with Clone tool, 102–106
Photoshop PSD layers, 106–111
Planar Transform, 117–118
tracking planar surfaces, 98–102

Size control, Inspector, 64, 169
sky

blending in, 93
blending in original, 93
tracking into position, 87–91

sky replacement
compositing, 77–79
controlling composition’s 

resolution, 73–77
Darken Apply mode, 77–79
Effects Library, 79–82
embedding alpha in images, 84–87
fixing holes in keys, 82–84
interrupted trackers, 91–93
retaining clip’s resolution, 68–72

slider’s range, extending, 83
smart caching, enabling, 36
smoke

creating with Fast Noise, 373–378
giving texture to, 375
viewing in scene, 321

soft light apply mode, 109

Soft Range slider, Inspector, 138
Solve button, camera, 344
Sphere Map, 297
spill, removing, 149
spill correction, disabling, 150
Spline Editor, 175–176
spline shapes, auto-keyframing, 52
splines, animating, 143
split screens

aligning clips, 58–61
creating effects, 46–51
drawing mattes, 51–57
layers from edit page, 42–46
nudging clips, 58–61
restoring camera motion, 61–64
tracking in Fusion page, 46–51

spot light, 262
sRGB color space, 128. See also RGB image
stabilization, using tracker for, 50
straight alpha channels, 111
Stroke tool, 104
Suppress wheel, using with spill color, 149
system requirements, xiv

T
tabs, aligning text with, 162–166
Template node, 185
templates, saving, 204–207
text. See also fonts

aligning with tabs, 162–166
animating in scenes, 275–279
moving to Fusion page, 185–186
revealing with mattes, 189–191
styling in edit page, 180–184

Text+ node, adding, 160–161
Text+ template, 181
Text3D Inspector, 273
textures as materials, 288
thumbnail timeline, displaying, 340
time ruler, Fusion page, 11
Time Stretcher tool, 103–104
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timeline
returning to, 36
versions, 201–203
zooming in and out, 43

Timelines bin, 126, 158, 180, 210, 240, 270
title templates

animating with follower, 192–195
background banner, 186–189
keyframe timing, 195–199
moving text to Fusion page, 185–186
revealing text with mattes, 189–191
saving, 204–207
styling text in edit page, 180–184
versions, 200–203

toolbar, Fusion page, 3
tools

versus nodes, 8
selecting in header, 197

Tracker node, using, 46–51, 87–90. See also 
interrupted trackers

tracking areas, defining, 101
tracking in Fusion page, 46–51
Transform 3D node, inserting, 256–257
Transform node. See also Planar Transform

adding to sky clip, 72
auto-orienting objects, 216
keyframing motion path, 211–215
linking parameters, 223–226
and Merge, 168–170
restoring camera motion, 62

Transform tool, 220
Transform1 Center Y controls, 

Inspector, 169
transparency, adding to smoke, 376
twisting 3D shapes, 281–282
typefaces. See fonts

U
Underlay tool, 367–368
undoing commands, 2, 25

V
Vai, Steve, 127
vapors. See Fast Noise
Velocity section, Inspector, 317
versions, trying out, 200–203
VFX (visual effects). See also Effects Library

adding, 16–22
color management, 126–129
plates, 11
terminology, 1

viewers. See also dual viewer setup
filling with frames, 171
fitting images in, 5
Fusion page, 3
panning, 54, 105
resizing, 52, 132
Select All Points button, 335

views
navigating in Fusion, 6
rotating, 251

vignettes, adding, 35

W
work area, Fusion page, 3–4

X
X axis, 349
X Rotation slider, 274
X Transform, Inspector, 247

Y
Y axis, 349
Y Pivot slider, 275
Y rotation slider, 193

Z
Z axis, 246, 349
Z spin variance, particles, 327
Z Translation, Inspector, 247–248, 278
zooming

keyboard shortcuts, 6
Node Editor view, 5
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Use Nodes to String Effects Together

Work in 3D Space

Create Sophisticated Animation Curves

Key and Composite Green Screen

 The Visual Effects Guide to

 DaVinci
 Resolve 18
The Fusion page in DaVinci Resolve 18 features hundreds of  
advanced tools for compositing, animating titles, 2D graphics,  
generating particle systems and 3D effects. This official hands on  
training guide teaches you how to create visual effects and 
motion graphics directly inside DaVinci Resolve, without importing 
or exporting large media files between applications. You’ll  
learn how its node based interface makes it easy to quickly build 
sophisticated effects and quickly make changes.

What You’ll Learn
• Fundamentals of compositing using nodes

• Combining optimal takes with the split screen technique

• Tracking objects using the point tracker and planar tracker

• Compositing with multi layer PSD files

• Advanced sky and sign replacement

• Green screen compositing with the delta keyer and auxiliary mattes

• Rotoscoping to produce clean traveling mattes

• Animating 2D and 3D text

• Creating a film credit roll

• Working in a 3D environment with cameras, lights, and textures

• Performing 3D camera tracking and integrating set extensions

• Building particle effects

• Applying LUTs and Resolve color management

• Setting up node pipelines that are processor efficient

Who This Book is For
This book is designed for compositors, editors, colorists, or any artists 
wanting to learn how to create visual effects and motion graphics in 
DaVinci Resolve 18. Beginners will find clear and concise lessons to get 
up and running quickly. If you’re a professional switching from another 
application, you’ll find lessons that cover everything from basic titling 
and motion graphics to keying, sky replacement, 3D camera tracking, 
and dozens of tips & tricks that will transform how you work!

http://www.blackmagicdesign.com
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